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Introduction

This chapter contains information on the following:

* Introduction to Wireless Networking
* Guidelines for Roaming
* Management and Monitoring Capabilities

Introduction to Wireless Networking

An Access Point extends the capability of an existing Ethernet network to devices on a wireless network. Wireless
devices can connect to a single Access Point, or they can move between multiple Access Points located within the same
vicinity. As wireless clients move from one coverage cell to another, they maintain network connectivity.

In a typical network environment (see Figure 1-1), the AP functions as a wireless network access point to data and voice
networks. An AP network provides:

« Seamless client roaming for both data and voice (VoIP)

» Easy installation and operation

* Over-the-air encryption of data

* High speed network links

-

Internet

Router

Coverage +_
Area

Figure 141 Typical Wireless Network Access Infrastructure

Guidelines for Roaming

» Typical voice network cell coverages vary based on environment. Proxim recommends having a site survey done
professionally to ensure optimal performance. For professional site surveyors, Ekahau™ Site Survey software is
included in the Xtras folder of the Installation CD.

* An AP can only communicate with client devices that support its wireless standards.
» All Access Points must have the same Network Name to support client roaming.




Introduction AP-700 User Guide
Management and Monitoring Capabilities

» All workstations with an 802.11 client adapter installed must use either a Network Name of “any” or the same Network
Name as the Access Points that they will roam between. If an AP has Closed System enabled, a client must have the
same Network Name as the Access Point to communicate (see Reboot the AP.).

« All Access Points and clients must have matching security settings to communicate.

» The Access Points’ cells should overlap to ensure that there are no gaps in coverage and to ensure that the roaming
client will always have a connection available. To ensure optimal AP placement, Proxim recommends having a site
survey done professionally to ensure optimal performance. For professional site surveyors, Ekahau™ Site Survey
software is included in the Xtras folder of the Installation CD.

» All Access Points in the same vicinity should use a unique, independent channel. By default, the AP automatically
scans for available channels during boot-up but you can also set the channel manually (see Interfaces for details).

» Access Points that use the same channel should be installed as far away from each other as possible to reduce
potential interference.

Management and Monitoring Capabilities

There are several management and monitoring interfaces available to the network administrator to configure and
manage an AP on the network:

 HTTP/HTTPS Interface

* Command Line Interface

*  SNMP Management

* SSH (Secure Shell) Management

HTTP/HTTPS Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s Ethernet Port.

HTTPS provides an HTTP connection over a Secure Socket Layer. HTTPS is one of three available secure management
options on the AP; the other secure management options are SNMPv3 and SSH. Enabling HTTPS allows the user to
access the AP in a secure fashion using Secure Socket Layer (SSL) over port 443. The AP supports SSLv3 with a 128-bit
encryption certificate maintained by the AP for secure communications between the AP and the HTTP client. All
communications are encrypted using the server and the client-side certificate.

The AP comes pre-installed with all required SSL files: default certificate, private key and SSL Certificate Passphrase
installed.

Command Line Interface

The Command Line Interface (CLI) is a text-based configuration utility that supports a set of keyboard commands and
parameters to configure and manage an AP.

Users enter Command Statements, composed of CLI Commands and their associated parameters. Statements may be
issued from the keyboard for real time control, or from scripts that automate configuration.

For example, when downloading a file, administrators enter the download CLI Command along with IP Address, file
name, and file type parameters.

You access the CLI over a HyperTerminal serial connection or via Telnet. During initial configuration, you can use the CLI
over a serial port connection to configure an Access Point’s IP address. When accessing the CLI via Telnet, you can
communicate with the Access Point from over your LAN (switch, hub, etc.), from over the Internet, or with a “crossover”
Ethernet cable connected directly to your computer’s Ethernet Port. See Command Line Interface (CLI) for more
information on the CLI and for a list of CLI commands and parameters.
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SNMP Management

In addition to the HTTP and the CLI interfaces, you can also manage and configure an AP using the Simple Network
Management Protocol (SNMP). Note that this requires an SNMP manager program, like HP Openview or Castlerock’s
SNMPc. The AP supports several Management Information Base (MIB) files that describe the parameters that can be
viewed and/or configured over SNMP:

*  MIB-Il (RFC 1213)

» Bridge MIB (RFC 1493)

* Ethernet-like MIB (RFC 1643)

+ 802.11 MIB

* ORINOCO Enterprise MIB

Proxim provides these MIB files on the CD-ROM included with each Access Point. You need to compile one or more of

the above MIBs into your SNMP program’s database before you can manage an Access Point using SNMP. See the
documentation that came with your SNMP manager for instructions on how to compile MIBs.

The Enterprise MIB defines the read and read-write objects that can be viewed or configured using SNMP. These objects
correspond to most of the settings and statistics that are available with the other management interfaces. See the
Enterprise MIB for more information; the MIB can be opened with any text editor, such as Microsoft Word, Notepad, or
WordPad.

SNMPv3 Secure Management

SNMPv3 is based on the existing SNMP framework, but addresses security requirements for device and network
management.

The security threats addressed by Secure Management are:

» Modification of information: An entity could alter an in-transit message generated by an authorized entity in such a
way as to effect unauthorized management operations, including the setting of object values. The essence of this
threat is that an unauthorized entity could change any management parameter, including those related to
configuration, operations, and accounting.

* Masquerade: Management operations that are not authorized for some entity may be attempted by that entity by
assuming the identity of an authorized entity.

* Message stream modification: SNMP is designed to operate over a connectionless transport protocol. There is a
threat that SNMP messages could be reordered, delayed, or replayed (duplicated) to effect unauthorized
management operations. For example, a message to reboot a device could be copied and replayed later.

» Disclosure: An entity could observe exchanges between a manager and an agent and thereby could learn of notifiable
events and the values of managed objects. For example, the observation of a set command that changes passwords
would enable an attacker to learn the new passwords.

To address the security threats listed above, SNMPv3 provides the following when secure management is enabled:

» Authentication: Provides data integrity and data origin authentication.
» Privacy (a.k.a Encryption): Protects against disclosure of message payload.
» Access Control: Controls and authorizes access to managed objects.

The default SNMPv3 username is administrator, with SHA authentication, and DES privacy protocol.

SSH (Secure Shell) Management

You may securely also manage the AP using SSH (Secure Shell). The AP supports SSH version 2, for secure remote CLI
(Telnet) sessions. SSH provides strong authentication and encryption of session data.

10
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The SSH server (AP) has host keys - a pair of asymmetric keys - a private key that resides on the AP and a public key
that is distributed to clients that need to connect to the AP. As the client has knowledge of the server host keys, the client
can verify that it is communicating with the correct SSH server.

NOTE: The remainder of this guide describes how to configure an AP using the HTTP Web interface or the CLI interface.
For information on how to manage devices using SNMP or SSH, see the documentation that came with your
SNMP or SSH program. Also, see the MIB files for information on the parameters available via SNMP and SSH.

IMPORTANT!

The remainder of the User Guide discusses installing your AP and managing it using the Web and CLI
interfaces only.

1
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Installation and Initialization

In this chapter:

* AP-700 Hardware Description
— Overview
— LED Indicators
— Power-over-Ethernet (PoE)
— Antennas
* Prerequisites
» System Requirements
* Product Package
* Hardware Installation
— Attach Cables
— Install the Security Cover (Optional)
— Mount the AP-700
— Power On the Unit
— Install External Antennas (Professional Installation Required)
* Initialization
— Using ScanTool
— Logging In
— Using the Setup Wizard
— Installing the Software
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AP-700 Hardware Description

Overview

The AP-700 is a tri-mode AP that supports 802.11b, 802.11g, or 802.11a clients. The unit contains one embedded
802.11a/b/g radio that supports the following operational modes:

802.11a only mode
802.11b only mode
802.11g only mode
802.11b/g mode
802.11g-wifi

NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band (802.11b and
802.11g) support only. 802.11a functionality covered in this User Guide is not supported.

The AP-700 can be powered through either PoE (802.3af Power-over-Ethernet) or through an external DC power source
using the power cord.

The AP-700 includes a a power jack, a 10/100 base-T Ethernet port, and an RS-232 serial data communication port. See
Figure 2-1. The AP includes an optional security cover that can be installed to protect against access to the power and
LAN cables and to the reset and reload buttons.

[’ :
(mm = | fe©
(ﬁ \ i\

Power LAN RS-232 Reset  Reload

Figure 2-1 Rear Panel

The unit has been designed to rest horizontally on a flat surface, but can be wall- or ceiling- mounted with the long axis
vertical. The unit includes screw slots in the bottom plastic for mounting to a flat wall or ceiling.

LED Indicators
The top panel of the AP-700 has the following LED indicators. See Power On the Unit for a description of LED behavior.

13
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Ethernet Wireless Power

e -

Figure 2-2 LED Indicators on the Top Panel

Power-over-Ethernet (PoE)

The AP-700 is equipped with an 802.3af-compliant Power-over-Ethernet (PoE) module. PoE delivers both data and
power to the access point over a single Ethernet cable. If you choose to use PoE, there is no difference in operation; the
only difference is in the power source.

* The PoE integrated module receives ~48 VDC over a standard Category 5 Ethernet cable.
» To use PoE, you must have a PoE hub (also known as a power injector) connected to the network.

* The cable length between the PoE hub and the Access Point should not exceed 100 meters (approximately 325 feet).
The PoE hub is not a repeater and does not amplify the Ethernet data signal.

» If connected to an PoE hub and an AC power supply simultaneously, the Access Point draws power from PoE.
Also see Hardware Installation.

NOTE: The AP’s 802.3af-compliant POE module is backwards compatible with all ORINOCOQO Active Ethernet (PoE) hubs
that do not support the IEEE 802.3af standard.

Antennas

The AP-700 employs two internal antennas for antenna diversity: one is vertically polarized, and the other is horizontally
polarized to provide optimal spatial and polarization diversity. When the AP is hung on the wall of an office or building, the
horizontally polarized antenna provides coverage for that particular floor level. The vertically polarized antenna provides
spatial diversity for the horizontally polarized antenna in the event of an antenna null. In addition, the vertically polarized
antenna provides some coverage above and below the current floor level. When the AP is mounted on the ceiling or
sitting on a table, the effect is the same, but the roles of the two antennas switch.

The AP supports both receive and transmit diversity. When receiving, the AP chooses the antenna that receives the
strongest signal. When transmitting, the AP chooses the antenna with the highest success rate, and broadcasts are
transmitted on alternating antennas.

Antenna diversity is enabled by default (set to “auto”). When using the internal antennas, Proxim recommends leaving
antenna diversity enabled. However, you may disable antenna diversity by manually selecting which antenna to use
through the Command Line Interface.

See External Antennas for information and Install External Antennas (Professional Installation Required) for installation
instructions.

14
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External Antennas

The AP-700 also has two antenna connectors for use with external antennas.

NOTE:
AP-700 units using external antennas must be installed by a suitably trained professional installation
technician or by a qualified installation service.

See Hardware Installation for AP cabling and mounting instructions, and Install External Antennas
(Professional Installation Required) for external antenna installation instructions.

802.11a/b/g Radio
Connectors

Connector 2 -_._\_l____,,lt-;_‘ | — e —
comector 1 — B 2 ||| ]} oroceen |

e X

Figure 2-3 AP-700 Antenna Connectors

When the AP is mounted on a wall, connector 1 corresponds to the horizontally polarized internal antenna, providing a
coverage pattern parallel to the wall; connector 2 corresponds to the vertically polarized internal antenna, providing a
coverage pattern parallel to the ceiling/floor. When the AP is mounted to a ceiling, connector 1 corresponds to the
vertically polarized internal antenna, and connector 2 corresponds to the horizontally polarized internal antenna. Plugging
an external antenna in to the antenna connector disables the corresponding internal antenna.

The AP continues to support antenna diversity with external antennas connected. With one external antenna connected
to one of the two antenna connectors on a radio, one internal antenna and one external antenna are used for antenna
diversity. With two external antennas connected, both external antennas are used for antenna diversity, and both internal
antennas are disabled.

With external antennas connected, you may wish to manually select a particular antenna for use. To do so, disable
antenna diversity by manually selecting which antenna to use through the Command Line Interface.

NOTE: Using two external antennas is not recommended.
For a list of recommended antennas, see http://www.proxim.com/products/wifi/accessories.

For installation instructions, see Install External Antennas (Professional Installation Required).

15
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Prerequisites

Before installing your unit, you need to gather certain network information. The following table identifies the information

you need.

Network Name (SSID of the
wireless cards)

You must assign the Access Point a Network Name before wireless users can
communicate with it. The clients also need the same Network Name. This is not the
same as the System Name, which applies only to the Access Point. The network
administrator typically provides the Network Name.

AP’s IP Address

If you do not have a DHCP server on your network, then you need to assign the
Access Point an IP address that is valid on your network.

HTTP Password

Each Access Point requires a read/write password to access the web interface. The
default password is public.

CLI Password

Each Access Point requires a read/write password to access the CLI interface. The
default password is public.

SNMP Read Password

Each Access Point requires a password to allow get requests from an SNMP
manager. The default password is public.

SNMP Read-Write Password

Each Access Point requires a password to allow get and set requests from an SNMP
manager. The default password is public.

SNMPv3 Authentication
Password

If Secure Management is enabled, each Access Point requires a password for sending
authenticated SNMPv3 messages. The default password is public. The default
SNMPv3 username is administrator, with SHA authentication, and DES privacy
protocol.

SNMPv3 Privacy Password

If Secure Management is enabled, each Access Point requires a password when
sending encrypted SNMPv3 data. The default password is public.

Security Settings

You need to determine what security features you will enable on the Access Point.

Authentication Method

A primary authentication server may be configured; a backup authentication server is
optional. The network administrator typically provides this information.

Authentication Server Shared
Secret

This is a password shared between the Access Point and the RADIUS authentication
server (so both passwords must be the same), and is typically provided by the network
administrator.

Authentication Server
Authentication Port

This is a port number (default is 1812) and is typically provided by the network
administrator.

Client IP Address Pool
Allocation Scheme

The Access Point can automatically provide IP addresses to clients as they sign on.
The network administrator typically provides the IP Pool range.

DNS Server IP Address

The network administrator typically provides this IP Address.

Gateway IP Address and
Subnet Mask

The gateway IP address and subnet mask of the network environment where the
Access Point is deployed.

System Requirements

To begin using an AP, you must have the following minimum requirements:

* A 10Base-T Ethernet or 100Base-TX Fast Ethernet switch or hub or cross-over Ethernet cable

* At least one of the following IEEE 802.11-compliant devices:
— An 802.11a, 802.11b, or 802.11b/g client device

» A computer that is connected to the same IP network as the AP and has one of the following Web browsers installed:
— Microsoft® Internet Explorer 6 with Service Pack 1 or later and patch Q323308

— Netscape® 7.1 or later

16
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Product Package

Each AP-700 shipment includes the items in the following table. Verify that you have received all parts of the shipment.

NOTE: Unless noted in this table, cables are not supplied with the unit.

AP-700 Unit

&o;mnme'mn \

W S e i i

Power Cord

Security Cover

Ceiling/Wall Mount Plate

Installation CD

Quick Installation Guide

17



Installation and Initialization AP-700 User Guide
Hardware Installation

Hardware Installation

NOTE:
AP-700 units using external antennas must be installed by a suitably trained professional installation
technician or by a qualified installation service.

NOTE:
Before installing and using this product, see the Safety and Regulatory Compliance Guide.

NOTE:
Avant d’installer et d’utiliser ce produit, consultez le manuel Safety and Regulatory Compliance
Guide.

NOTA:
Prima dell’installazione e dell’utilizzo del prodotto, consultare il documento Safety and Regulatory
Compliance Guide (Guida per la sicurezza e la conformita alle normative).

ANMERKUNG:
Lesen Sie vor der Installation und Verwendung dieses Produkts die wichtigen Informationen im
Handbuch Safety and Regulatory Compliance Guide.

NOTA:
Antes de instalar y utilizar este producto, consulte el manual Safety and Regulatory Compliance
Guide (Manual de seguridad y cumplimiento de la normativa).

HER
ORI EA A b= L THEATSEIZ, [Safety and Regulatory Compliance Guide./ .

Perform the following procedures to install the AP hardware:

» Attach Cables

» Install the Security Cover (Optional)
*  Mount the AP-700

» Power On the Unit

Attach Cables

Cabling without Power Over Ethernet (PoE)

1. Plug the barrel of the power cable from the power supply into the power jack (the left-most port in the back of the unit,
see figure).

2. Connect one end of an Ethernet cable (not supplied) to the unit's LAN port (see figure). The other end of the cable
should not be connected to another device until after installation is complete:

* Use a straight-through Ethernet cable if you intend to connect the unit to a switch, hub, or patch panel.
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* Use a cross-over Ethernet cable or adapter if you intend to connect the unit to a single computer.

Power r‘\‘ S
\\M

A
Ethernet T ..

to Switch, Hub or Patch Panel
(if connected to a PC, use a ~—
cross-over cable or adapter)

Figure 2-4 Cabling without PoE

3. Optionally, connect an RS-232 cable (not shown) to the RS-232 console port (the right port, labeled “RS-232").
NOTE: You cannot install the security cover to the AP-700 if an RS-232 cable is connected.

4. Continue with Install the Security Cover (Optional).

Cabling with Power Over Ethernet (PoE)

1. To use PoE, you must use a PoE adapter such as the ORINOCO 1-Port Active Ethernet DC Injector (ordered
separately). Connect one end of an Ethernet cable (not supplied) to the unit's LAN port. Connect the other end to the
Data and Power Out port of the DC Injector (see figure).

2. Connect one end of a second Ethernet cable (not supplied) to the Data In port of the DC Injector (see figure). The
other end of the cable should not be connected to another device until after installation is complete:

* Use a straight-through Ethernet cable if you intend to connect the unit to a switch, hub, or patch panel.
» Use a cross-over Ethernet cable or adapter if you intend to connect the unit to a single computer.

Ethernet to
AP’s LAN Port

{‘?\“ - D:';é_’é\-\er Decs
. . )

Ethernet to -

Data & Power Out on
the DC Injector

! EEE 302 laf Complia

v

Ethernet to
Switch, Hub or Patch Panel
(If connected to a PC, use a
cross-over cable or adapter)

Figure 2-5 Cabling with PoE

3. Optionally, connect an RS-232 cable (not shown) to the RS-232 console port (the right port, labeled “RS-232").
NOTE: You cannot install the security cover to the AP-700 if an RS-232 cable is connected.

4. Continue with Install the Security Cover (Optional) below.
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Install the Security Cover (Optional)

You can optionally install a security cover to deter unauthorized access to the unit. The security cover is a plastic
enclosure that prevents access to the cabling and the Reset and Reload buttons.

1. Open the split end of the security cover just enough to slide the power cable (if not using PoE) and the Ethernet cable
through the opening until they fit inside the straight clamping portion of the cover (see figure). Exercise care as you
slide the cable(s) so you do not accidentally break the cover.

2. Slide the hinging end of the security cover into the hole on the rear panel of the unit to the left of the connectors. Once
in place, pivot the right side of the cover to bring it close to the rear panel of the unit.

3. Use the two attached screws to fasten the security cover onto the rear panel of the unit.

o’

Figure 2-6 Installing the Security Cover

Mount the AP-700

Proxim recommends that you have a site survey professionally conducted to determine the best location for the AP. For
professional site surveyors, Ekahau Site Survey software is included in the Xtras folder on the Installation CD-ROM.

Note that the AP-700 has been certified under UL Standard 2043 and can be installed in the plenum. In an office building,
plenum is the space between the structural ceiling and the tile ceiling that is provided to help air circulate. Many
companies also use the plenum to house communication equipment and cables. These products and cables must
comply with certain safety requirements, such as Underwriter Labs (UL) Standard 2043: “Standard for Fire Test for Heat
and Visible Smoke Release for Discrete Products and Their Accessories Installed in Air-Handling Spaces”.

NOTE: When installed in a plenum, the AP must use PoE.
Once you have chosen a final location for your unit, the following are the mounting options are available:

* Wall Mounting
* Ceiling Mounting

Wall Mounting
Follow these steps to mount the unit on a wall:

1. If the unit’s power supply is plugged in, unplug it.
2. Put the mounting plate up to the wall so that the embossed letter “L” is on top (see figure). If the plate is correctly
oriented, the circular tab that is vertically aligned with the square hole should be on top.

3. Fasten the mounting plate with two screws through the circular holes of the plate. Depending on the type of wall, you
may need to use the two fasteners provided.

4. Holding the unit so that the connectors on the rear are facing left, align the two holes on the bottom of the unit with the
two tabs on the mounting plate. Press the unit down so it is flush with the plate.
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5. Carefully slide the unit to the right until the tabs snap securely onto the narrow holes of the unit. If the unit is mounted

correctly, no portion of the mounting plate should protrude from any of the sides of the unit.

—T

Figure 2-7 Mounting the AP to a Wall

Ceiling Mounting

Follow these steps to mount the unit to a ceiling:

1. If the unit’s power supply is plugged in, unplug it.

2. Snap the rectangular tabs on the back of the mounting plate onto a ceiling T-bar. You may need to slightly rotate the

plate until it securely snaps onto the T-bar.

3. Fasten the mounting plate to the ceiling tile with two screws through the circular holes of the plate.

4. Position so that the embossed letter “L” on the mounting plate is facing up (see previous figure). Holding the unit so
that the connectors on the rear are facing to left, align the two holes on the bottom of the unit with the two tabs on the
mounting plate. Press the unit up so it is flush with the plate.

5. Carefully slide the unit to the right until the tabs snap securely onto the narrow holes of the unit. If the unit is mounted

correctly, no portion of the mounting plate should protrude from any of the sides of the unit.

Power On the Unit

The AP can be powered by a power supply (just plug the power cord of the power supply into an AC power outlet), or by

Power-over-Ethernet (connect a PoE DC injector to the Ethernet cable).

When the unit is powered on, it performs startup diagnostics. When startup is completed, the LEDs show the operational

state of the unit.
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The LED indicators exhibit the following behavior:

at 100 Mbps with no traffic.

for use.

Indication Ethernet Wireless Interface Power
(802.11a/b/g radio)
Solid Green Ethernet interface is connected |Wireless interface is preparing  |AP image running.

Blinking Green

Ethernet interface is connected
at 100 Mbps with traffic.

Wireless interface is transmitting
or receiving wireless packets.

n/a

Solid Amber

Ethernet interface is connected
at 10 Mbps with no traffic.

n/a

The Bootloader is loading the
application software.

Blinking Amber |The Ethernet interface is n/a The AP is reloading.
connected at 10 Mbps with
traffic.
Solid Red n/a n/a Power On Self Test (POST)
running.
Blinking Red n/a n/a Rebooting.

Install External Antennas (Professional Installation Required)

Optionally, you can connect two external antennas to your AP.

All products using external antennas must be professionally installed, and the transmit power of the system must be
adjusted by the professional installers to ensure that the system EIRP is in compliance with the limit specified by the
regulatory authority of the country of application.

See the following sections for more information:

* Connecting Antenna(s)
* Adjusting Tx Output Power
* Antenna Types and Maximum Gain

Connecting Antenna(s)

Follow the mounting instructions included with your external antenna, and then connect the antenna cable to the AP, as

follows:

1. Press down near the center of the compartment covering and slide open the external antenna access compartments.
The compartment closer to the LED panel contains the connectors.

NOTE: AP-700 models 8675-US2 and 8675-AU do not provide external antenna connectors for 5 GHz (802.11a)
operation.
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Figure 2-8 Opening the Antenna Compartment

2. There are two antenna connectors in the AP-700, labeled 1 and 2 Connect the antenna cable to connector 1 (the
connector closer to the LED panel in the compartment).

802.11a/b/g Radio
Connectors
Connector 2 '_h"‘“-—--..‘_"l_-:— e
| e—"
Connector 1 —I’E_du | ' [ ' ’ - SRR _.1
' =

Figure 2-9 Antenna Connectors

3. Ifinstalling a second external antenna (not recommended), connect the antenna cable to connector 2.

4. Close the external antenna access compartment.
5. If desired, manually select which antenna(s) to use through the Command Line Interface.

Adjusting Tx Output Power

NOTE: When the system is set to transmit at the maximum power, professional installers must ensure that the maximum
EIRP limit is not exceeded. To achieve this, they may have to add attenuation between the device and the

antenna when a high gain antenna is used.

Use the following formula in combination with the table of EIRP limits in US, Canada, and EU countries to calculate
system transmit power (based on EIRP limits) of these countries:

Tx Power (dBm) = EIRP Limit (dBm) + FL (dB) — G (dB)
where:

Tx Power = Output power measured at the antenna input
EIRP Limit = EIRP limits specified below
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FL = Feeder loss including loss of connectors
G = Antenna Gain

Band EIRP Limit (dBm)
USA and Canada EU
2.4 - 2.4835 GHz (Point-to-Multipoint 36 20
2.4 - 2.4835 GHz (Point-to-Point) When G < 6: 36 20
When G >/= 6, use the following
equation:
G-6
36 - =5
5.15-5.25 GHz 23 23
5.25-5.35 GHz 30 23
5.47 - 5.725 GHz 30 30
5.725 - 5.850 GHz (Point-to-Multipoint) 36 14
5.725 - 5.850 GHz (Point-to-Point) No limit 14

Antenna Types and Maximum Gain

For devices using external antennas, professional installers should select only the antenna types listed in the following
table, with gain not exceeding the listed maximum gain for each type.

Frequency Band Antenna Type Maximum Gain
2.4 GHz Omni 10
Panel 14
Yagi 14
Parabolic 24
5 GHz Omni 13
Panel 28.2
Sector 17
Parabolic 33.4
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Initialization

The following sections detail how to initialize the AP using ScanTool, log in to the HTTP interface, perform an initial
configuration of the AP using the Setup Wizard, and download the required AP software.

* Using ScanTool

* Logging In

* Using the Setup Wizard
* Installing the Software

Using ScanTool

ScanTool is a software utility that is included on the installation CD-ROM. It is an initial configuration tool that allows you
to find the IP address of an Access Point by referencing the MAC address in a Scan List, or to assign an IP address if one
has not been assigned.

The tool automatically detects the Access Points installed on your network, regardless of IP address, and lets you
configure each unit’s IP settings. In addition, you can use set initial device parameters that will allow the AP to retrieve a
new software to an AP that does not have a valid software image installed (see Client Connection Problems).

To access the HTTP interface and configure the AP, the AP must be assigned an IP address that is valid on its Ethernet
network. By default, the AP is configured to obtain an IP address automatically from a network Dynamic Host
Configuration Protocol (DHCP) server during boot-up. If your network contains a DHCP server, you can run ScanTool to
find out what IP address the AP has been assigned. If your network does not contain a DHCP server, the Access Point’s
IP address defaults to 169.254.128.132. In this case, you can use ScanTool to assign the AP a static IP address that is
valid on your network.

ScanTool Instructions
Follow these steps to install ScanTool and initialize the AP:

1. Power up, reboot, or reset the AP.

2. Double-click the ScanTool icon on the Windows desktop to launch the program (if the program is not already
running). If the icon is not on your desktop, click Start > All Programs > ORINOCO > AP-700 > ScanTool.

NOTE: If your computer has more than one network adapter installed, you will be prompted to select the adapter that
you want ScanTool to use before the Scan List appears. You can use either an Ethernet or wireless adaptor.
If prompted, select an adapter and click OK. You can change your adapter setting at any time by clicking the
Select Adapter button on the Scan List screen.

ScanTool scans the subnet and displays all detected Access Points. The ScanTool's Scan List screen appears, as
shown in the following example.

MmN -0l x|
MAL Ackdwzs | Syster Mirne T | Uiptise: | Zystem Darcrgiion Anmcan
AP 324128132 0d3RSn0 AP w2 3.0 SHAAUT ABSTIS:
_Owge |
Sebect Adapier
Eboed Cencel

Figure 2-10 Scan List

3. Locate the MAC address of the AP you want to initialize within the Scan List.
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NOTE: If your Access Point does not appear in the Scan List, click the Rescan button to update the display. If the unit
still does not appear in the list, see Troubleshooting for suggestions. Note that after rebooting an Access
Point, it may take up to five minutes for the unit to appear in the Scan List.
4. Do one of the following:
» If the AP has been assigned an IP address by a DHCP server on the network:
a. Highlight the entry for the AP you want to configure.
b. Click the Change button. The Change screen appears.
c. Click on the Web Configuration button at the bottom of the change screen.
d. Proceed to the Logging In section for information on how to access the HTTP interface using this IP address.

» If the AP has not been assigned an IP address (in other words, the unit is using its default IP address,
169.254.128.132), follow these steps to assign it a static IP address that is valid on your network:

a. Highlight the entry for the AP you want to configure.
b. Click the Change button. The Change screen appears.

chamge x|
WAL Aujdesss |
Hare | }
IF Addiest Type F Bratid " Dynamc
IF Ak |-n:|n:|3:|
Subnet Matk. 252550
Galeway [P Addwss  [1B9.254120133

TR Serent IP Address ||

Image Fie Mame [

Readwiln Pagswond |

et Comtiguaation| ok | cewe |

Figure 2-11 Scan Tool Change Screen

c. SetIP Address Type to Static.

d. Enter a static IP Address for the AP in the field provided. You must assign the unit a unique address that is
valid on your IP subnet. Contact your network administrator if you need assistance selecting an IP address for
the unit.

e. Enter your network’s Subnet Mask.

f. Enter your network’s Gateway IP Address.

g. Enter the SNMP Read/Write password in the Read/Write Password field (for new units, the default SNMP
Read/Write password is public).

NOTE: The TFTP Server IP Address and Image File Name fields are only available if ScanTool detects that
the AP does not have a valid software image installed. See Client Connection Problems.
h. Click OK to save your changes.

i. The Access Point will need to reboot to apply any changes you made. When the reboot message appears,
click OK to reboot the device and return to the Scan List screen.

j.  After allowing sufficient time for the device to reboot, click Rescan to verify that your changes have been
applied.
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k. Click the Change button to return to the Change screen.
I.  Click the Web Configuration button at the bottom of the Change screen.
m. Proceed to the Logging In section for information on how to access the HTTP interface using this IP address.

Logging In

Once the AP has a valid IP Address and an Ethernet connection, you may use your web browser to monitor and
configure the AP. (To configure and monitor using the command line interface, see Command Line Interface (CLI).)

1. Open a Web browser on a network computer.
2. If necessary, disable the browser’s Internet proxy settings. For Internet Explorer users, follow these steps:

Select Tools > Internet Options.

Click the Connections tab.

Click LAN Settings.

If necessary, remove the check mark from the Use a proxy server box.
Click OK twice to save your changes and return to Internet Explorer.

3. Enter the Access Point’s IP address in the browser’s Address field and press Enter or Go.

This is either the dynamic IP address assigned by a network DHCP server or the static IP address you manually
configured. See Using ScanTool for information on how to determine the unit’s IP address and manually configure a
new IP address, if necessary.

The Enter Network Password screen appears.

e

?‘) Pleate lype pour uer name and password

Site: 169.254/50.2
Realm Access-Product
Uset Mame |

Password | ..... 1

™ Save thir passwcrd in pour pacsword st

(o] oo |

Figure 2-12 Enter Network Password

4. Enter the HTTP password in the Password field. Leave the User Name field blank. For new units, the default HTTP
password is public.

If you are logging on for the first time the Setup Wizard will launch automatically.

NOTE: Setup Wizard will not relaunch on subsequent logins. To force the Setup Wizard to launch upon login, click

Management > Services and choose Enable from the Setup Wizard drop down menu.

5. To configure the AP using the Setup Wizard, see Using the Setup Wizard; to configure the AP without using the Setup
Wizard, click Exit. Upon clicking Exit, the System Status screen will appear.
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tal SN-04UT45570522
System Status
y v3.1.0
Soniduie IF Address Contact Name
System Name Contact Phone
HMonit System Location yE Loc Contact Email
L Up Time (DD:HH:MW:SS)  02:00:40:21 ObjectiD
Commands System Alarms
This table displays information on the alarms (SNMP Traps) generated by the access point. They should be
Help deleted once they are reviewed and resolved. The alarm severity levels are: Critical, Major, Minor, and
Informational.
Exit
SelactAll 4 Deselect All 3
Reboot
Description Severity Time Stamp
r Link Up. Informational OdaysOhrs0Om24s
Delete 3

Figure 2-13 System Status Screen

The buttons on the left of the screen provide access to the monitoring and configuration options for the AP. See
Advanced Configuration to begin configuring the AP manually.

You can also exit the Web interface or reboot the AP using these buttons.

The Command Line Interface (CLI) also provides a method for monitoring and configuring the AP using Telnet or a
serial connection. For more information about monitoring and configuring the AP with the CLI, see Command Line

Interface (CLI).

Using the Setup Wizard

The first time you connect to an AP’s HTTP interface, the Setup Wizard launches automatically. The Setup Wizard
provides step-by-step instructions for how to configure the Access Point’s basic operating parameters, such as Network
Name, IP parameters, system parameters, and management passwords.

Step 1:
Introduction

Step X
System
Configuration

Step X:
[
Configuration

Step 4:
Passerord
Configuration

Step 5
Wireless
Interfaces
Configuration

Step 6
Summarny

Wekcome 1o the Access Point Setup Wisand. The setup wizard provides & sel of pages for
configuring basic soess poind parameters, which are isted belos.

Systeem is used to configure device nformation such as Sysiem name and contact informason
iguration i uked b configure the miarned (TCPAP) s&ing for the Siceas poind,

PaR 118 wEed b confegure the SAMP, Talnest RE LI}, & HT TE (el detaul]l passwords.
Wireless Interfaces (& used to configure the characteristics of the wirelegs medium

Cllick the Setup Wizand button and the wizand will kead you through & step-by-step guide 1o
configuring your sccees poant. Far more advanced configurstion optons, click the axit button below
& At tha Confegisaation section of this wob interlacs

Oince you have completed the setup wizard, you must reboot the scoess point in order for the
changes to take effect.

H you siart the Setup Wizard but do not complete i, sny changes that you ssved up to the poant that
you exiled e wizard will be asved by ihe Access Poant and applied the next lime tha uwnil reboals,

Satup iz ad g Exid |

Figure 2-14 Setup Wizard

Setup Wizard Instructions

1. Click Setup Wizard to begin. The Setup Wizard supports the following navigation options:
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Save & Next Button: Each Setup Wizard screen has a Save & Next button. Click this button to submit any
changes you made to the unit’'s parameters and continue to the next page. The instructions below describe how to
navigate the Setup Wizard using the Save & Next buttons.

Navigation Panel: The Setup Wizard provides a navigation panel on the left-hand side of the screen. Click the
link that corresponds to the parameters you want to configure to be taken to that particular configuration screen.
Note that clicking a link in the navigation panel will not submit any changes you made to the unit’s configuration on
the current page.

Exit: To exit from the Setup Wizard at any time, click Step 1: Introduction on the navigation panel, and then click
the Exit button.

CAUTION: If you exit from the Setup Wizard, any changes you submitted (by clicking the Save & Next button) up
to that point will be saved to the unit but will not take effect until it is rebooted.

2. Configure the System Configuration settings and click Save & Next. See System for more information.

NOTE: On APs with model numbers ending in -WD, you must select the operating country on this page or on the

Configure > System tab. Setting the country makes the AP automatically compliant with the rules of the
regulatory domain in which it is used by configuring the allowed frequency bands, channels, Dynamic
Frequency Selection status, Transmit Power Control status, and power levels. If the country is not selected, an
informational message will appear on the Status page, and you will be unable to configure interface
parameters.

3. Configure the Access Point’s IP Configuration, including basic IP address settings, if necessary, and click Save &
Next. See Basic IP Parameters for more information.

4. On the Password Configuration screen, assign the AP new passwords to prevent unauthorized access and click
Save & Next. Each management interface has its own password:

SNMP Read Password
SNMP Read-Write Password
CLI Password

HTTP (Web) Password

By default, each of these passwords is set to “public’. See Passwords for more information.
5. Configure the basic Wireless Interface Configuration settings:

Select the Operational Mode as follows and click Save & Next:

The Wireless (802.11a/b/g) interface can be configured to operate in the following modes:
+ 802.11a only mode: The radio uses the 802.11a standard only.

* 802.11b mode only: The radio uses the 802.11b standard only.

+ 802.11g mode only: The radio is optimized to communicate with 802.11g devices. This setting will provide
the best results if this radio interface will only communicate with 802.11g devices.

+ 802.11b/g mode: This is the default mode. Use this mode if you want to support a mix of 802.11b and
802.11g devices.

+ 802.11g-wifi mode: The 802.11g-wifi mode has been defined for Wi-Fi testing purposes. It is not
recommended for use in your wireless network environment.

NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band
(802.11b and 802.11g) support only. 802.11a functionality covered in this User Guide is not supported.

In general, you should use either 802.11g only mode (if you want to support 802.11g devices only) or 802.11b/g
mode to support a mix of 802.11b and 802.11g devices.

Configure the following available options and click Save & Next:
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— Primary Network Name (SSID): Enter a Network Name (between 1 and 32 characters long) for the wireless
network. You must configure each wireless client to use this name as well. Note that the unit supports up to 16
SSIDs/VLANSs. Please see the Advanced Configuration chapter for information on the detailed rules on
configuring multiple SSIDs, VLANSs, and security profiles.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to
misinterpret the name.

— Auto Channel Select: By default, the AP scans the area for other Access Points and selects the best
available communication channel, either a free channel (if available) or the channel with the least amount of
interference. Remove the check mark to disable this option. See Dynamic Frequency Selection/Radar
Detection (DFS/RD) for information and Available Channels for a list of available channels.

— Frequency Channel: When Auto Channel Select is enabled, this field is read-only and displays the Access
Point’s current operating channel. When Auto Channel Select is disabled, you can specify the Access Point’s
channel. If you decide to manually set the unit’'s channel, ensure that nearby devices do not use the same
frequency. Available Channels vary based on regulatory domain. See Dynamic Frequency Selection/Radar
Detection (DFS/RD) for information and Available Channels for a list of available channels.

— Transmit Rate: Use the drop-down menu to select a specific transmit rate for the AP. The values depend on
the Operational mode. Auto Fallback is the default setting; it allows the AP unit to select the best transmit rate
based on the cell size.

For 802.11a only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/s.

NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band
(802.11b and 802.11g) support only. 802.11a functionality covered in this User Guide is not
supported.

» For 802.11b only -- Auto Fallback, 1, 2, 5.5, 11 Mbits/sec.

+ For 802.11g only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/sec

+ For 802.11b/g -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec

+ For 802.11g-wifi -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec

NOTE: 802.11g-wifi has been defined for Wi-Fi testing purposes. It is not recommended for use in your
wireless network environment.

Additional advanced settings are available on the Interfaces tab.

Also see Security Profile for a description of security features, Management VLAN for a description of VLAN
capabilities, and Configuring Security Profiles for detailed security configuration procedures.

6. Review the configuration Summary. If you want to make any additional changes, use the navigation panel on the
left-hand side of the screen to return to an earlier screen. After making a change, click Save & Next to save the
change and proceed to the next screen.

7. When finished, click Reboot on the Summary screen to restart the AP and apply your changes.

Installing the Software

Proxim periodically releases updated software for the AP on its Web site, http://support.proxim.com. Check the Web site
for the latest updates after you have installed and initialized the unit.

CAUTION: Downgrading a unit shipped with version 3.6 software could cause unstable hardware and is not
recommended.

Download the Software
1. In your web browser, go to http://support.proxim.com.
2. If prompted, create an account to gain access.
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NOTE: The Knowledgebase is available to all website visitors. First-time users will be asked to create an account to
gain access.

Click Search Knowledgebase.

In the Search Knowledgebase field, enter 1686.

Click Search.

Click on the appropriate link to access the download page.

Use the instructions in the following sections to install the new software.

No o~

Install Software with HTTP Interface
Use the Update AP via HTTP tab to update the AP with the latest software image.
1. Click Commands > Update AP > via HTTP.

UpdatesP ) RetioveFile ) Reboot ) Reset |  Hepliok |
via TFTP  vaHTR

This page is vsed to update software images, license file and configuration files in
the Accass Point uging HTTP file tranafer. Click on the brovwse bution to seanch for
the file or enter the path in the text box. Select the file type and click the Update AP
bution to start the file transfer.,

Hote: On updating configuration e the Acceas Poinl will reboot by stgell,

System Infarmation

Sofware Version XXX

Bool Leadar Version XKX

File Type Irma ge "I

FileName  [AP.sei Browse...
Update AP | Cancel |

Figure 2-15 Update AP via HTTP Command Screen

2. From the File Type drop-down menu, select Image.

3. Use the Browse button to locate or manually type in the name of the file (including the file extension) you downloaded
from the Proxim Knowledgebase. If typing the file name, you must include the full path and the file extension in the file
name text box.

4. To initiate the HTTP Update operation, click the Update AP button.

A warning message advises you that a reboot of the device will be required for changes to take effect.

%
? ,l' You are updatng Image fil to the AP, You wil need to reboat the device for changes to take affect. Do you want to procesd 7
| oK I Canos ]

Figure 2-16 Warning Message

5. Click OK to continue with the operation or Cancel to abort the operation.

6. If the operation is unsuccessful, you will receive an error message. If this occurs, see the Troubleshooting chapter or
attempt installing the software with a TFTP server, as described in the next section.
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If the operation is successful, you will receive a confirmation message.
7. Reboot the AP as follows:

* Click Commands > Reboot.

* Enter 0 in the Time to Reboot field.

* Click OK.

Install Software with TFTP Server

A Trivial File Transfer Protocol (TFTP) server allows you to transfer files across a network. You can upload files from the
AP for backup or copying, and you can download the files for configuration and AP Image upgrades. The Solarwinds
TFTP server software is located on the AP Installation CD-ROM. You can also download the latest TFTP software from
Solarwind’s Web site at http://www.solarwinds.net. The instructions that follow assume that you are using the Solarwinds
TFTP server software; other TFTP servers may require different configurations.

NOTE: If a TFTP server is not available in the network, you can perform similar file transfer operations using the HTTP
interface.See Update AP via HTTP.

After the TFTP server is installed:

* Check to see that TFTP is configured to point to the directory containing the AP Image.

» Make sure you have the proper TFTP server IP address, the proper AP Image file name, and that the TFTP server is
operational.

* Make sure the TFTP server is configured to both Transmit and Receive files (on the TFTP server’s Security tab), with
no automatic shutdown or time-out (on the Auto Close tab).
The following types of files can be downloaded to the AP from a TFTP server:

» Config (configuration file)

* Image (AP software image or kernel)

» UpgradeBspBIl (BSP/Bootloader firmware file)
» SSL Certificate

* SSL Private Key

* SSH Public Key

* SSH Private Key

» CLI Batch File

Install Updates from your TFTP Server using the Web Interface

1. Download the latest software from http://support.proxim.com. See Download the Software for instructions.
2. Copy the latest software updates to your TFTP server.

In the Web Interface, click the Commands button and select the Download tab.

Enter the IP address of your TFTP server in the field provided.

Enter the File Name (including the file extension). If the file is located in the default TFTP directory, you need enter
only the file name. Otherwise, enter the full directory path and file name.

Select the File Type from the drop-down menu (use Img for software updates).
7. Select Download & Reboot from the File Operation drop-down menu.
8. Click OK. The Access Point will reboot automatically when the download is complete.

o e

o

Install Updates from your TFTP Server using the CLI

1. Download the latest software to http://support.proxim.com. See Download the Software for instructions.
2. Copy the latest software updates to your TFTP server.

3. Open the CLI interface via Telnet or a serial connection.
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4. Enter the CLI password when prompted.
5. Enter the command: download <tftpaddr> <filename> img

The download will begin, and the image will be downloaded to the Access Point.
6. When the download is complete, type reboot 0 and press Enter.
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System Status

The first screen displayed after Logging In is the System Status screen. You can always return to this screen by clicking
the Status button.

SN-04UT45570522
System Status
y v3.1.0
Soniduie IF Address Contact Name
System Name Contact Phone
HMonit System Location tion Contact Email
L Up Time (DD:HH:MW:SS)  02:00:40:21 ObjectiD
Commands System Alarms
This table displays information on the alarms (SNMP Traps) generated by the access point. They should be
Help deleted once they are reviewed and resolved. The alarm severity levels are: Critical, Major, Minor, and
Informational.
Exit
SelectAl g Deselect All 3
Reboot
Description Severity Time Stamp
r Link Up. Informational OdaysOhrs0Om24s
Delete 3

Figure 3-1 System Status Screen

The System Status screen provides the following information:

» System Status: This area provides system-level information, including the unit’s IP address and contact information.
See System for information on these settings.

+ System Alarms: System traps (if any) appear in this area. Each trap identifies a specific severity level: critical, major,
minor, and informational. See Alarms for a list of possible alarms.

NOTE: On APs with model numbers ending in -WD, an operating Country must be selected (during the Setup Wizard
or on the Configure > System tab). If a country has not been selected, an informational message will appear
in the System Alarms list, and you will be unable to configure interface parameters.

From this screen, you can also access the AP’s monitoring and configuration options by clicking on the buttons on the
left of the screen.
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Advanced Configuration

This chapter contains information on configuring settings in the following categories:

System: Configure specific system information such as system name and contact information.

Network: Configure IP, DNS client, DHCP server, DHCP Relay Agent, DHCP Relay Servers, Link Integrity, and SNTP
settings.

Interfaces: Configure the Access Point’s interfaces: Wireless and Ethernet. Configure the and a Wireless Distribution
System (WDS).

Management: Configure the Access Point’'s management Passwords, IP Access Table, and Services such as
configuring secure or restricted access to the AP via SNMPv3, HTTPS, or CLI. Configure Secure Management, SSL,
Secure Shell (SSH), and RADIUS Based Access Management. Set up Automatic Configuration for Static IP.

Filtering: Configure Ethernet Protocol filters, Static MAC Address filters, Advanced filters, and Port filters.

Alarms: Configure the Alarm (SNMP Trap) Groups, the Alarm Host Table, and the Syslog features.

Bridge: Configure the Spanning Tree Protocol, Storm Threshold protection, Intra BSS traffic, and Packet Forwarding.
QoS: Configure Wireless Multimedia Enhancements/Quality of Service parameters and QoS policies.

Radius Profiles: Configure RADIUS features such as RADIUS Access Control and Accounting.

PXU (ProximUnify) Profile: Configure ProximUnify features to enable VLAN support.

SSID/VLAN/Security: Configure SSIDs, VLANs, and security profiles. Configure security features such as MAC
Access Control, WPA, 802.11i (WPA2), WEP Encryption, and 802.1x.

To configure the AP using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for
instructions.

You may also configure the AP using the command line interface. See Command Line Interface (CLI) for more
information.

To configure the AP via HTTP/HTTPS:

1.

Click the Configure button located on the left-hand side of the screen.
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Alarms 1 Bridge ‘ QoS ‘ RADIUS Profiles ‘SSDMAMSewmy‘
System | Network % intefaces %  Management %  Fiteing %

Configure

There are ten main categories of configuration for the access point, which may be changed to suit your
network properties and configuration.

System is used to pecific system i ion such as system name and contact information.
Hetwork is used to configure IP settings, DNS client, DHCP server, DHCP relay agent, and Link Integrity.
Interfaces is used to configure the access point operational modes and interfaces: Wireless and Ethernet.

[} is used to gure the access point management Passwords, IP Access Table, Services
and Auto C i and C Resetto feature.

Filtering is used to configure Ethernet Protocol filters, Static MAC Address filters, Advanced filters, and
Port filters.

Alarms is used to enable and disable Alarm (SNMP Trap) Groups, configure the Alarm Host Table, the
Syslog, and the Rogue Scan feature.

Bridge is used to configure the Spanning Tree Protocol, Storm Threshold protection, Intra BSS traffic, and
Packet Forwarding.

QoS is used to configure the Quality of Service (Qo5) feature. This tab can be used to configure QoS
Policies, Priority Mapping and EDCA values,

RADIUS Profiles is used to configure RADIUS Profiles for servers used for MAC based RADIUS
Authentication, EAP/802.1x, and Accounting

SSIDVLAN/Security is used to configure multiple S5ID's for each wireless interface(s), VLAN properties,
MAC Access Control, and Security Profiles.

Figure 4-1 Configure Main Screen

2. Click the tab that corresponds to the parameter you want to configure. For example, click Network to configure the
Access Point’s TCP/IP settings.

Each Configure tab is described in the remainder of this chapter.
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System

You can configure and view the following parameters within the System Configuration screen:

Name: The name assigned to the AP. See the Dynamic DNS Support and Access Point System Naming Convention
sections for rules on naming the AP.

Country: The country in which the AP will be used. Note that some countries have two selectable options (one for
indoor use and one for outdoor use). Setting the country makes the AP automatically compliant with the rules of the
regulatory domain in which it is used by configuring the allowed frequency bands, channels, Dynamic Frequency
Selection status, Transmit Power Control status, and power levels. See Interfaces for more information about these
settings.

NOTE: You must reboot the AP in order for country selection to take effect.

NOTE: Country selection is available only on APs with model numbers ending in -WD. If country selection is available,
however, it must be set before any interface parameters can be configured.
Location: The location where the AP is installed.

GPS Longitude: The longitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

GPS Latitude: The latitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

GPS Altitude: The altitude at which the AP is installed. Enter the value in the format required by your network
management system. If using the ProximVision™ Network Management System (recommended), enter the value in
decimals (e.g., 78.4523).

Contact Name: The name of the person responsible for the AP.
Contact Email: The email address of the person responsible for the AP.
Contact Phone: The telephone number of the person responsible for the AP.

Object ID: This is a read-only field that displays the Access Point’s system object identification number; this
information is useful if you are managing the AP using SNMP.

Ethernet MAC Address: This is a read-only field that displays the unique MAC (Media Access Control) address for
the Access Point’s Ethernet interface. The MAC address is assigned at the factory.

Descriptor: This is a read-only field that reports the Access Point’'s name, serial number, current image software
version, and current bootloader software version.

Up Time: This is a read-only field that displays how long the Access Point has been running since its last reboot.
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System
; - RADIUSPXU R +
Alarms Bridge QoS & . SSIDVLANISecurty
Profiles ’
\ MNetwork \ Interfaces \ Management \ Filtering
Status
This tab allows for configuration of system unique parameters and contact information.
Note: Ghanges to these paramelers require access point rebool in order to take effect
Wonitor Note: Name is also used as Dynamic DNS hostname
Note: Name can only contain alphanumeric characters. Hyphen is the only special character allowed No
Commands spaces are allowed. First character can't be 8 numeric.
1
Help Hame [NMS-AP-2000M 2B q-2
Location .Ur‘-:eu Kingdom |
Exit GPS Longitude -121.8893
GPS Latitude [57.3321
Rebool GPS Altitude [10

Contact Name

name{@Crganization.con

Contact Phang Numbear

Ethermnet MAC Address
Descriptor 7 0(1215) SN-06UT22600035 v3 1.0
Up Time (DD:HHMICSS

0} 3 Cancel 3

Figure 4-2 System Tab

Dynamic DNS Support

DNS is a distributed database mapping the user readable names and IP addresses (and more) of every registered
system on the Internet. Dynamic DNS is a lightweight mechanism which allows for modification of the DNS data of host
systems whose IP addresses change dynamically. Dynamic DNS is usually used in conjunction with DHCP for mapping

meaningful names to host systems whose IP addresses change dynamically.

Access Points provide DDNS support by adding the host name (option 12) in DHCP Client messages, which is used by

the DHCP server to dynamically update the DNS server.

Access Point System Naming Convention

The Access Point's system name is used as its host name. In order to prevent Access Points with default configurations
from registering similar host names in DNS, the default system name of the Access Point is uniquely generated. Access
Points generate unique system names by appending the last 3 bytes of the Access Point's MAC address to the default

system name.

The system name must be compliant with the encoding rules for host name as per DNS RFC 1123. According to the

encoding rules, the AP name:

» Can contain alphanumeric or hyphen characters only.
» Can contain up to 31 characters.

» Cannot start or end with a hyphen.

« Cannot start with a digit.
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Network
The Network tab contains the following sub-tabs:

» IP Configuration

+ DHCP Server

+ DHCP Relay Agent

» Link Integrity

*  SNTP (Simple Network Time Protocol)

IP Configuration
This tab is used to configure the internet (TCP/IP) settings for the access point.

These settings can be either entered manually (static IP address, subnet mask, and gateway IP address) or obtained
automatically (dynamic).The DNS Client functionality can also be configured, so that host names used for configuring the
access point can be resolved to their IP addresses.

Alarms \ Bridge \ QoS \ RADIUS Profiles \SSIDJ"-;'L;‘«N.-'Securit.'\

System N teraces ) Management Y Fiteing Y\
| DHCPSewver | DHCPRA 4 Linkintegriy §  SNTP Y

This tab is used to configure the internet (TCP/IP) settings for the access point. These
settings can be either entered manually (static IP address, subnet mask, and gateway IP
address) or obtained automatically (dynamic).The DNS Client functionality can also be
configured, so that host names used for configuring the access point can be resolved to
their IP addresses. IP address type will remain static if dhep server is enabled.

Note: Changes to these parameters require access point reboot in order to take effect.

IP Address Assignment Type Static -l
IP Address 192.168.10.21
Subnet Mask [zs5.285.0.0

Gateway IP Address

Enable DNS Client r
DNS Primary Server IP Address [oo00

DNS Secondary Server IP Address [o0.00

DNS Client Default Domain Name
Default TTL (Time To Live) a4
QK § Cancel &

Figure 4-3 IP Configuration

You can configure and view the following parameters within the IP Configuration sub-tab:

NOTE: You must reboot the AP in order for any changes to the Basic IP or DNS Client parameters to take effect.

Basic IP Parameters

* |IP Address Assignment Type: Set this parameter to Dynamic to configure the Access Point as a Dynamic Host
Configuration Protocol (DHCP) client; the Access Point will obtain IP settings from a network DHCP server
automatically during boot-up. If you do not have a DHCP server or if you want to manually configure the Access
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Point’s IP settings, set this parameter to Static.IP Address: The Access Point’s IP address. When IP Address
Assignment Type is set to Dynamic, this field is read-only and reports the unit’s current IP address. The Access Point
will default to 169.254.128.132 if it cannot obtain an address from a DHCP server. Though the Access Point starts
functioning with the default IP address, it will continue to renew as a DHCP address and will get one if DHCP server is
available.

Subnet Mask: The Access Point’s subnet mask. When IP Address Assignment Type is set to Dynamic, this field is
read-only and reports the unit’s current subnet mask. The subnet mask will default to 255.255.0.0 if the unit cannot
obtain one from a DHCP server.

Gateway IP Address: The IP address of the Access Point’s gateway. When IP Address Assignment Type is set to
Dynamic, this field is read-only and reports the IP address of the unit's gateway. The gateway IP address will default to
169.254.128.133 if the unit cannot obtain an address from a DHCP server.

DNS Client

If you prefer to use host names to identify network servers rather than IP addresses, you can configure the AP to act as a
Domain Name Service (DNS) client. When this feature is enabled, the Access Point contacts the network’s DNS server to
translate a host name to the appropriate network IP address. You can use this DNS Client functionality to identify
RADIUS servers by host name.

Enable DNS Client: Place a check mark in the box provided to enable DNS client functionality. Note that this option
must be enabled before you can configure the other DNS Client parameters.

DNS Primary Server IP Address: The IP address of the network’s primary DNS server.

DNS Secondary Server IP Address: The IP address of a second DNS server on the network. The Access Point will
attempt to contact the secondary server if the primary server is unavailable.

DNS Client Default Domain Name: The default domain name for the Access Point’s network (for example,
“proxim.com”). Contact your network administrator if you need assistance setting this parameter.

Advanced

Default TTL (Time to Live): Time to Live (TTL) is a field in an IP packet that specifies the number of hops, or routers
in different locations, that the request can travel before returning a failed attempt message. The Access Point uses the
default TTL for generated packets for which the transport layer protocol does not specify a TTL value. This parameter
supports a range from 0 to 255. By default, TTL is 64.

DHCP Server

CAUTION: If your network does not have a DHCP Server, you can configure the AP as a DHCP server to assign

dynamic IP addresses to Ethernet nodes and wireless clients.Make sure there are no other DHCP servers
on the network and do not enable the DHCP server without checking with your network administrator first, as
it could disrupt normal network operation. Also, the AP must be configured with a static IP address before
enabling this feature.

When the DHCP Server functionality is enabled, you can create one or more IP address pools from which to assign
addresses to network devices.

40



Advanced Configuration AP-700 User Guide
Network

Alarms 1 Bridge 1 QoS 1 RADIUS Profiles ‘[\ SEIDNLANSecurity |
System . | intertaces | Management ¥ Filtering 1
P ConSguration O \l DHCPR A I'L\ Link Inkagrity I SNTP 1

The DHCP server in the accoss point allows for dynamic IP addreas azsignment to both
wirgless clhanis and wired hosis
Nofe: The DHCP parver [ E via Bl § [ ¥ i f f
HCP sar F Changes fo these paramelers reqguire access point reboal in order
b Cake affscL
-
(k]
Mumbar of IF Fool Table Entrigs L1
o} Cancel
F . F |

IP Pool Table

Adis )’ Edi J

Start P EndIP Defaul lease Maximarn Lease Comment  Status

Figure 4-4 DHCP Server Configuration Screen

You can configure and view the following parameters within the DHCP Server Configuration screen:

NOTE: You must reboot the AP before changes to any of these DHCP server parameters take effect.

» Enable DHCP Server: Place a check mark in the box provided to enable DHCP Server functionality.
NOTE: You cannot enable the DHCP Server functionality unless there is at least one IP Pool Table Entry configured.

» Subnet Mask: This field is read-only and reports the Access Point’s current subnet mask. DHCP clients that receive
dynamic addresses from the AP will be assigned this same subnet mask.

» Gateway IP Address: The AP will assign the specified address to its DHCP clients.

* Primary DNS IP Address: The AP will assign the specified address to its DHCP clients.

* Secondary DNS IP Address: The AP will assign the specified address to its DHCP clients.

*  Number of IP Pool Table Entries: This is a read-only field that reports the number of entries in the IP Pool Table.

* IP Pool Table Entry: This entry specifies a range of IP addresses that the AP can assign to its wireless clients. Click
Add to create a new entry. Click Edit to change an existing entry. Each entry contains the following fields:

— Start IP Address: The first IP address in the pool. IP addresses must be within the same subnet as the AP.
— End IP Address: The last IP address in the pool. IP addresses must be within the same subnet as the AP.

— Default Lease Time (optional): The default time value for clients to retain the assigned IP address. DHCP
automatically renews IP Addresses without client notification. This parameter supports a range between 3600 and
86400 seconds. The default is 86400 seconds. If this field is left blank, the default (86400) is used.

— Maximum Lease Time (optional): The maximum time value for clients to retain the assigned IP address. DHCP
automatically renews IP Addresses without client notification. This parameter supports a range between 3600 and
86400 seconds. The default is 86400 seconds. If this field is left blank, the default (86400) is used.
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NOTE: The Default Lease Time cannot be larger than the Maximum Lease Time. If you set the Maximum Lease

Time, you should also set the Default Lease Time to ensure that the Default Lease Time is less than the
Maximum.

— Comment (optional)

— Status: IP Pools are enabled upon entry in the table. You can also disable or delete entries by changing this field’s
value.

NOTE: You must reboot the AP before changes to any of these DHCP server parameters take effect.

DHCP Relay Agent
When enabled, the DHCP relay agent forwards DHCP requests to the set DHCP server.
Click the Configure > Network > DHCP R A to configure DHCP relay agent servers and enable the DHCP relay agent.
NOTE: At least one DHCP server must be enabled before DHCP Relay Agent can be enabled.

NOTE: If the DHCP relay agent is unable to reach the external DHCP Server specified in the DHCP Server IP Address
Table, the requesting client will receive an IP address from the IP Pool table of the AP’s internal DHCP Server,
even if the internal DHCP Server is disabled.

NOTE: If a client requests an available IP address from the IP Pool table of the AP’s internal DHPC Server, the client will
receive this address, even if the DHCP server on the AP is disabled. To ensure that clients receive IP addresses
only from the DHCP Relay Agent, disable all entries in the IP Pool table of the AP’s internal DHCP server.

The DHCP Relay functionality of the AP supports Option 82 and sends the system name of the AP (as a NAS identifier)
as a sub-option of Option 82.

The AP makes a DHCP Request for lease renewal five minutes ahead of the expiration of the Rebinding time as
specified in the DHCP Offer from the DHCP server obtained during the last renewal.

Alarms 1 Bridge \ 203 \ FADIUE Prafles \ SSIDNLANISacurity 1

Syslem T \ Interfacas \I\ Managament \I‘ Filtaring \ﬁ..
|F Configuration DHCP Server \I.‘ Link Infegify \ SHNTP -‘.!L
Tha DHCP Relay Agent in the scoess point allows for dynamic IP address assignmant to

wirgless clients from a DHCP Server in a different subnel.
Mate: The DHCP Relay Agent can only be enabled alf

f the DHGP Server P address fabde. In adoifion to this, OH i b aisahded ir
gl 1P A el o pignimant Type far fhe 4 § i b wal [ tic, Changes (o those
paramebers requine access point reboot in order bo take effect

Enable DHCP Relay Agent O

i J Lancal 4
DHCP Server |IP Address Table

Add F Edl

&

DHCP Server IP Address Comment Status

Figure 4-5 DHCP Relay Agent
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DHCP Server IP Address Table

The AP supports the configuration of a maximum of 10 server settings in the DHCP Relay Agents server table. At least
one server must be configured to enable DHCP Relay.

To add entries to the table of DHCP Relay Agents, click Add in the DHCP Server IP Address Table; to edit existing
entries, click Edit. The following window is displayed.

Alarms ‘1~ Bridge ‘I'-. n0s 1 RADILS Prafiles \L SSIDNLANSecurly |

Systam 1 mgraces 1 Managarmani \1. Filtaring \{

DHCP Server |P Address Table - Edit Entries

Changes o these paramelers nequire access point eboot in onder

IP Addrass 172184.28.10

Commment gl

Stabus Enabée -

bl 4 G- B A

Figure 4-6 DHCP Server IP Address Table - Edit Entries

To add an entry, enter the IP Address of the DHCP Server and a comment (optional), and click OK.

To edit an entry, make changes to the appropriate entry. Enable or disable the entry by choosing Enable or Disable from
the Status drop-down menu, and click OK.

Link Integrity

The Link Integrity feature checks the link between the AP and any nodes on the backbone. These nodes are listed by IP
address in the Link Integrity IP Address Table. The AP periodically pings the nodes listed within the table. If the AP loses
network connectivity (that is, the ping attempts fail), the AP disables its wireless interface(s). Note that this feature does
not affect WDS links (if WDS links are configured and enabled).

You can configure and view the following parameters within the Link Integrity Configuration screen:

« Enable Link Integrity: Place a check mark in the box provided to enable Link Integrity.

» Poll Interval (milliseconds): The interval between link integrity checks. Range is 500-15000 ms in increments of
500 ms; default is 500 ms.

* Poll Retransmissions: The number of times a poll should be retransmitted before the link is considered down.
Range is 0 to 255; default is 5.

» Target IP Address Entry: This entry specifies the IP address of a host on the network that the AP will periodically poll
to confirm connectivity. The table can hold up to five entries. By default, all five entries are set to 0.0.0.0. Click Edit to
update one or more entries. Each entry contains the following field:

— Target IP Address
— Comment (optional)

— Status: Set this field to Enable to specify that the Access Point should poll this device. You can also disable an
entry by changing this field’s value to Disable.
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Figure 4-7 Link Integrity Configuration Screen

SNTP (Simple Network Time Protocol)

SNTP allows a network entity to communicate with time servers in the network/internet to retrieve and synchronize time

of day information. When this feature is enabled, the AP will attempt to retrieve the time of day information from the
configured time servers (primary or secondary), and, if successful, will update the relevant time objects in the AP.

Requests are sent every 10 seconds. If the AP fails to retrieve the information after three attempts, the AP will use the
system uptime and update the relevant time objects. If this feature is disabled, the user can manually configure the date

and time parameters.
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Figure 4-8 SNTP Configuration Screen

You can configure and view the following parameters within the SNTP screen:

SNTP Status: Select Enable or Disable from the drop-down menu. The selected status will determine which of the
parameters on the SNTP screen are configurable.

NOTE: When SNTP is enabled, it will take some time for the AP to retrieve the time of day from the configured time
servers and update the relevant date and time parameters.

Addressing Format: If SNTP is enabled, choose whether you will use the host name or the IP address to configure
the primary/secondary SNTP servers. If these servers are configured with the host name, the DNS client feature must
be enabled and configured properly.

Primary Server Name or IP Address: If SNTP is enabled, enter the host name or IP address of the primary SNTP
server.

Secondary Server Name or IP Address: If SNTP is enabled, enter the host name or IP address of the secondary
SNTP server.

Time Zone: Select the appropriate time zone from the drop down menu.
Daylight Savings Time: Select the number of hours to adjust for daylight savings time.

Time and Date Information: When SNTP is disabled, the following time-relevant objects are manually configurable.
When SNTP is enabled, these objects are grayed out:
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— Year: Enter the current year.

— Month: Enter the month in digits (1-12).

— Day: Enter the day in digits (1-31).

— Hour: Enter the hour in digits (0-23).

— Minutes: Enter the minutes in digits (0-59).
— Seconds: Enter the seconds in digits (0-59).
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Interfaces

From the Interfaces tab, you configure the Access Point’s operational mode settings, power control settings, wireless
interface settings and Ethernet settings. You may also configure a Wireless Distribution System for AP-to-AP
communications. The Interfaces tab contains the following sub-tabs:

* Operational Mode
* Wireless A (802.11a/b/g Radio)
* Ethernet

NOTE: On APs with model numbers ending in -WD, the operating country must be selected on the System tab before
any of these sub-tabs are available.

Operational Mode

From this tab, you can configure and view the operational mode for the Wireless interface.

Alarms \ Bridge \ Qo3 \ RADIUS Frofes \ S3IDALANSacurity 1

Syslem Mok L \ Managament \ Filbering 1

§ \ Wiraless “I\ Ethemet \l\

Tha aperatonal mode of the wirelos s interfaco determines the mode of communication
panhween wirgless chents and the ACoess point

Note: Changes (0 Lhese parawmalors require Sccees point rebool in order o take effect

|ate: Select the dosired operational mode prior to confiquring other waroloss interface

Note: BOL 11d needs to be enabled bofore enabiing IBSS Power Conlrol.

Wireless - &

Cperational Mode [5:].'-‘.‘.::-.-, Il
Enabla Super Moda r
Enable Turbo Mode [
Enabla 802114 r
ISOAEC 3166-1 CountryCode | UNITED STATES =
Enable TX Powar Control r
Wirgless - A Transmit Power Lewel | 100% ;I
Ok 3 Cancel 3

Figure 4-9 Operational Mode Screen

The Wireless (802.11a/b/g) interface can be configured to operate in the following modes:
* 802.11a only mode: The radio uses the 802.11a standard only.

* 802.11b mode only: The radio uses the 802.11b standard only.

* 802.11g mode only: The radio is optimized to communicate with 802.11g devices. This setting will provide the best
results if this radio interface will only communicate with 802.11g devices.
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» 802.11b/g mode: This is the default mode. Use this mode if you want to support a mix of 802.11b and 802.11g
devices.

» 802.11g-wifi mode: The 802.11g-wifi mode has been defined for Wi-Fi testing purposes. It is not recommended for
use in your wireless network environment.

NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band (802.11b and
802.11g) support only. 802.11a functionality covered in this User Guide is not supported.

Enable H Band Support

In compliance with FCC regulations, Dynamic Frequency Selection is required in the middle frequency band (M band:
5.26 GHz - 5.32 Ghz) and high frequency band (H band: 5.470 GHz - 5.725 GHz). DFS is enabled automatically when
you use one or both of these frequency bands.

If the AP’s Wireless Card A is variant 2, 3, or 6, the M band channels are enabled by default, and DFS is performed
automatically and cannot be disabled. To add H band channels to the list of available channels, select Enable H Band
Support on the Op Mode page. When the H band is enabled, DFS is enabled automatically, and is performed on both M
and H band channels.

If the AP’s Wireless Card A is variant 8, 10, or 11, both M and H band channels are enabled automatically. DFS is
performed on both M and H band channels and cannot be disabled.

To identify your AP’s software variant, click Monitor > Version to view the Version tab.
For a full discussion of Dynamic Frequency Selection, see Dynamic Frequency Selection/Radar Detection (DFS/RD).

NOTE: You can avail this option by upgrading your pre 3.6 version device to 3.7 version.

Super Mode and Turbo Mode

Super mode improves throughput between the access point and wireless clients that support this capability. For wireless
clients that support this capability the AP will negotiate and treat them accordingly, for other clients that do not support
super mode, the AP will treat them as normal wireless clients.

Super mode can be configured only when the wireless operational mode is one of the following:

* 802.11a only mode
+ 802.11g only mode
* 802.11b/g mode

NOTE: Super mode is not available in 802.11b and 802.11g-wifi operational modes. Turbo mode is available only in
802.11a mode in the FCC regulatory domain. Turbo Mode is not available in frequency bands in which DFS is
required.

Turbo mode is supported in 802.11a mode in the FCC regulatory domain when DFS is not required. Turbo mode supports
turbo speeds at twice the standard data rates, and also dynamically switches between Turbo mode speeds and normal
speeds depending on the wireless client. All connected clients must be using Turbo mode in order for the AP to operate
at Turbo mode speed. If turbo mode is enabled, then this is displayed in the web Ul and the transmit speeds and
channels pull-down menus are updated with the valid values.

When Turbo mode is enabled, only a subset of the wireless channels in the 5.0 GHz spectrum can be used. If any
wireless clients do not support turbo mode, the AP will fall back to normal mode.

Turbo mode can be configured only when Super mode has already been enabled.

Super mode is supported in the 2.4 GHz and 5 GHz frequency bands in all regulatory domains. Turbo mode is available
in the 5 GHz frequency band in the FCC regulatory domain when DFS is not required.
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IEEE 802.11d Support for Additional Regulatory Domains

The IEEE 802.11d specification allows conforming equipment to operate in more than one regulatory domain over time.
IEEE 802.11d support allows the AP to broadcast its radio’s regulatory domain information in its beacon and probe
responses to clients. This allows clients to passively learn what country they are in and only transmit in the allowable
spectrum. When a client enters a regulatory domain, it passively scans to learn at least one valid channel, i.e., a channel
upon which it detects IEEE Standard 802.11 frames.

The beacon frame contains information on the country code, the maximum allowable transmit power, and the channels to
be used for the regulatory domain.

The same information is transmitted in probe response frames in response to a client’s probe requests. Once the client
has acquired the information required to meet the transmit requirements of the regulatory domain, it configures itself for
operation in the regulatory domain.

On some AP models, the regulatory domain and associated parameters are automatically configured when a country is
selected on the System tab. On APs in which country selection is not available on the system tab, the regulatory domain
is pre-programmed into the AP prior to shipment. Depending on the regulatory domain, a default country code is chosen
that is transmitted in the beacon and probe response frames.

Configuring 802.11d Support
Perform the following procedure to enable 802.11d support and select the country code:

1. Click Configure > Interfaces > Operational Mode.
2. Select Enable 802.11d.
3. Select the Country Code from the ISO/IEC 3166-1 CountryCode drop-down menu.

NOTE: On APs with model numbers ending in -WD, this object is not configurable.

4. Click OK.
5. Configure Transmit Power Control and Transmit Power Level if required.

Transmit Power Control/Transmit Power Level

Transmit Power Control uses standard 802.11d frames to control transmit power within an infrastructure BSS (Basic
Service Set, or combination of AP and associated clients that can communicate to each other and/or to the backhaul
connection via the AP). This method of power control is considered to be an interim way of controlling the transmit power
of 802.11d enabled clients in lieu of implementation of 802.11h.

When an AP comes online, it automatically uses the maximum TX power allowed in the regulatory domain. The Transmit
Power Control feature lets the user manually lower the transmit power level by setting a “back-off” value between 0 and
35 dBm.

When Transmit Power Control is enabled, the transmit power level of the card in the AP is set to the maximum transmit
power level minus the back-off value. This power level is advertised in Beacon and Probe Response frames as the
802.11d maximum transmit power level.

When an 802.11d-enabled client learns the regulatory domain related information from Beacon and Probe Response
frames, it learns the power level advertised in Beacon and Probe response frames as the maximum transmit power of the
regulatory domain and configures itself to operate with that power level.

As aresult, the transmit power level of the BSS is configured to the power level set in the AP (assuming that the BSS has
only 802.11d enabled clients and an 802.11d enabled AP).

NOTE: In FCC DFS-enabled bands, power control is adjusted from beacon information only.

In addition, ATPC (Automatic Transmit Power Control) is a feature to automatically adapt transmit power when the quality
of the link is more than sufficient to maintain a good communication with reduced transmit power. This feature is required
for FCC DFS. It works by monitoring the quality of the link and reducing the output power of the radio by up to 6 dB when
good link quality can still be achieved. When link quality reduces, the output power is automatically increased up to the
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original power level to maintain a good link. For a full discussion of DFS, see Dynamic Frequency Selection/Radar
Detection (DFS/RD).

Configuring TX Power Control
1. Click Configure > Interfaces > Operational Mode.
2. Select Enable Transmit Power Control.

3. Enter the desired backoff from the maximum Transmit Power level (between 0 and 35 dBm) in the Wireless-A:
Transmit Power Level Back-Off field.

4. Click OK.
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Wireless A (802.11a/b/g Radio)
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Wireless interface properties determine the characteristics of the wireless medium as
well a5 how wireless clients will communicate with the access point.

Verify configuration of the desired operational mode prier to configuring the wireless
interface properties below.

Note: This page aliows configuration of a single S5ID (Wireless Network Name); in order to
configure more tham one S50, please visit the SSIDVLANSecurily page.

Note: Changes to these par except Wireless Service Status, DCS, & DCS Threshold
regquirg Sccess point reboot i order to take effect.

Physical Interface Type 802.11a (OFDM 5 GHZ)

MAC Address 00-20:A6:6F 9587

Regulatory Domain LUSA (FCC)

Metwork Name (SSID) Wirgless MNetwork A

Enable Auto Channel Select W

Frequency Channel [foe-sesoe =

Transmit Rate [futcFalieass =]

DTIM Period (1-255 ) P

RTSICTS Medium Reservation (2347=off) [asr

Antenna Gain (Including Cable Loss) P

Wireless Senice Status m

Load Balancing Max Clients [es

Enable DCS -

DCS Threshold | E |
—id)  mbiilled

Channel Blacklist Table

This table is used to ct A channel can be blacklisted
automatically if radar is detected on the opeérating channel (this is applicable only to specific
regulatory domains). Il radar is detected on a channel, that channel will be blacklisted for 30
minutes. A channel can also be blacklisted by the administrator in case that channel is not
to be used when ACS is enabled.

' ™
Channel Radar Detected Elapsed Time (Minutes) Blacklist Status
52 FALSE o Disable
56 FALSE 0 Disable
[:11] FALSE o Disable
54 FALSE 0 Disable
100 FALSE 1} Disable
104 FALSE o Disable
108 FALSE 0 Disable
112 FALSE 0 Disable
116 FALSE 1] Disable
120 FALSE 1} Disable
124 FALSE o Disable
128 FALSE o Disable
132 FALSE o Disable
136 FALSE 1] Disable
140 FALSE 1} Disable
149 FALSE o Disable
153 FALSE 0 Disable
157 FALSE o Disable
161 FALSE 0 Disable
165 FALSE 1} Disable

A A

Wireless Distribution System (WDS)

WDS can be used to establish point-to-point [Le. wireless backhaul) connections with other
access points. This table is used to configure WDS partner access points.

s N

Figure 4-10 Wireless Interface
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You can view and configure the following parameters for the Wireless interface:

NOTE: You must reboot the Access Point before any changes to these parameters take effect.

Physical Interface Type: Depending on the Operational Mode, this field reports:
— For 802.11a mode: “802.11a (OFDM 5 GHz).”
NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band (802.11b
and 802.11g) support only. 802.11a functionality covered in this User Guide is not supported.
— For 802.11b mode only: "802.11b (DSSS 2.4 GHz)"
— For 802.11g mode: "802.11g (OFDM/DSSS 2.4 GHz)"
— For 802.11b/g mode: "802.11g (OFDM/DSSS 2.4 GHz)"
— For 802.11g-wifi mode: "802.11g (OFDM/DSSS 2.4 GHz)"

OFDM stands for Orthogonal Frequency Division Multiplexing; this is the name for the radio technology used by
802.11a/4.9 GHz devices. DSSS stands for Direct Sequence Spread Spectrum; this is the name for the radio
technology used by 802.11b devices.

MAC Address: This is a read-only field that displays the unique MAC (Media Access Control) address for the Access
Point’s wireless interface. The MAC address is assigned at the factory.

Regulatory Domain: Reports the regulatory domain for which the AP is certified. Not all features or channels are
available in all countries.

Network Name (SSID): Enter a Network Name (between 1 and 32 characters long) for the primary wireless network.

You must configure each wireless client using this network to use this name as well. Additional SSIDs and VLANs may
be configured under Configure > SSID/VLAN/Security. Up to 16 SSID/VLANs may be configured.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the
name.

Enable Auto Channel Select: When the Enable Auto Channel Select option is enabled, the AP scans the area for
other Access Points and selects a free or relatively unused communication channel. This helps prevent interference
problems and increases network performance. By default this feature is enabled. See Dynamic Frequency
Selection/Radar Detection (DFS/RD) for more information and Available Channels for a list of available channels.

Frequency Channel: When Auto Channel Select is enabled, this field is read-only and displays the Access Point’s
current operating Channel. When Auto Channel Select is disabled, you can specify the Access Point’s operating
channel. If you decide to manually set the unit's Channel, ensure that nearby devices do not use the same frequency
(unless you are setting up WDS links). Available channels vary based on regulatory domain. See Dynamic Frequency
Selection/Radar Detection (DFS/RD) for more information and Available Channels for a list of available channels.

Transmit Rate: Use the drop-down menu to select a specific transmit rate for the AP. The values depend on the
Operational mode. Auto Fallback is the default setting; it allows the AP unit to select the best transmit rate based on
the cell size.

— For 802.11a only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/s.
NOTE: In countries in which 802.11a (5 GHz) is not available for use, the AP-700 provides dual-band (802.11b
and 802.11g) support only. 802.11a functionality covered in this User Guide is not supported.
— For 802.11b only -- Auto Fallback, 1, 2, 5.5, 11 Mbits/sec.
— For 802.11g only -- Auto Fallback, 6, 9, 12, 18, 24, 36, 48, 54 Mbits/sec
— For 802.11b/g -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec
— For 802.11g-wifi -- Auto Fallback, 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54 Mbits/sec

NOTE: 802.11g-wifi has been defined for Wi-Fi testing purposes. It is not recommended for use in your wireless
network environment.
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NOTE: Turbo mode is supported in only in 802.11a mode in the FCC regulatory domain when DFS is not required.
If turbo mode is enabled, then this is displayed in the web Ul and the transmit speeds and channels
pull-down menus are updated with the valid values.

DTIM Period: The Deferred Traffic Indicator Map (DTIM) Period determines when to transmit broadcast and multicast
packets to all clients. If any clients are in power save mode, packets are sent at the end of the DTIM period. This
parameter supports a range between 1 and 255; it is recommended to leave the DTIM at its default value unless
instructed by technical support. Higher values conserve client battery life at the expense of network performance for
broadcast or multicast traffic.

RTS/CTS Medium Reservation: The 802.11 standard supports optional RTS/CTS communication based on packet
size. Without RTS/CTS, a sending radio listens to see if another radio is already using the medium before transmitting
a data packet. If the medium is free, the sending radio transmits its packet. However, there is no guarantee that
another radio is not transmitting a packet at the same time, causing a collision. This typically occurs when there are
hidden nodes (clients that can communicate with the Access Point but are out of range of each other) in very large
cells.

When RTS/CTS occurs, the sending radio first transmits a Request to Send (RTS) packet to confirm that the medium
is clear. When the receiving radio successfully receives the RTS packet, it transmits back a Clear to Send (CTS)
packet to the sending radio. When the sending radio receives the CTS packet, it sends the data packet to the
receiving radio. The RTS and CTS packets contain a reservation time to notify other radios (including hidden nodes)
that the medium is in use for a specified period. This helps to minimize collisions. While RTS/CTS adds overhead to
the radio network, it is particularly useful for large packets that take longer to resend after a collision occurs.

RTS/CTS Medium Reservation is an advanced parameter and supports a range between 0 and 2347 bytes. When set
to 2347 (the default setting), the RTS/CTS mechanism is disabled. When set to 0, the RTS/CTS mechanism is used
for all packets. When set to a value between 0 and 2347, the Access Point uses the RTS/CTS mechanism for packets
that are the specified size or greater. You should not need to enable this parameter for most networks unless you
suspect that the wireless cell contains hidden nodes.

Antenna Gain: This parameter modifies the sensitivity of the radio card when detecting radar signals in accordance
with Dynamic Frequency Selection/Radar Detection (DFS/RD) requirements. Given that the radar detection threshold
is fixed by the regulatory codes in the country of operation, and that a variety of antennas with different gains may be
attached to the unit, adjust this threshold to account for higher than expected antenna gains and avoid false radar
detection events. Set this parameter to a value between 0 and 35. The default value is 0.

Wireless Service Status: The user can shut down (or resume) the wireless service on the wireless interface of the
AP through the CLI, HTTP, or SNMP interface. Select Shutdown to shutdown the wireless service on a wireless
interface, or to Resume to resume wireless service. When the wireless service on a wireless interface is shut down,
the AP will:

— Stop the AP services to wireless clients connected on that wireless interface by disassociating them
— Disable the associated BSS ports on that interface

— Disable the transmission and reception of frames on that interface

— Indicate the wireless service shutdown status of the wireless interface through LED and traps

— Enable Ethernet interface so that it can receive a wireless service resume command through CLI/HTTP/SNMP
interface

NOTE: WSS disables BSS ports.

NOTE: The wireless service cannot be shutdown on an interface where Rogue Scan is enabled.

In shutdown state, AP will not transmit and receive frames from the wireless interface and will stop transmitting
periodic beacons. Moreover, none of the frames received from the Ethernet interface will be forwarded to that wireless
interface.

Wireless service on a wireless interface of the AP can be resumed through CLI/HTTP/SNMP management interface.
When wireless service on a wireless interface is resumed, the AP will:

— Enable the transmission and reception of frames on that wireless interface
— Enable the associated BSS port on that interface
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— Start the AP services to wireless clients
— Indicate the wireless service resume status of the wireless interface through LED and traps

After wireless service resumes, the AP resumes beaconing, transmitting and receiving frames to/from the wireless
interface and bridging the frames between the Ethernet and the wireless interface.

Traps Generated During Wireless Service Shutdown (and Resume)

The following traps are generated during wireless service shutdown and resume, and are also sent to any configured
Syslog server.

When the wireless service is shut down on a wireless interface, the AP generates a trap called
oriTrapWirelessService Shutdown.

When the wireless service is resumed on a wireless interface, the AP generate a trap called
oriTrapWirelessServiceResumed.

Load Balancing Max Clients: Load balancing distributes clients among available access points. Enter a number
between 1 and 63 to specify the maximum number of clients to allow.

Channel Blacklist Table: The Channel Blacklist table contains all available channels (channels vary based on
regulatory domain). It can be used to manually blacklist channels, and it also reflects channels that have been
automatically blacklisted by the Dynamic Frequency Selection/Radar Detection (DFS/RD) function. In the IC, FCC,
ETSI, and TELEC regulatory domains, a channel is blacklisted automatically if it is found to be busy or occupied by
radar during a scan at start-up. When a channel has been automatically blacklisted, it will remain blacklisted for 30
minutes. Additionally, an administrator can blacklist channels manually to prevent them from being used when ACS is
enabled.

NOTE: Any change in channel-related parameters (e.g., country code, turbo mode, Operational mode, H-band

operation) resets the channel blacklist table.
The channel blacklist table can be configured only through the Web or SNMP interfaces. CLI configuration is not
supported.
To blacklist a channel manually:
1. Click on Configure > Interfaces > Wireless A.
2. Scroll down to the Channel Blacklist heading.

Channel Blacklist Table

This table is used to configure blacklist channels. A channel can be blacklisted
automatically il radar is detecied on the operating channel (this is applicable only 1o specific
regulatory domains). If radar is detected on a channel, that channe! will be blacklisted for 30
minutes. A channel can also be blacklisted by the administrator in case that channel is not
1o be used when ACS is enabled.

— -
Channal Radar Detected Elapsed Time (Minutes) Blacklist Status
1 FALSE 0 Disable
2 FALSE 0 Disable
3 FALSE ] Disable
a FalLSE 1] Disable
5 FalLSE 0 Disable
G FALSE ] Disable
7 FALSE 0 Disable
8 FALSE 0 Disakble
g FALSE 0 Disable
10 FALSE 0 Disable
11 AL SE 0 Disable
12 Fal SE g Disable
13 FALSE a0 Disable

Figure 4-11 Channel Blacklist Table
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3. Click Edit in the Channel Blacklist Table
4. Set Blacklist Status to Enable.

Channel Blacklist Table

This page is used to configure blacklisted channels. You can blacklist a channel by
setting the Blacklist Status to Enable.

Channel 1
Blacklist Status | Enale =]
Channel 2
Blacklist Status | Disssle =
Channel 3
Blacklist Status | Enasle =]

Figure 4-12 Channel Blacklist Table - Edit Screen

* Wireless Distribution System: A Wireless Distribution system can be used to establish point-to-point (i.e. wireless
backhaul) connections with other access points. See Wireless Distribution System (WDS) for configuration
information.

Dynamic Channel Selection (DCS)

Dynamic Channel Selection (DCS) addresses two major requirements in Optimal Channel Configuration. Principally it
enables the on-the-fly channel change without requiring a system reboot on conditions like RADAR
Detection/Configuration change of Channel. In addition to this it houses the functionality to Monitor the Channel Health in
the background and triggers ACS to perform an Auto Scan Function to select the channel with lowest interference and
dynamically switches to the new channel.

The DCS is triggered under the following conditions:

1. Dynamic channel change required (Radar Detection and Configuration change)
2. Poor Condition of the current operating channel

NOTE: Ifthe AP finds all the channels are busy in a two hour period, DCS no longer changes channels automatically and
sends a trap message.
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pa_:nﬁgum IF Address Contaclt Name Contaci Name
Systern Name Contact Phone  Contact Phone Number
M Systermn Location Contacl Emnail name@Organization.com
ohitar Up Time (DD:HHMM:ES) Object 1D 1.36.7.41.11898.24.12
Commands: System Alarms

This table displays information on the alatms (SHMP Traps) generated by the access point. They should be
HEIE!. deleted once they ae reviewed and resolved. The alarm severity levels are: Critical, Major, Minot, and
ol o rvatbonal.

Exit
Select Al ] Deselect All J
Rebant
Description Severity Time Stamp
AP Cold Started Informational OdaysDhrs2m22s
Link Up Informalional OdaysOhrs2m31s

Informational OdaysOhrs 2m 31 8

All channels have interference 50 DCS
will no mare change channels
aulomaticallyPC CARD B

]

DCS Trap Message Delele 3

O 00O

Major DdaysOhrs52m 29 s

The Access Point monitors the current channel for interference and errors. The DCS Threshold controls how
aggressively the Access Point changes the channels. The lowest value of the DCS Threshold is 1 which means channel
switch would happen even for minimum interference and the highest value (10) means the channel has to be significantly
bad. A value of “10” in the DCS threshold dropdown indicates a less Aggressive system and “1” indicates a high
aggressiveness index. Higher the value is lesser the Agressive Index showing an inversely proportional ratio.
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Wireless interface properties determine the characteristics of the wireless medium as
well as how wireless clients will communicate with the access point.

Werify configuration of the desired operational mode prior to configuring the wireless
interface properties below.

Note: This page aliows configuration of a single SSID (Wireless Network Name); in order to
configure more than one SSID, please visit the SSIDVIANSacurily page.

Note: Changes to these paramaters except Wireless Service Status, DCS, & DCS Threshold'
require access point reboot in order to take effect.

Physical Intertace Type 802.11a (OFDM 5 GHz)

MAC Address 00:20:46.6F.95:87

Regulatory Domain LISA (FCC)

Metwork Mame (SSID) iR NeTaok A

Enable Auto Channel Select =

Frequency Channel | 108 - 5.54 GHz E

Transmit Rate IA.uh Fallback E

DTIM Period (1-255 ) | [

RTSICTS Medium Reservation (2347=off) asz

Anfenna Gain (Including Cable Loss) D

Wireless Senice Status [Resume 5]

Load Balancing Max Clients [ea

Enable DCS (]

DCS Threshold | |
—id  emSilild

Channel Blacklist Table

This table is used to ct A channel can be blacklisted

 if radar is on the operating channel (this is applicable only to specific
regulatory doemains). If radar is detected on a channel, that channel will be blacklisted for 20
minutes. A channel can also be blacklisted by the administrator in case that channel is not
to be used when ACS is enabled.

' Ny
Channel Radar Detected Elapsed Time (Minutes) Blacklist Status
52 FALSE 1] Disable
56 FALSE 0 Digable
&0 FALSE 1] Disable
64 FALSE 0 Disable
100 FALSE 1] Disable
104 FALSE 1] Disable
108 FALSE 0 Digable
112 FALSE 1] Disable
116 FALSE 0 Disable
120 FALSE 1] Disable
124 FALSE 0 Disable
128 FALSE o Digable
132 FALSE 1] Disable
136 FALSE 0 Disable
140 FALSE 1] Disable
149 FALSE 1] Disable
153 FalLSE 0 Digable
157 FALSE 1] Disable
161 FALSE 0 Disable
165 FALSE 0 Disable

. >y

Wireless Distribution System (WDS)

WDS5 can be used 10 establish point-to-point (i.e. wireless backhaul) connections with other
access points. This table is used to configure WDS partner access points.

-
Port Index. Partner MAC Address Status
1 00:00:00:00:00:00 Disable
2 00:00:00:00:00:00 Disable
3 00:00:00:00:00:00 Disable
4 00:00:00:00:00:00 Disable
5 00:00:00:00:00:00 Disable
1] 00c00:00:00:00:00 Disable

Figure 4-13 A complete Interfaces page
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DCS can be configured using the following interfaces:
*  Web (HTTP) Interface
¢ Command Line Interface (CLI)
¢ MIB (SNMP) Requirements
Web (HTTP) Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s Ethernet Port.

The user will be able to enable/disable the Dynamic Channel Selection feature in the Wireless subtab. If DCS is disabled,
all DCS configuration options are grayed out showing the text fields are not configurable.

The default value for DCS text field is Disable and for DCS Threshold is 5.
To configure the HTTP (Web) interface, click Configure>Interfaces>Wireless A and B.
To reset your configuration, click Cancel.

You can configure HTTP page for configuring the DCS feature for each interface separately.

\ SSIDVLANSecurity

Staus

Wircleas interisce propertics delerming the charecloriatica of the wircless modivm as

wiell as how wireless clients will commumnicate with the sccess point.

Note: This page allt

COMTIURe MOFe tha

wigeration of a single 351D (Wireless Nefwork Name); in order o
D, pleass wisdl the 0y Pagee.

Help Nate: Changed IO [hedd Daramelers artepd Wireledd Service Stalui, DCS, £ OCS Thrshold
P AOCeE PO rabood inorder o take effect

m

Retgot

ik Name (5SS My Wireles Network 4

DC%E Configurable

Mireless Serace Status Cr— - fields
i &4
=
| C -I
- s F)

Figure 4-14 Configurable DCS fields

NOTE: Changes to these parameters except Wireless Service Status, DCS and DCS Threshold require Access Point
reboot in order to take effect.

Command Line Interface (CLI)

See the Command Line Interface (CLI) section in Appendix A.

58



Advanced Configuration AP-700 User Guide
Interfaces

MIB (SNMP) Requirements

DCS feature can be managed and monitored by MIB objects too. All the configuration parameters are present for both
Interface A and Interface B separately. The oriWirelessIfDCSThreshold object stores the DCS Threshold from 1 to 10.

See the table below for defaults and units for all objects.

Feature MIB/Group Object Data type Values Access | Default
DCS orinoco-> orinocolf-> | oriWirelessIfD | Integer Enable (1) RwW 2
orinocoWirelesslf -> CSStatus Disable (2)
oriWirelesslfPropertie
sTable
DCS orinoco-> orinocolf-> | oriWirelessIfD | Integer 1to 10 RwW 5
Thresho | orinocoWirelesslf -> CSThreshold
Id oriWirelesslfPropertie
sTable

Dynamic Frequency Selection/Radar Detection (DFS/RD)

In order to prevent interference with radar systems and other devices that occupy the 5 GHz band, 802.11a APs certified
in the ETSI, TELEC, FCC, and IC regulatory domains (see Affected Countries) and operating in the middle and high
frequency bands select an operating channel through a combination of Auto Channel Select (ACS) and Dynamic
Frequency Selection (DFS)/Radar Detection (RD).

During boot-up, ACS scans the available channels and selects the best channel. Once a channel is selected, the AP
performs a channel availability check for 60 seconds to ensure that the channel is not busy or occupied by radar, and
then commences normal operation. (In Canada, if the channel was previously blacklisted, the AP scans for 600 seconds
before commencing normal operation if the selected channel frequency is in the 5600 - 5650 MHz range). When the AP
enters normal operation, DFS works in the background to detect interference in that channel. If interference is detected,
the AP sends a trap, disassociates all clients, blacklists the channel, and reboots. After it reboots, ACS re-scans and
selects a better channel that is not busy and is free of radar interference.

If ACS is disabled, only channels in the lower, upper, and ISM frequency bands are available for use:

* 36:5.180 GHz (default)
* 40:5.200 GHz

e 44:5.220 GHz

* 48:5.240 GHz

* 149:5.745 GHz

* 153:5.765 GHz

« 157:5.785 GHz

* 161:5.805 GHz

* 165:5.825 GHz

If you are using the unit in a country and band that require DFS, keep in mind the following:

» DFS is not a configurable parameter; it is always enabled and cannot be disabled.

* You cannot manually select the device’s operating channel; you must let the unit select the channel. You may make
channels unavailable by manually “blacklisting” them and preventing those channels being selected, in accordance
with local regulations or interference. You can also display the Channel Blacklist Table to view the channels that have
been blacklisted by the AP.
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In compliance with FCC regulations, the AP uses ATPC (Automatic Transmit Power Control) to automatically adapt
transmit power when the quality of the link is more than sufficient to maintain a good communication with reduced
transmit power. See Transmit Power Control/Transmit Power Level for more information.

DFS is required for three purposes:

1.

Radar avoidance both at startup and while operational. To meet these requirements, the AP scans available
frequencies at startup. If a DFS enabled channel is busy or occupied with radar, the system will blacklist the channel
for a period of 30 minutes in accordance with FCC, IC, ETSI, and TELEC regulations. Once fully operational on a
frequency, the AP actively monitors the occupied frequency. If interference is detected, the AP blacklists the channel,
logs a message and rescans to find a new frequency that is not busy and is free of radar interference.

Guarantee the efficient use of available frequencies by all devices in a certain area. To meet this requirement, the AP
scans each available frequency upon startup and selects a frequency based upon the least amount of noise and
interference detected. This lets multiple devices operate in the same area with limited interference. This procedure is
done only at startup; if another UNII device comes up on the same frequency, the AP does not detect this or rescan
because of it. It is expected that other devices using these frequencies also are in compliance with country
regulations, so this should not happen.

Uniform Channel Spreading. To meet this requirement, the AP randomly selects its operating channel from the
available channels with least interference.

Affected Countries

Japan is certified in the TELEC regulatory domain, Canada is certified in the IC regulatory domain, and the USA is
certified in the FCC regulatory domain for operation in the 5 GHz band.

The following countries are certified in the ETSI regulatory domain for operation in the 5 GHz band:

Austria — Greece — Norway
Belgium — Hungary — Poland
Czech Republic — lreland — Portugal
Cyprus — ltaly — Spain
Denmark — Latvia — Sweden
Estonia — Lithuania — Switzerland
Finland — Luxembourg - UK
France — Malta

Germany — Netherlands

VLAN on Ethernet Port

VLANSs are very useful to segment the LAN into different broadcast domains. This helps in reducing the broadcast
domain by separating logical segments of a LAN. VLANs can operate in different modes based on the incoming traffic.

VLAN on Ethernet port of AP can be configured in different ways. Following are the different modes in which VLAN
functions.

Transparent Mode
Access Mode
Trunk Mode
Mixed Mode
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Transparent Mode

Transparent mode is the default mode and is equivalent to the NO VLAN support. The VLAN receievs both the tagged
and untagged frames from the network. Transparent mode simply forwards both the tagged and untagged frames
received on the Ethernet port to WDS, Mesh or BSS and is not able to read any VLAN information.

1 z L ADIUSIF " | -
Alarms Bridge Q03 BRI \ SSIDMLANISecurity
. E) VRS ___ Frofiles =
System Metwork 1 Management \ Filtering \
Status = = IE—— <
Op Mode Wireless - & Wireless-B Ethernet \ Mesh \\\
Coofigure
This tab iz used to configure the Ethernet interface speed and transmission mode.
lonitar Note 1: Changes to Only Speed and Transmission Mode parameter requires access point
raboot in order to take effect,
Fominands Note 2: Ethernet Vian is Enabled and Mgnt VID is not present in Access/Trunk table, user
cant be able to mamage AP using Ethernet interface,
Help
. MAC Address 00:20A6.62.8E48
20 Speed and Transmission Mode [ sute-speed-sutoduplex =1
Reboot
VLAN MODE | Transparent =1

Access VLAN 1D

Access VAN Priority

WVLAM 1
VLAN 2
VLAN 3
VLAN 4
VLAN 5
VLAN B
VLAN 7
VLAN 8
VLAN 9
VLAN 10
VLAN 11
VLAN 12
VLAN 13
VLAN 14
VLAN 15
VLAN 16

QK 3 Cancel 3

Figure 4-15 Ethernet Interface

Access Mode

Access mode is used when we want to have a non-VLAN aware device connected on ethernet side to be a part of the
VLAN network. Access Point tags or untags the frames for this device. The frames receiving on Ethernet port, which is
destined to WDS, Mesh or BSS, are tagged with Access VLAN ID, Priority and forwards to the corresponding ports.

NOTE: Access mode does not work unless you enable VLAN tagging.
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[ VLAN Aware Switch ]

l..,tlllu-- S LLLL l‘.lllu-- L]
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Trunk Mode

Trunk mode works as a filter. Trunk links provide VLAN identification for frames travelling between switches. Once this
mode is enabled, the frames received from the WDS, Mesh or wireless ports are filtered and compared with the trunk
tables entries. The device percolates the incoming frames comparing with the trunk table data and forwards to the
respective ports. The trunk table is configurable on the Access Point. The frames with any mismatched tags are dropped
at this point. To distinguish between the traffic flows, a trunk port must mark the frames with special tags as they pass
between the switches.

VLAN Aware Switch

Trunk link r(_,_ﬁ_‘f_‘w'ﬁ“f”_'\m
| y )
s s [ oy \ VLAN Aware _ )
Mesh/ WDS e J
e

o R
Client-1 Client-2
Mixed Mode

Mixed mode is the combination of both the Access mode and the Trunk mode. All devices connected to the Ethernet
except for one device have to be VLAN aware. The Access Point puts this device into Access Mode and works as Trunk
Mode for other devices. The frames an Access Point receives are either untagged or tagged. For all incoming untagged
frames, Access mode rules are applied. The frames are tagged with the Access VLAN ID and are forwarded to the
respective ports. Trunk mode works when an Access Point receives tagged frames. The tagged frames are compared
with the Trunk table entries and are forwarded if it matches the entries, otherwise dropped.

NOTE: In Mixed Mode, Access VLAN ID should not be present in Trunk table.

62



Advanced Configuration AP-700 User Guide
Interfaces

[ VLAN Aware Switch ]

Trunk link

":‘.-lllll'- -IH:: iu_.-_”“"_" L1

cEsanl I

Mixed mode Mesh/ WDS

— —
e — e ——
Chent-1 Client-2

Management VLAN Configuration

Trunk Mode: In trunk mode if any management VLAN ID is configured then that management VLAN ID should present in
trunk table, then only we can able to manage the device.

Access Mode : In Access mode if any management VLAN ID is configured then that management VLAN ID should be
same as Access VLAN ID, then only we can able to manage the device .

Mixed Mode: In this mode the management VLAN ID should be present either in Trunk table or Access VLAN ID, and
then only we can able to manage the device.

WARNING: Error in configuring the VLAN management ID may result in loss of management access to the
Access Point. If this occurs, then the AP can only be managed via the serial port (console) port.

Configurable VLAN Parameters

Access VLAN ID: The Access VLAN ID is configurable in Access and Mixed mode. The Access VLAN ID values range
from 1 to 4094; the default value is 1.

Access VLAN Priority: The Access VLAN priority is configurable in Access and Mixed modes. The value in VLAN
Priority ranges from 0 to 7. The type of the Access VLAN Periority is VLAN ID only. The default value is 0.

VLAN 1-16: The VLAN IDs are configurable only in the Trunk and Mixed modes and apply in the both modes. The VLAN
ID values range from -1 to 4094. The default value is 4094. Here -1 represents the untagged frames. The maximum
number of VLAN IDs that can be configured in the AP VLAN table is 16.

Interface Requirements

There are several management and monitoring interfaces available to the network administrator to configure and
manage the unit. These are:

¢ Web Interface
¢ Command Line Interface (CLI)
* SNMP
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Web Interface

The HTTP Interface (Web browser Interface) provides easy access to configuration settings and network statistics from
any computer on the network. You can access the HTTP Interface over your LAN (switch, hub, etc.), over the Internet, or
with a “crossover” Ethernet cable connected directly to your computer’s EthernetPort.

To configure the HTTP (Web) interface, click Configure>Interfaces>Ethernet

z k ! RADILUS/FXU ™y :
A { SSIDMLAN f
Alarms \\ Bridge \ QoS ‘\‘ Profiles )\ IDNLANISecurity
System Metwork Interfaces i Management \ Filtering \
Status : : TE——— :
Op Mode Yireless - A Wireless - B Ethernet ’L Mesh \’L
_onfigure
This tab is used to configure the Ethernet interface speed and transmission mode.
loniter Note 1: Changes to Only Speed and Transmission Mode parameter requires access point
reboot in order to take effect.
Lommands Note 2: Ethernet Vian is Enabled and Mgnt VID is not present in Access/Trunk table, user
cant be able to manage AP using Ethernet interface,
Help
. MAC Address 00:20:A6:62:8E:49
Bl Speed and Transmission Mode |suts—s?eed-sutc-mipl~‘=x =]
Reboot
VLAM MODE | Transparent _v_’
Access VLAN ID

Access VLAM Priority

VLAN 1
VLAN 2
VLAN 3
VLAN 4
VLAN 5
VLAM B
VLAN 7
VLAM 8
VLAN 9
VLAN 10
VLAN 11
VLAN 12
VLAN 12
VLAM 14
VLAN 15
VLAN 16

—) S—

Figure 4-16 Web Interface configuration

NOTE: By default, the speed and transaction mode is auto-speed-auto-duplex and VLAN mode is Transparent.

NOTE: Ethernet VLAN is Enabled and Mgnt VID is not present in Access/Trunk table, user can’t be able to manage AP
using Ethernet interface.

Based upon the modes you select, the Access VLAN ID, Access Priority and the VLAN text fields also vary, either
enabled or disabled, or both enabled and disabled. The detail is mentioned below:

*  When VLAN Mode is Transparent, all the text boxes from VLAN 1 to VLAN 16, Access VLAN ID and Access VLAN
Priority are disabled.

«  When VLAN Mode is Trunk, text boxes from VLAN 1 to VLAN 16 are enabled and Access VLAN ID and Access VLAN
Priority are disabled.
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*  When VLAN Mode is Access, text boxes Access VLAN ID and Access VLAN Priority are enabled and VLAN 1 to
VLAN 16 text boxes are disabled.

*  When VLAN Mode is Mixed, all the text boxes from VLAN 1 to VLAN 16, Access VLAN ID and Access VLAN Priority
are enabled.

Select your mode manually and configure the parameters and finally click OK.

Command Line Interface (CLI)

See the Command Line Interface (CLI) section in Appendix A.

SNMP

VLAN can be configured through SNMP with MIB objects. Note that this requires an SNMP manager program like HP
Openview or Castlerock’'s SNMPc. The AP supports several Management Information Base (MIB) files that describe the
parameters that can be viewed and/or configured over SNMP. The MIB can be opened with any text editor, such as
Microsoft Word, Notepad, or WordPad.

MIB objects that support VLAN are mentioned in the following table.

Object Name Data Type Values/ Ranges Default Value Access
oriEthernetlfVlanMode Integer 0 — Transparent 0 RW

1 — Trunk mode

2 — Access mode

3 — Mixed mode
oriEthernetlfAccessVlanld Vlanld 1-4094 1 RW
oriEthernetlfAccessVlanPriority Vlanld 0-7 0 RW
oriEthernetlfTrunkVlanid01 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanid01 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld03 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld04 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld05 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld06 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld07 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld08 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld09 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld010 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanid11 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld12 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld13 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVianid14 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld15 Vlanld -1-4094 4094 RW
oriEthernetlfTrunkVlanld16 Vlanld -1-4094 4094 RW

Wireless Distribution System (WDS)

A Wireless Distribution System (WDS) creates a link between two 802.11a, 802.11b, or 802.11b/g APs over their radio
interfaces. This link relays traffic from one AP that does not have Ethernet connectivity to a second AP that has Ethernet
connectivity. WDS allows you to configure up to six (6) ports.
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In the WDS example below, AP 1 and AP 2 communicate over a WDS link (represented by the blue line). This link
provides Client 2 with access to network resources even though AP 2 is not directly connected to the Ethernet network.
Packets destined for or sent by the client are relayed between the Access Points over the WDS link.

Y

Client 1

Client 2

Figure 4-17 WDS Example

Bridging WDS

Each WDS link is mapped to a logical WDS port on the AP. WDS ports behave like Ethernet ports rather than like
standard wireless interfaces: on a BSS port, an Access Point learns by association and from frames; on a WDS or
Ethernet port, an Access Point learns from frames only. When setting up a WDS, keep in mind the following:

There are separate security settings for clients and WDS links. The same WDS link security mode must be configured
(currently we only support none or WEP) on each Access Point in the WDS and the same WEP key must be
configured.

The WDS link shares the communication bandwidth with the clients. Therefore, while the maximum data rate for the
Access Point's cell is 54 Mbits/second (802.11a, 802.11g only, or 802.b/g modes) or 11 Mbits/second (802.11b only
mode), client throughput will decrease when traffic is passing over the WDS link.

If there is no partner MAC address configured in the WDS table, the WDS port remains disabled.

A WDS port on a single AP should have a unique partner MAC address. Do not enter the same MAC address twice in
an AP’s WDS port list.

Each Access Point that is a member of the WDS must have the same Channel setting to communicate with each
other.

If your network does not support spanning tree, be careful to avoid creating network loops between APs. For example,
creating a WDS link between two Access Points connected to the same Ethernet network will create a network loop (if
spanning tree is disabled). For more information, see the Spanning Tree section.

When WDS is enabled, Spanning Tree protocol is automatically enabled. It may be manually disabled. If Spanning
Tree protocol is enabled by WDS and WDS is subsequently disabled, Spanning tree will remain enabled until it is
manually disabled. See Spanning Tree.
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WDS Setup Procedure

NOTE: You must disable Auto Channel Select to create a WDS. Each Access Point that is a member of the WDS must
have the same channel setting to communicate with each other.

To setup a wireless backbone follow the steps below for each AP that you wish to include in the Wireless Distribution

System.

—_

. Confirm that Auto Channel Select is disabled.

2. Write down the MAC Address of the radio that you wish to include in the Wireless Distribution System.
3. Click on Configure > Interfaces > Wireless A.
4. Scroll down to the Wireless Distribution System heading.

Part ndax
1

L3 k3

onoLn e

Wireless Distribution System (WDS)

W5 can be used to establish paint-to-point (i.e. wireless backhaul) connections with other
stoedd powits. This table is used to configure WDS partner sctesd polnts.

Edit J

Partmar MAC Address
00:00:00:00:00:00
00:00:00:00:00:00
00:00:00:00:00:00
00C00:00:00000:00
00:00:00:00:00:00
00:00:00:00:00:00

Figure 4-18 WDS Configuration

5. Click the Edit button to update the Wireless Distribution System (WDS) Table.

67



Advanced Configuration
Interfaces

AP-700 User Guide

System Network nterfaces \ Management \
é.
WDS Slot A Table Configuration- Add Entries

This page is used to configure the Wireless Distribution System (WDS5) links or
partners. You can configure up to six WDS links and the security to be used for those
links.

Mesh is currently enabled on this wireless interface. WDS cannot be configured when
the AP is configured to function as a Mesh AP.

ty requires that the encryption key for the WDS links between

Note: Changes to these parameters require access point reboot in order to take effect.

WDS Security
WDS Security Mode |NONE .|
Encryption Key 0
WDS AES Shared Secret ssssssas
OK J Cancel &

WDS partner access points

Port Index 1
Partner MAC Address 00:00:0
Status
Port Index 2
Partner MAC Address 00:00:00:00:00:00
dabiie I Dleabnle i

Filtering

Alarms \ Bridge \ Qo3 \ RADIUS Profiles \ SSIDNVLAN/ISecurity \\‘

A}

Figure 4-19 Adding WDS Links

6. Select which encryption method to use (if any) from the WDS Security Mode drop-down menu.
7. If you selected a WDS Security Mode, do one of the following:

* If you selected WEP: Enter an encryption key.
» If you selected AES: Enter a shared secret.

8. Enter the MAC Address that you wrote down in Step 2 in one of the Partner MAC Address field of the Wireless

Distribution Setup window.
9. Set the Status of the device to Enable.
10.Click OK.
11.Reboot the AP.

Ethernet

Select the desired speed and transmission mode from the drop-down menu. Half-duplex means that only one side can
transmit at a time and full-duplex allows both sides to transmit. When set to auto-duplex, the AP negotiates with its switch

or hub to automatically select the highest throughput option supported by both sides.

68



Advanced Configuration
Interfaces

AP-700 User Guide

Syehem Nabwok

Alarms 1 Bridge \
T ‘\ an agaement ‘\

A

This tab is used to configure the Ethemet interface speed and fransmission mode.

Uperational Mods Wvireless

Note: Chanpes fo this parameder requines Sccess point raboot in orger to take affect.

M&C Address 0020 AB 55 FI3T
Spaed and Transmission Mode [iLLb—Hﬁﬂ-.JIt-ﬂJ#lux ;]
IR 3 Cancil 3

Filloring

GaS \ RADIUS Profles \ S8IDNLANSecnty ‘1

\

Figure 4-20 Ethernet Sub-tab

For best results, Proxim recommends that you configure the Ethernet setting to match the speed and transmission mode
of the device the Access Point is connected to (such as a hub or switch). If in doubt, leave this setting at its default,

auto-speed-auto-duplex. Choose between:

* 10 Mbit/s - half duplex or full duplex
* 100 Mbit/s - half duplex or full duplex
* Auto speed - auto duplex
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The Management tab contains the following sub-tabs:

Passwords

IP Access Table

Services

Automatic Configuration (AutoConfig)
Hardware Configuration Reset (CHRD)

Passwords

Passwords are stored in flash memory and secured using encryption. You can configure the following passwords:

SNMP Read Community Password: The password for read access to the AP using SNMP. Enter a password
between 6 and 32 characters in both the Password field and the Confirm field. The default password is public.

SNMP Read/Write Community Password: The password for read and write access to the AP using SNMP. Enter a
password between 6 and 32 characters in both the Password field and the Confirm field. The default password is
public.

SNMPv3 Authentication Password: The password used when sending authenticated SNMPv3 messages. Enter a

password in both the Password field and the Confirm field. This password must be between 6 and 32 characters, but
a length of at least 8 characters is recommended. The default password is public. Secure Management (Services tab)
must be enabled to configure SNMPv3.

The default SNMPv3 username is administrator, with SHA authentication and DES privacy protocol.

SNMPv3 Privacy Password: The password used when sending encrypted SNMPv3 data. Enter a password in both
the Password field and the Confirm field. This password must be between 6 and 32 characters, but a length of at
least 8 characters is recommended. The default password is public. Secure Management (Services tab) must be
enabled to configure SNMPV3.

Telnet (CLI) Password: The password for the CLI interface (via serial or Telnet). Enter a password between 6 and 32
characters in both the Password field and the Confirm field. The default password is public.

HTTP (Web) Password: The password for the Web browser HTTP interface. Enter a password between 6 and 32
characters in both the Password field and the Confirm field. The default password is public.

NOTE: For security purposes Proxim recommends changing ALL PASSWORDS from the default “public” immediately, to

restrict access to your network devices to authorized personnel. If you lose or forget your password settings, you
can always perform a Soft Reset to Factory Defaults or Hard Reset to Factory Defaults.
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IP Access Table

The Management IP Access table limits in-band management access to the IP addresses or range of IP addresses
specified in the table. This feature applies to all management services (SNMP, HTTP, and CLI) except for CLI
management over the serial port. To configure this table, click Add and set the following parameters:

» |IP Address: Enter the IP Address for the management station.
» IP Mask: Enter a mask that will act as a filter to limit access to a range of IP Addresses based on the IP Address you

already entered.

— The IP mask 255.255.255.255 would authorize the single station defined by the IP Address to configure the
Access Point. The AP would ignore commands from any other IP address. In contrast, the IP mask 255.255.255.0
would allow any device that shares the first three octets of the IP address to configure the AP. For example, if you
enter an |IP address of 10.20.30.1 with a 255.255.255.0 subnet mask, any IP address between 10.20.30.1 and
10.20.30.254 will have access to the AP’s management interfaces.

+ Comment: Enter an optional comment, such as the station name.

To edit or delete an entry, click Edit. Edit the information, or select Enable, Disable, or Delete from the Status pull-down

menu.

Services

You can configure the following management services:

Secure Management

Secure Management allows the use of encrypted and authenticated communication protocols such as SNMPv3, Secure
Socket Link (SSL), and Secure Shell (SSH) to manage the Access Point.
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» Secure Management Status: Enables the further configuration of HTTPS Access, SNMPv3, and Secure Shell
(SSH). After enabling Secure Management, you can choose to configure HTTPS (SSL) and Secure Shell access on
the Services tab, and to configure SNMPv3 passwords on the Passwords tab.

SNMP Settings

»  SNMP Interface Bitmask: Configure the interface or interfaces (Ethernet, Wireless, All Interfaces) from which you
will manage the AP via SNMP. You can also select Disabled to prevent a user from accessing the AP via SNMP.

HTTP Access

» HTTP Interface Bitmap: Configure the interface or interfaces (Ethernet, Wireless, All Interfaces) from which you
will manage the AP via the Web interface. For example, to allow Web configuration via the Ethernet network only, set
HTTP Interface Bitmask to Ethernet. You can also select Disabled to prevent a user from accessing the AP from the
Web interface.

* HTTP Port: Configure the HTTP port from which you will manage the AP via the Web interface. By default, the HTTP
port is 80. You must reboot the Access Point if you change the HTTP Port.

» HTTP Wizard Status: The Setup Wizard appears automatically the first time you access the HTTP interface. If you
exited out of the Setup Wizard and want to relaunch it, enable this option, click OK, and then close your browser or
reboot the AP. The Setup Wizard will appear the next time you access the HTTP interface.

HTTPS Access (Secure Socket Layer)
NOTE: SSL requires Internet Explorer version 6, 128 bit encryption, Service Pack 1, and patch Q323308.
NOTE: You need to reboot the AP after enabling or disabling SSL for the changes to take effect.

» HTTPS (Secure Web Status): The user can access the AP in a secure fashion using Secure Socket Layer (SSL)
over port 443. The AP comes pre-installed with all required SSL files: default certificate and private key installed. Use
the drop-down menu to enable/disable this feature.

» SSL Certificate Passphrase: After enabling SSL, the only configurable parameter is the SSL passphrase. The
default SSL passphrase is proxim.

The AP supports SSLv3 with a 128-bit encryption certificate maintained by the AP for secure communications
between the AP and the HTTP client. All communications are encrypted using the server and the client-side
certificate.

If you decide to upload a new certificate and private key (using TFTP or HTTP File Transfer), you need to change the
SSL Certificate Passphrase for the new SSL files.

Accessing the AP through the HTTPS interface

The user should use a SSL intelligent browser to access the AP through the HTTPS interface. After configuring SSL,
access the AP using https:// followed by the AP’s management IP address.
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Figure 4-21 Management Services Configuration Screen
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Telnet Configuration Settings

» Telnet Interface Bitmask: Select the interface (Ethernet, Wireless, All Interfaces) from which you can manage the
AP via telnet. This parameter can also be used to Disable telnet management.

* Telnet Port Number: The default port number for Telnet applications is 23. However, you can use this field if you want
to change the Telnet port for security reasons (but your Telnet application also must support the new port number you
select). You must reboot the Access Point if you change the Telnet Port.

* Telnet Login Idle Timeout (seconds): Enter the number of seconds the system will wait for a login attempt. The AP
terminates the session when it times out. The range is 30 to 300 seconds; the default is 60 seconds.

* Telnet Session Idle Timeout (seconds): Enter the number of seconds the system will wait during a session while
there is no activity. The AP will terminate the session on timeout. The range is 60 to 36000 seconds; the default is 900
seconds.

Secure Shell (SSH) Settings

The AP supports SSH version 2, for secure remote CLI (Telnet) sessions. SSH provides strong authentication and
encryption of session data.

The SSH server (AP) has host keys - a pair of asymmetric keys - a private key that resides on the AP and a public key
that is distributed to clients that need to connect to the AP. As the client has knowledge of the server host keys, the client
can verify that it is communicating with the correct SSH server. The client authentication is performed as follows:

» Using a username/password pair if RADIUS Based Management is enabled; otherwise, using a password to
authenticate the user over a secure channel created using SSH.

SSH Session Setup
An SSH session is setup through the following process:

* The SSH server public key is transferred to the client using out-of-band or in-band mechanisms.
» The SSH client verifies the correctness of the server using the server’s public key.
* The user/client authenticates to the server.

* An encrypted data session starts. The maximum number of SSH sessions is limited to two. If there is no activity for a
specified amount of time (the Telnet Session Timeout parameter), the AP will timeout the connection.

SSH Clients

The following SSH clients have been verified to interoperate with the AP’s server. The following table lists the clients,
version number, and the website of the client.

Clients Version Website
OpenSSH V3.4-2 http://www.openssh.com
Putty Rel 0.53b http://www.chiark.greenend.org.uk
Zoc 5.00 http://www.emtec.com
Axessh V2.5 http://www.labf.com

For key generation, OpenSSH client has been verified.

Configuring SSH
Perform the following procedure to set the SSH host key and enable or disable SSH:

1. Click Configure > Management > Services
2. Select the SSH Host Key Status from the drop down menu.

NOTE: SSH Host Key Status can not be changed if SSH status or Secure Management is enabled.
3. To enable/disable SSH, select Enable/Disable from the SSH (Secure Shell) Status drop-down menu.
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NOTE: When Secure Management is enabled on the AP, SSH will be enabled by default and cannot be disabled.

Host keys must either be generated externally and uploaded to the AP (see Uploading Externally Generated Host Keys),
generated manually, or auto-generated at the time of SSH initialization if SSH is enabled and no host keys are present.
There is no key present in an AP that is in a factory default state.

To manually generate or delete host keys on the AP:
CAUTION: SSH Host key creation may take 3 to 4 minutes during which time the AP may not respond.

» Select Create to generate a new pair of host keys.

» Select Delete to remove the host keys from the AP. If no host keys are present, the AP will not allows connections
using SSH. When host keys are created or deleted, the AP updates the fingerprint information displayed on the
Management > Services page.

Uploading Externally Generated Host Keys

Perform the following procedure to upload externally generated host keys to the AP. You must upload both the SSH
public key and SSH private key for SSH to work.

1. Verify that the host keys have been externally generated. The OpenSSH client has been verified to interoperate with
AP’s SSH server.

2. Click Commands > Update AP > via HTTP (or via TFTP).
\ Rgtnieve Filg \ Reboeot 1 Resel 1 Help Lank \
da TFTP i ‘\

This page i3 uacd to update software images and configurabon tias in the Acceas
Point using HTTP file transfer. Click on the browse bution 1o search for the file or
enter the path in the text box. Select the (e fype and clhck the Update AP bution o
slart the file tranafer,

System Infarmation

SoRw A

E._p_gl sader Version

Irial g
Confg

SSL Corsbcale
S5L Privateiay
UpgradeBSPBL
(CLI Batch File
SSH Pubbic Key

Figure 4-22 Uploading an Externally Generated SSH Public Key and SSH Private Key

Select SSH Public Key from the File Type drop-down menu.

Click Browse, select the SSH Public Key file on your local machine.
Click Open.

to initiate the file transfer, click the Update AP button.

Select SSH Private Key from the File Type drop-down menu.

Click Browse, select the SSH Private Key on your local machine.

9. Click Open.

10.To initiate the file transfer, click the Update AP button.

® N gk~

The fingerprint of the new SSH public key will be displayed in the Management > Services page.
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Serial Configuration Settings

The serial port interface on the AP is enabled at all times. See Setting IP Address using Serial Port for information on how
to access the CLlI interface via the serial port. You can configure and view the following parameters:

» Serial Baud Rate: Select the serial port speed (bits per second). Choose between 2400, 4800, 9600, 19200, 38400,
or 57600; the default Baud Rate is 9600.
» Serial Flow Control: Select either None (default) or Xon/Xoff (software controlled) data flow control.

NOTE: To avoid potential problems when communicating with the AP through the serial port, Proxim recommends
that you leave the Flow Control setting at None (the default value).

» Serial Data Bits: This is a read-only field and displays the number of data bits used in serial communication (8 data
bits by default).

» Serial Parity: This is a read-only field and displays the number of parity bits used in serial communication (no parity
bits by default).

» Serial Stop Bits: This is a read-only field that displays the number of stop bits used in serial communication (1 stop
bit by default).

NOTE: The serial port bit configuration is commonly referred to as 8N1.

RADIUS Based Management Access

User management of APs can be centralized by using a RADIUS server to store user credentials. The AP cross-checks
credentials using RADIUS protocol and the RADIUS server accepts or rejects the user.

HTTP/HTTPS and Telnet/SSH users can be managed with RADIUS. Serial CLI and SNMP cannot be managed by
RADIUS. Two types of users can be supported using centralized RADIUS management:

» Super User: The super user has access to all functionality of a management interface. A super user is configured in
the RADIUS server by setting the filter ID attribute (returned in the RADIUS Accept packet) for the user to a value of
“super user” (not case sensitive). A user is considered a super user if the value of the filter-id attribute returned in the
RADIUS Accept packet for the user is “super user” (not case sensitive).

» Limited User: A limited user has access to only a limited set of functionality on a management interface. All users
who are not super users are considered limited users. However, a limited user is configured in the RADIUS server by
setting the filter-id attribute (returned in the RADIUS Accept packet) to “limited user” (not case sensitive). Limited
users do not have access to the following configuration capabilities:

— Update/retrieve files to and from APs
— Reset the AP to factory defaults
— Reboot the AP

— Change management properties related to RADIUS, management modes, and management passwords.

NOTE: When a user has both “limited user” and “super user” filter-ids configured in the Radius server, the user has
limited user privileges.

When RADIUS Based Management is enabled, a local user can be configured to provide Telnet, SSH, and HTTP(S)
access to the AP when RADIUS servers fail. The local user has super user capabilities. When secure management is
enabled, the local user can only login using secure means (i.e., SSH or SSL). When the local user option is disabled the
only access to the AP when RADIUS servers are down will be through serial CLI or SNMP.

The Radius Based Management Access parameters allows you to enable HTTP or Telnet Radius Management Access,
to configure a RADIUS Profile for management access control, and to enable or disable local user access, and configure
the local user password. You can configure and view the following parameters:

 HTTP RADIUS Access Control Status: Enable RADIUS management of HTTP/HTTPS users.

* Telnet RADIUS Access Control Status: Enable RADIUS management of Telnet/SSH users.
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* RADIUS Profile for Management Access Control: Specifies the RADIUS Profile to be used for RADIUS Based
Management Access.

* Local User Status: Enables or disables the local user when RADIUS Based Management is enabled. The default
local user ID is root.

» Local User Password and Confirm Password: The default local user password is public. “Root” cannot be
configured as a valid user for Radius based management access when local user access is enabled.

Automatic Configuration (AutoConfig)

The Automatic Configuration feature which allows an AP to be automatically configured by downloading a specific
configuration file from a TFTP server during the boot up process.

Automatic Configuration is disabled by default. The configuration process for Automatic Configuration varies depending
on whether the AP is configured for dynamic or static IP.

When an AP is configured for dynamic IP, the Configuration filename and the TFTP server IP address are contained in
the DHCP response when the AP gets its IP address dynamically from the DHCP server. When configured for static IP,
these parameters are instead configured in the AP interface.

After setting up automatic configuration you must reboot the AP. When the AP reboots it receives the new configuration
information and must reboot one additional time. If Syslog is configured, a Syslog message will appear indicating the
success or failure of the Automatic Configuration.

Auto Configuration and the CLI Batch File

The Auto Configuration feature allows download of the LTV (Length, Type, Value) format configuration file or the CLI
Batch file. The LTV file contains parameters used by the AP; the CLI Batch file contains CLI executable commands used
to set AP parameters. The AP detects whether the uploaded file is LTV format or a CLI Batch file. If the AP detects an
LTV file, it stores the file in the AP’s flash memory. If the AP detects a CLI Batch file (a file with an extension of .cli), the
AP executes the commands contained in the file immediately. The AP will reboot after executing the CLI Batch file. Auto
Configuration will not result in repeated reboots if the CLI Batch file contains rebootable parameters.

For more information, see the CLI Batch File section.

Set up Automatic Configuration for Static IP

Perform the following procedure to enable and set up Automatic Configuration when you have a static IP address for the
TFTP server.

1. Click Configure > Management > AutoConfig. The Automatic Configuration Screen appears.

2. Check Enable Auto Configuration.

3. Enter the Configuration Filename. The default is config.

4. Enter the IP address of the TFTP server in the TFTP Server Address field. The default is 169.254.128.133.
NOTE: The default filename is “config”. The default TFTP IP address is 169.254.128.133.

Click OK to save the changes.

o

6. Reboot the AP. When the AP reboots it receives the new configuration information and must reboot one additional
time. If a Syslog server was configured, the following messages can be observed on the Syslog server:

* AutoConfig for Static IP
* TFTP server address and configuration filename
* AutoConfig Successful
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Figure 4-23 Automatic Configuration Screen

Set up Automatic Configuration for Dynamic IP

Perform the following procedure to enable and set up Automatic Configuration when you have a dynamic IP address for

the TFTP server via DHCP.

The Configuration filename and the TFTP server IP address are contained in the DHCP response when the AP gets its IP
address dynamically from the DHCP server. A Syslog server address is also contained in the DHCP response, allowing

the AP to send Auto Configuration success and failure messages to a Syslog server.

NOTE: The configuration filename and TFTP server IP address are configured only when the AP is configured for Static
IP. If the AP is configured for Dynamic IP these parameters are not used and obtained from DHCP.

1. Click Configure > Management > AutoConfig.
The Automatic Configuration screen appears.

2. Check Enable Auto Configuration.

When the AP is Configured with Dynamic IP, the DHCP server should be configured with the TFTP Server IP address
("Boot Server Host Name", option 66) and Configuration file ("Bootfile name", option 67) as follows (note that this

example uses a Windows 2000 server):

3. Select DHCP Server > DHCP Option > Scope.
The DHCP Options: Scope screen appears.
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Scope Options
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Figure 4-24 DHCP Options: Setting the Boot Server Host Name

4. Add the Boot Server Hostname and Boot Filename parameters to the Available Options list.

5. Set the value of the Boot Server Hostname Parameter to the hostname or IP Address of the TFTP server. For
example: 11.0.0.7.

Scope Dptions

[ 064 MIS+ Domain Mame The name o
[ 065 NIS+ Servers A list of IP ac
[ 0BE Boot Server Host Name TFTF boot 5,

[4P-Config

Figure 4-25 DHCP Options: Setting the Bootfile Name

6. Set the value of the Bootfile Name parameter to the Configuration filename. For example: AP-Config.
7. If using Syslog, set the Log server IP address (option 7, Log Servers).

8. Reboot the AP. When the AP reboots it receives the new configuration information and must reboot one additional
time. If a Syslog server was configured, the following messages can be observed on the Syslog server:

* AutoConfig for Dynamic IP
* TFTP server address and configuration filename
* AutoConfig Successful

Hardware Configuration Reset (CHRD)
Hardware Configuration Reset Status is a parameter that defines the hardware configuration reset behavior of the AP.

If a user loses or forgets the AP’s HTTP/Telnet/SNMP password, the Reload button on the power injector provides a way
to reset the AP to default configuration values and gain access to the AP. However, in AP deployments where physical
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access to the AP is not protected, an unauthorized person could reset the AP to factory defaults and thus gain control of
the AP. The user can disable the hardware configuration reset functionality to prevent unauthorized access.

The hardware configuration reset feature operates as follows:
»  When hardware configuration reset is enabled, the user can press the Reload button on the power injector for 10
seconds when the AP is in normal operational mode in order to delete the AP configuration.

*  When hardware configuration reset is disabled, pressing the Reload button when the AP is in normal operational
mode does not have any effect on the AP.

» The hardware configuration reset parameter does not have any effect on the functionality of the reload button to
delete the AP image during AP boot loader execution.

» The default hardware configuration reset status is enabled. When disabling hardware configuration reset, the user is
recommended to configure a configuration reset password. A configuration reset option appears on the serial port
during boot up, before the AP reads its configuration and initializes.

*  Whenever the AP is reset to factory default configuration, hardware configuration reset status is enabled and the
configuration reset password is set to the default, “public”.

» If secure mode is enabled in the AP, only secure (SSL, SNMPv3, SSH) users can modify the values of the Hardware
Configuration Reset Status and the configuration reset password.
Configuration Reset via Serial Port During Bootup

If hardware configuration reset is disabled, the user gets prompted by a configuration reset option to reset the AP to
factory defaults during boot up from the serial interface. By pressing a key sequence (ctrl-R), the user gets prompted to
enter a configuration reset password before the configuration is reset.

NOTE: Itis important to safely store the configuration reset password. If a user forgets the configuration reset password,
the user will be unable to reset the AP to factory default configuration if the AP becomes inaccessible and the
hardware configuration reset functionality is disable.

Configuring Hardware Configuration Reset

Perform the following procedure to configure Hardware Configuration Reset and to set the Configuration Reset
Password. See Figure 4-26.

1. Click Configure > Management > CHRD.
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Figure 4-26 Hardware Configuration Reset
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2. Check (enable) or uncheck (disable) the Enable Hardware Configuration Reset checkbox.

3. Change the default Configuration Reset Password in the “Configuration Reset Password” and “Confirm” fields.

4. Click OK.

5. Reboot the AP.

NOTE: Itis important to safely store the configuration reset password. If a user forgets the configuration reset password,

the user will be unable to reset the AP to factory default configuration if the AP becomes inaccessible and the
hardware configuration reset functionality is disable.

Procedure to Reset Configuration via the Serial Interface

1. During boot up, observe the message output on the serial interface.
The AP prompts the user with the message: “Press ctrl-R in 3 seconds to choose configuration reset option.”
2. Enter ctrl-R within 3 seconds after being prompted.

The AP prompts the user with “Press ctrl-Z to continue with normal boot up or enter password to reset configuration.’
If the user enters ctrl-Z, the AP continues to boot with the stored configuration.

3. Enter the configuration reset password. The default configuration reset password is “public”.
When the correct configuration reset password is entered, the AP gets reset to factory defaults and displays the
message “AP has been reset to Factory Default Settings.” The AP continues to boot up. If an incorrect configuration
reset password is entered, the AP shows an error message and reprompts the user. If the incorrect password is
entered three times in a row, the AP proceeds to boot up.
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The Access Point’s Packet Filtering features help control the amount of traffic exchanged between the wired and wireless
networks. There are four sub-tabs under the Filtering heading:

Ethernet Protocol
Static MAC
Advanced
TCP/UDP Port

Ethernet Protocol

The Ethernet Protocol Filter blocks or forwards packets based on the Ethernet protocols they support.

Follow these steps to configure the Ethernet Protocol Filter:

1. Select the interface or interfaces that will implement the filter from the Ethernet Protocol Filtering drop-down menu.

» Ethernet: Packets are examined at the Ethernet interface
*  Wireless: Packets are examined at the Wireless interface
» All Interfaces: Packets are examined at both interfaces

* Disabled: The filter is not used

2. Select the Filter Operation Type.
» |If set to Passthru, only the enabled Ethernet Protocols listed in the Filter Table will pass through the bridge.
» If set to Block, the bridge will block enabled Ethernet Protocols listed in the Filter Table.

Alarms \'|'| Bridge ‘]\ Qo8 1 RADILS Profilas 11 SSIDMLAN/Securty |

System Metwark Inkarfaces Wanagemant

|  omtcmsc | Adanced | TCPUDPPat |

Protocol filters can be used to control netwark traffic. Allowing or denying cerain protocols can reduce
overhead of unwanted iraffic on the wireless network. The access poanl supports a predefined lisi of

Ethernal projocols, bul provides the flaxibility of defining custom Etharmnel protocals
Ethernet Frotoced Filtering ANl intertaces vI
Filer Operation Iype Bisck -

- Cancel

Ethermnet Protocol Filter Table
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\

Figure 4-27 Ethernet Protocol Filter Configuration

3. Configure the Ethernet Protocol Filter Table. This table is pre-populated with existing Ethernet Protocol Filters,
however, you may enter additional filters by specifying the appropriate parameters.
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» To add an entry, click Add, and then specify the Protocol Number and a Protocol Name.

— Protocol Number: Enter the protocol number. See http://www.iana.org/assignments/ethernet-numbers for a
list of protocol numbers.

— Protocol Name: Enter related information, typically the protocol name.

Alarms \ Bridge \ 008 | RADIUSProfiles | SSIDMLANSecurty |

SyslEm REtwark Il TS Wanagemant 1
€

Ethernet Protocal Filter Table - Add Entries

[n ] ahicel

Figure 4-28 Ethernet Protocol Filter Table - Add Entries

» To edit or delete an entry, click Edit and change the information, or select Enable, Disable, or Delete from the
Status drop-down menu.

NOTE: An entry’s status must be enabled in order for the protocol to be subject to the filter.

Alarms } Bridge \ 0os x'L RADILS Profiles ‘.l SSIDNVLANSecunty |

Sysharm Fabarr Inledaces Managermani \I'..

Advanced Protocol Filter Table - Edit Entries
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Figure 4-29 Ethernet Protocol Filter Table - Edit Entries

Static MAC

The Static MAC Address filter optimizes the performance of a wireless (and wired) network. When this feature is properly
configured, the AP can block traffic between wired devices and wireless devices based on MAC address.

For example, you can set up a Static MAC filter to prevent wireless clients from communicating with a specific server on
the Ethernet network. You can also use this filter to block unnecessary multicast packets from being forwarded to the
wireless network.

NOTE: The Static MAC Filter is an advanced feature. You may find it easier to control wireless traffic via other filtering
options, such as Ethernet Protocol Filtering.
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Figure 4-30 Static MAC Filter Configuration

Each static MAC entry contains the following fields:

*  Wired MAC Address

*  Wired Mask

* Wireless MAC Address

* Wireless Mask

+ Comment: This field is optional.

Each MAC Address or Mask is comprised of 12 hexadecimal digits (0-9, A-F) that correspond to a 48-bit identifier. (Each
hexadecimal digit represents 4 bits (0 or 1).)

Taken together, a MAC Address/Mask pair specifies an address or a range of MAC addresses that the AP will look for
when examining packets. The AP uses Boolean logic to perform an “AND” operation between the MAC Address and the
Mask at the bit level. However, for most users, you do not need to think in terms of bits. It should be sufficient to create a
filter using only the hexadecimal digits 0 and F in the Mask (where 0 is any value and F is the value specified in the MAC
address). A Mask of 00:00:00:00:00:00 corresponds to all MAC addresses, and a Mask of FF:FF:FF:FF:FF:FF applies
only to the specified MAC Address.

For example, if the MAC Address is 00:20:A6:12:54:C3 and the Mask is FF:FF:FF:00:00:00, the AP will examine the
source and destination addresses of each packet looking for any MAC address starting with 00:20:A6. If the Mask is
FF:FF:FF:FF:FF:FF, the AP will only look for the specific MAC address (in this case, 00:20:A6:12:54:C3).

When creating a filter, you can configure the Wired parameters only, the Wireless parameters only, or both sets of
parameters. Which parameters to configure depends upon the traffic that you want block:

» To prevent all traffic from a specific wired MAC address from being forwarded to the wireless network, configure only
the Wired MAC Address and Wired Mask (leave the Wireless MAC Address and Wireless Mask set to all zeros).

» To prevent all traffic from a specific wireless MAC address from being forwarded to the wired network, configure only
the Wireless MAC address and Wireless Mask (leave the Wired MAC Address and Wired Mask set to all zeros).

» To block traffic between a specific wired MAC address and a specific wireless MAC address, configure all four
parameters.
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A maximum of 200 entries can be created in the Static MAC filter table. To create an entry, click Add and enter the
appropriate MAC addresses and Masks to setup a filter. The entry is enabled automatically when saved.

- | RADIUSProfles | SSIDMLANSecurty |

(=]

Alarms ‘k Bridge "|.L Qo
Nebwork Infemtaces

]
3
]

Managermgnt I'II_

T Wk &
red KAl AD0mnss

Figure 4-31 Static MAC Filter Table - Add Entries

To edit an entry, click Edit. To disable or remove an entry, click Edit and change the Status field from Enable to Disable
or Delete.

Static MAC Filter Examples
Consider a network that contains a wired server and three wireless clients. The MAC address for each unit is as follows:

»  Wired Server: 00:40:F4:1C:DB:6A

*  Wireless Client 1: 00:02:2D:51:94:E4
*  Wireless Client 2: 00:02:2D:51:32:12
»  Wireless Client 3: 00:20:A6:12:4E:38

Prevent Two Specific Devices from Communicating
Configure the following settings to prevent the Wired Server and Wireless Client 1 from communicating:

* Wired MAC Address: 00:40:F4:1C:DB:6A

*  Wired Mask: FF:FF.:FF:FF:FF:FF

* Wireless MAC Address: 00:02:2D:51:94:E4
* Wireless Mask: FF.FF:FF:FF.FF:FF

Result: Traffic between the Wired Server and Wireless Client 1 is blocked. Wireless Clients 2 and 3 can still communicate
with the Wired Server.

Prevent Multiple Wireless Devices from Communicating with a Single Wired Device
Configure the following settings to prevent Wireless Clients 1 and 2 from communicating with the Wired Server:

* Wired MAC Address: 00:40:F4:1C:DB:6A

* Wired Mask: FF:FF:FF:FF:FF:FF

*  Wireless MAC Address: 00:02:2D:51:94:E4

* Wireless Mask: FF:FF:FF:00:00:00

Result: When a logical “AND” is performed on the Wireless MAC Address and Wireless Mask, the result corresponds to
any MAC address beginning with the 00:20:2D prefix. Since Wireless Client 1 and Wireless Client 2 share the same

prefix (00:02:2D), traffic between the Wired Server and Wireless Clients 1 and 2 is blocked. Wireless Client 3 can still
communicate with the Wired Server since it has a different prefix (00:20:A6).
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Prevent All Wireless Devices from Communicating with a Single Wired Device
Configure the following settings to prevent all three Wireless Clients from communicating with Wired Server 1:

* Wired MAC Address: 00:40:F4:1C:DB:6A
*  Wired Mask: FF:FF:FF:FF:FF:FF

* Wireless MAC Address: 00:00:00:00:00:00
* Wireless Mask: 00:00:00:00:00:00

Result: The Access Point blocks all traffic between Wired Server 1 and all wireless clients.

Prevent a Wireless Device from Communicating with the Wired Network
Configure the following settings to prevent Wireless Client 3 from communicating with any device on the Ethernet:

*  Wired MAC Address: 00:00:00:00:00:00

*  Wired Mask: 00:00:00:00:00:00

* Wireless MAC Address: 00:20:A6:12:4E:38
* Wireless Mask: FF.FF.:FF:FF.:FF:FF

Result: The Access Point blocks all traffic between Wireless Client 3 and the Ethernet network.

Prevent Messages Destined for a Specific Multicast Group from Being Forwarded to the Wireless LAN

If there are devices on your Ethernet network that use multicast packets to communicate and these packets are not
required by your wireless clients, you can set up a Static MAC filter to preserve wireless bandwidth. For example, if
routers on your network use a specific multicast address (such as 01:00:5E:00:32:4B) to exchange information, you can
set up a filter to prevent these multicast packets from being forwarded to the wireless network:

*  Wired MAC Address: 01:00:5E:00:32:4B

»  Wired Mask: FF:FF:FF:FF:FF:FF

*  Wireless MAC Address: 00:00:00:00:00:00

*  Wireless Mask: 00:00:00:00:00:00

Result: The Access Point does not forward any packets that have a destination address of 01:00:5E:00:32:4B to the
wireless network.

Advanced
You can configure the following advanced filtering options:

* Enable Proxy ARP: Place a check mark in the box provided to allow the Access Point to respond to Address
Resolution Protocol (ARP) requests for wireless clients. When enabled, the AP answers ARP requests for wireless
stations without actually forwarding them to the wireless network. If disabled, the Access Point will bridge ARP
requests for wireless clients to the wireless LAN.

* Enable IP/ARP Filtering: Place a check mark in the box provided to allow IP/ARP filtering based on the IP/ARP
Filtering Address and IP Mask. Leave the box unchecked to prevent filtering. If enabled, you should also configure the
IP/ARP Filtering Address and IP/ARP IP Mask.

— IP/ARP Filtering Address: Enter the Network filtering IP Address.
— IP/ARP IP Mask: Enter the Network Mask IP Address.
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Figure 4-32 Advanced Filter Configuration

The following protocols are listed in the Advanced Filter Table:

Deny IPX RIP

Deny IPX SAP
Deny IPX LSP

Deny IP Broadcasts
Deny IP Multicasts

The AP can filter these protocols in the wireless-to-Ethernet direction, the Ethernet-to-wireless direction, or in both
directions. Click Edit and use the Status field to Enable or Disable the filter.
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Figure 4-33 Static MAC Filter Table - Edit Entries

TCP/UDP Port

Port-based filtering enables you to control wireless user access to network services by selectively blocking TCP/UDP
protocols through the AP. A user specifies a Protocol Name, Port Number, Port Type (TCP, UDP, or TCP/UDP), and
filtering interfaces (Wireless only, Ethernet only, a combination of Wireless and Ethernet, or all interfaces) in order to
block access to services, such as Telnet and FTP, and traffic, such as NETBIOS and HTTP.

For example, an AP with the following configuration would discard frames received on its Ethernet interface with a UDP
destination port number of 137, effectively blocking NETBIOS Name Service packets.

Protocol Type Destination Port Protocol Name Interface Status (Enable/Disable)
(TCP/UDP) Number
UDP 137 NETBIOS Name Ethernet Enable
Service

Adding TCP/UDP Port Filters
1. Place a check mark in the box labeled Enable TCP/UDP Port Filtering.
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Figure 4-34 TCP/UDP Port Filter Configuration

2. Click Add under the TCP/UDP Port Filter Table heading.
3. Inthe TCP/UDP Port Filter Table, enter the Protocol Names to filter.

4. Set the destination Port Number (a value between 1 and 65535) to filter. See the IANA Web site at
http://www.iana.org/assignments/port-numbers for a list of assigned port numbers and their descriptions.

5. Set the Port Type for the protocol: TCP, UDP, or both (TCP/UDP).
6. Set the Interface to filter:

*  Only Ethernet

*  Only Wireless

* Allinterfaces
7. Click OK.
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Figure 4-35 TCP/UDP Port Filter Table - Add Entries

Editing TCP/UDP Port Filters
1. Click Edit under the TCP/UDP Port Filter Table heading.

2. Make any changes to the Protocol Name or Port Number for a specific entry, if necessary.

3. In the row that defines the port, set the Status to Enable, Disable, or Delete, as appropriate.

4. Select OK.
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Figure 4-36 TCP/UDP Port Filter Table - Edit Entries
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The Alarms tab has the following sub-tabs:

*  Groups

* Alarm Host Table
* Syslog

* Rogue Scan

Groups

Alarm groups can be enabled or disabled via the Web interface. Place a check mark in the box provided to enable a
specific group. Remove the check mark from the box to disable the alarms. Alarm severity levels are as follows:

« Critical alarms will often result in severe disruption in network activity or an automatic reboot of the AP.

* Major alarms are usually activated due to a breach in the security of the system. Clients cannot be authenticated
because an attempt at unauthorized access into the AP has been detected.

* Informational alarms provide the network administrator with some general information about the activities the AP is

performing.

Configuration Trap Group

Trap Name Description Severity Level
oriTrapDNSIPNotConfigured DNS IP address not configured Major
oriTrapRADIUSAuthenticationNotConfigured RADIUS Authentication not configured Maijor
oriTrapRADIUSAccountingNotConfigured RADIUS Accounting not configured Major
oriTrapDuplicatelPAddressEncountered Another network device with the same IP address | Major

exists
oriTrapDHCPRelayServerTableNotConfigured | The DHCP relay agent server table is empty or Major
not configured
oriTrapVLANIDInvalidConfiguration A VLAN ID configuration is invalid Maijor
oriTrapAutoConfigFailure Auto configuration failed Minor
oriTrapBatchExecFailure The CLI Batch execution fails for the following Minor
reasons:
+ lllegal Command is parsed in the CLI Batch
file
« Execution error is encountered while
executing CLI Batch file
» Bigger file size than 100 Kbytes
oriTrapBatchFileExecStart The CLI Batch execution begins after file is Minor
uploaded
oriTrapBatchFileExecEnd The execution of CLI Batch file ends. Minor

Security Trap Group

Trap Name

Description

Severity Level

oriTraplnvalidEncryptionKey

Invalid encryption key has been detected.

Critical
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Trap Name

Description

Severity Level

oriTrapAuthenticationFailure

Client authentication failure has occurred.
Authentication failures can range from:

« MAC Access Control table
* RADIUS MAC authentication

« 802.1x authentication specifying the
EAP-Type
+  WORP mutual authentication

« SSID authorization failure specifying the
SSID

* VLAN ID authorization failure specifying the
VLAN ID

Major

oriTrapUnauthorizedManagerDetected

Unauthorized manager has attempted to view
and/or modify parameters

Major

oriTrapRADScanComplete

RAD scan is successfully completed

Informational

oriTrapRADScanResults

Provides information on the RAD Scan results

Informational

oriTrapRogueScanStationDetected

Rogue station detected

Informational

oriTrapRogueScanCycleComplete

Rogue scan successfully completed

Informational

Wireless Interface/Card Trap Group

Trap Name Description Severity Level
oriTrapWLCFailure General failure wireless interface/card failure. Critical
oriTrapWLCRadarInterferenceDetected Radar interference detected on the channel being | Major

used by the wireless interface
MIC Attack Detected Supported in Web interface only Maijor
MIC Attack Report Detected Supported in Web interface only Major

Operational Trap Group

Trap Name Description Severity Level
oriTrapUnrecoverableSoftwareErrorDetected Unrecoverable software error detected. Causes | Critical
software watch dog timer to expire, which in turn
causes the device to reboot.
oriTrapRADIUSServerNotResponding RADIUS server not responding to authentication | Major
requests sent from the RADIUS client in the
device
oriTrapModuleNotlInitialized Module (hardware or software) not initialized Maijor
oriTrapDeviceRebooting Device rebooting Informational
oriTrapTaskSuspended Task suspended Critical
oriTrapBootPFailed Response to the BootP request not received; Major

device not dynamically assigned an IP address
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Trap Name

Description

Severity Level

oriTrapDHCPFailed

Response to the DHCP client request not
received; device not dynamically assigned an IP
address

Major

oriTrapDNSClientLookupFailure

DNS client attempts to resolve a specified
hostname (DNS lookup) and a failure occurs
because either the DNS server is unreachable or
there is an error for the hostname lookup. Trap
specifies the hostname that was being resolved.

Major

oriTrapSSLlInitializationFailure

SSL initialization failure

Major

oriTrapWirelessServiceShutdown

Wireless interface has shutdown services for
wireless clients

Informational

oriTrapWirelessServiceResumed

Wireless interface has resumed service and is
ready for wireless client connections

Informational

oriTrapSSHInitializationStatus

SSH initialization status

Major

oriTrapVLANIDUserAssignment

User is assigned a VLAN ID from the RADIUS
server

Informational

oriTrapDHCPLeaseRenewal

AP requests DHCP renewal and receives new
information from the DHCP server. Information
includes the DHCP server IP address that replied
to the DHCP client request, and the IP address,
subnet mask, and gateway IP address returned
from the DHCP server.

Informational

oriTrapTemperatureAlert

Temperature is above or below acceptable
operating margin.

Temperature is within 5°C of upper or lower limit.

Critical

Major

Flash Memory Trap Group

dConfiguration

be corrupted, and the device loads the last known
good configuration file

Trap Name Description Severity Level
oriTrapFlashMemoryEmpty No data present in flash memory Informational
Flash Memory Corrupted Flash memory corrupted Critical
oriTrapFlashMemoryRestoringLastknownGoo | Current/original configuration data file is found to | Informational

TFTP Trap Group

Trap Name Description Severity Level
oriTrapTFTPFailedOperation TFTP operation failed Major
oriTrapTFTPOperationlnitiated TFTP operation Initiated Informational
oriTrapTFTPOperationCompleted TFTP operation completed Informational

Image Trap Group

Trap Name

Description

Severity Level

oriTrapZeroSizelmage

Zero size image loaded onto device

Major
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device

Trap Name Description Severity Level
oriTraplnvalidimage Invalid image loaded onto device Major
oriTraplmageToolLarge Image loaded on the device exceeds the size Major

limitation of flash
oriTraplncompatiblelmage Incompatible image loaded onto device Major
oriTraplnvalidimageDigitalSignature Image with invalid digital signature is loaded onto | Major

SNTP Trap Group
Trap Name Description Severity Level
oriTrapSNTPFailure SNTP time retrieval failure Minor
oriTrapSNTPFailure SNTP sync-up failure Minor

In addition, the AP supports these standard traps, which are always enabled:

RFC 1215-Trap

Trap Name Description Severity Level
coldStart AP is on or rebooted Informational
linkUp AP's Ethernet interface link is up (working) Informational
linkDown AP's Ethernet interface link is down (not working) | Informational

Bridge MIB (RFC 1493) Alarms

same transition

Trap Name Description Severity Level
New Root AP has become the new root in the Spanning Informational
Tree network
topologyChange Trap is not sent if a newRoot trap is sent for the | Informational

All these alarm groups correspond to System Alarms that are displayed in the System Status Screen, including the traps
that are sent by the AP to the SNMP managers specified in the Alarm Host Table.

Alarm Host Table

To add an entry and enable the AP to send SNMP trap messages to a Trap Host, click Add, and then specify the IP

Address and Password for the Trap Host.

NOTE: Up to 10 entries are possible in the Alarm Host table.

» |IP Address: Enter the Trap Host IP Address.

» Password: Enter the password in the Password field and the Confirm field.
+ Comment: Enter an optional comment, such as the alarm (trap) host station name.

To edit or delete an entry, click Edit. Edit the information, or select Enable, Disable, or Delete from the Status

drop-down menu.
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Syslog

The Syslog messaging system enables the AP to transmit event messages to a central server for monitoring and
troubleshooting. The access point logs “Session Start (Log-in)” and “Session Stop (Log-out)” events for each wireless
client as an alternative to RADIUS accounting.

See RFC 3164 at http://www.rfc-editor.org for more information on the Syslog standard.
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Crougs Alarm Host Table \ Rocuesean |
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Figure 4-37 Syslog Configuration Screen

Setting Syslog Event Notifications

Syslog Events are logged according to the level of detail specified by the administrator. Logging only urgent system
messages will create a far smaller, more easily read log than a log of every event the system encounters. Determine
which events to log by selecting a priority defined by the following scale:

Event Priority Description
LOG_EMERG |0 System is unusable
LOG_ALERT 1 Action must be taken immediately
LOG_CRIT 2 Critical conditions
LOG_ERR 3 Error conditions
LOG_WARNING |4 Warning conditions
LOG_NOTICE |5 Normal but significant condition
LOG_INFO 6 Informational
LOG DEBUG |7 Debug-level messages

Configuring Syslog Event Notifications
You can configure the following Syslog settings from the HTTP interface:

» Enable Syslog: Place a check mark in the box provided to enable system logging.
« Syslog Port Number: This field is read-only and displays the port number (514) assigned for system logging.
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» Syslog Lowest Priority Logged: The AP will send event messages to the Syslog server that correspond to the
selected priority number and any priority numbers below it. For example, if set to 6, the AP will transmit event
messages labeled priority 1 to 6 to the Syslog server. This parameter supports a range between 1 and 7; 6 is the
default.

» Syslog Heartbeat Status: When Heartbeat is enabled, the AP periodically sends a message to the Syslog server to
indicate that it is active.

» Syslog Heartbeat Interval: If Syslog Heartbeat Status is enabled this field provides the interval for the heartbeat in
seconds (between 1 and 604800). The default is 900 seconds.

» Syslog Host Table: This table specifies the IP addresses of a network servers that the AP will send Syslog messages
to. Click Add to create a new entry. Click Edit to change an existing entry. Each entry contains the following field:

— IP Address: Enter the IP Address for the management host.
— Comment: Enter an optional comment such as the host name.

— Status: The entry is enabled automatically when saved (so the Status field is only visible when editing an entry).
You can also disable or delete entries by changing this field’s value.

Syslog Messages

The following messages are supported in the AP:

Syslog Message Name Priority Severity Description

Auto Configuration using DHCP |6 Informational | Configuration filename and TFTP server address
are obtained from DHCP when dynamic IP is
configured on the device.

Auto Configuration using Static IP | 6 Informational | Configured TFTP server address and configuration
filename is used when Static IP is configured on
the device.

TFTP Server IP and configuration | 4 Minor Configuration filename and/or TFTP server

filename not present in DHCP address is not present in the DHCP response when

response using DHCP.

TFTP Server IP Address used in | 6 Informational | TFTP server IP address used for AutoConfig.

AutoConfig feature

TFTP Server filename used in 6 Informational | TFTP filename used for AutoConfig.

AutoConfig feature

Auto Configuration TFTP 4 Minor TFTP download of a configuration file for

Download Failure AutoConfig fails for the following reasons:

* Incorrect or non-reachable TFTP server
address

» Incorrect or unavailable configuration
filename

e TFTP transfer timeout.

Image Compatibility Check, 2 Maijor One of the following failures occurs:
Invalid Image « Invalid Signature

» Zero File Size

» Large File

*  Non VxWork Image
* Incompatible Image

AP Heartbeat Status 5 Informational | AP syslog keep alive message.
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Syslog Message Name Priority Severity Description
Client Login Authentication 6 Informational | Client logs in/authenticates. Message includes:
Status « Client MAC Address
» Authentication Type = None, ACL, RADIUS
MAC, 802.1X
» Cipher Type = None, WEP, TKIP, AES
» Status = Allow, Deny
» SSID to which client is connecting
Sample Message:
<client mac address> | Status = <value> | SSID =
<value> | Auth Type = <value> | Cipher Type =
<value>
Client De-Authentication Status | 6 Informational | Client de-authenticates. Message includes:
+ Client MAC Address
» Cipher Type = None, WEP, TKIP, AES
+ Status = De-authentication reason, which can
be any of the following:
— Unknown reason
— Stale authentication information
— Authenticated STA leaving BSS
— Inactivity
— Association error
— Class 2 frame received from
non-authenticated STA
— Class 3 frame received from
non-associated STA
— Associated STA leaving BSS
— STA requesting information, but not yet
authenticated
— Enhanced security (RSN) required
— Enhanced security (RSN) used
inconsistently
— Invalid Information Element
— MIC Failure
—  WPA module de-auth
» SSID to which client was connected
Sample Message:
<client mac address> | Status = <value> | SSID =
<value> | Cipher Type = <value>
RADIUS Accounting Start and 6 Informational | Start and Stop accounting messages for wireless
Stop Messages clients.
CLI Configuration File Start 6 Informational | CLI configuration file execution starts.
Execution
CLI Configuration File End 6 Informational | CLI configuration file execution ends.
Execution
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Syslog Message Name Priority Severity Description

CLI Configuration File Execution |4 Minor There is an error in execution of the CLI

Errors configuration file. The message specifies the
filename, line number, and error reason.

SSH Initialization Failure 3 Major One of the following failures occurs:
Keys not present
Keys cannot be generated
Internal error (no available resources)

SSH Key Generation Successful |6 Informational | SSH Key generation is successful.

Wireless Service Shutdown 6 Informational | Wireless service is shutdown.

Wireless Service Resume 6 Informational | Wireless service resumes.

MIC Attack Occurred 4 Minor MIC attack occurred; wireless interface is shut
down for 60 seconds

MIC Attack from Wireless Station Minor A MIC attack is detected from a wireless station.

SNTP Time Retrieval Failure 4 Minor SNTP Client in the AP fails to retrieve time
information from the configured SNTP servers.
Also included in message: IP Address of SNTP
server.

SNTP Time Sync-Up Failure 4 Minor SNTP Client in the AP fails to synchronize the time
with the SNTP server it was communicating with.
Also included in message: IP Address of SNTP
server.

Rogue Scan

The Rogue Scan feature provides an additional security level for wireless LAN deployments. Rogue Scan uses the
selected wireless interface(s) for scanning its coverage area for Access Points and clients.

A centralized Network Manager receives MAC address information from the AP on all wireless clients detected by the AP.
The Network Manager then queries all wired switches to find out the inbound switch/port of these wireless clients. If the
switch/port does not have a valid Access Point connected to it as per a pre-configured database, the Network Manager
proceeds to block that switch/port and prevent the Rogue AP from connecting to the wired network.
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Figure 4-38 Preventing Rogue AP Attacks

The figure above shows Client 1 connected to a Trusted AP and Client 2 connected to a Rogue AP. The Trusted AP
scans the networks, detects Client 2, and notifies the Network Manager. The Network Manager uses SNMP/CLI to query
the wired switch to find the inbound switch port of Client 2’s packets. The Network Manager verifies that this switch/router

98



Advanced Configuration AP-700 User Guide
Alarms

and port does not have a valid Access Point as per the administrator’s database. Thus it labels Client 2's AP as a Rogue
AP and proceeds to prevent the Rogue AP attack by blocking this switch’s port.

APs can be detected either by active scanning using 802.11 probe request frames or passively by detecting periodic
beacons, or both. Wireless clients are detected by monitoring 802.11 connection establishment messages such as
association/authentication messages or data traffic to or from the wireless clients.

There are two scanning modes available per wireless interface: continuous scanning mode and background scanning
mode.

Continuous Scanning Mode

The continuous scanning mode is a dedicated scanning mode where the wireless interface performs scanning alone and
does not perform the normal AP operation of servicing client traffic.

In continuous scanning mode the AP scans each channel for a channel scan time of one second and then moves to the
next channel in the scan channel list. With a channel scan time of one second, the scan cycle time will take less than a
minute (one second per channel). Once the entire scan channel list has been scanned the AP restarts scanning from the
beginning of the scan channel list.

Background Scanning Mode

In background scanning mode the AP performs background scanning while performing normal AP operations on the
wireless interface.

You can configure the scan cycle time between 1-1440 minutes (24 hours). The scan cycle time indicates how
frequently a channel is sampled and defines the minimum attack period that can go unnoticed.

In background scanning mode the AP will scan one channel then wait for a time known as channel scan time. The
channel scan time affects the amount of data collected during scanning and defines the maximum number of samples
(possible detections) in one scan. This is increased to improve scanning efficiency; the tradeoff is that it decreases
throughput. The optimum value for this parameter during background scanning mode is 20ms.The channel scan time is
calculated from the scan cycle time parameter and the number of channels in the scan channel list as follows:

intra-channel scan time = (scan cycle time - (channel scan time * number of channels in the scan list))/number of
channels in the scan list.

Rogue Scan Data Collection

The AP stores information gathered about detected stations during scanning in a Rogue Scan result table. The Rogue
Scan result table can store a maximum of 2000 entries. When the table fills, the oldest entry gets overwritten. The Rogue
Scan result table lists the following information about each detected station:
« Station Type: indicates one of the following types of station:
— Unknown station
— AP station
— Infrastructure Client Station
— IBSS Client Station
*  MAC Address of the detected station
* Channel: the working channel of the detected station
* SNR: the SNR value of the last frame from the station as received by the AP
» BSSID: the BSSID field stores the:
— MAC address of the associated Access Point in the case of a client.
— Zero MAC address or MAC address of the partner Access Point if the AP is a partner of a WDS link

The AP ages out older entries in the Rogue Scan result table if a detected station is inactive for more than the Scan
Result Table Ageing Time.
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Rogue Scan

Perform this procedure to enable Rogue Scan and define the Scan Interval and Scan Interface. See Figure 4-39.

The Rogue Scan screen also displays the number of new access points and clients detected in the last scan on each
wireless interface.

1.

9.

Enable the Security Alarm Group. Select the Security Alarm Group link from the Rogue Scan screen. Configure a
Trap Host to receive the list of access points (and clients) detected during the scan.

Click Configure > Alarms > Rogue Scan.
Enable Rogue Scan by checking Enable Rogue Scan.

NOTE: Rogue Scan cannot be enabled on a wireless interface when the Wireless Service Status on that interface is
shutdown. First, resume service on the wireless interface.

NOTE: Enabling Rogue Scan simultaneously with Broadcast Unique Beacon will cause a drift in the beacon interval
and the occasional missing of beacons.

. Enter the Scan Mode. Select Background Scanning or Continuous Scanning. In Continuous Scanning mode the AP

stops normal operation and scans continuously on that interface. In Background Scanning mode, the AP performs
background scanning while doing normal AP operation on that interface.

If the Scan Mode is Background Scanning, then enter the Scan Interval.

* The Scan Interval specifies the time period in minutes between scans in Background Scanning mode and can be
set to any value between 1 and 1440 minutes.

Configure the Scan Result Table Ageing Time. The AP ages out older entries in the Rogue Scan result table if a
detected station is inactive for more than this time. The valid range is from 60-7200 minutes, the default is 60 minutes.

. Configure the Scan Results Trap Notification Mode to control the notification behavior when APs or stations are

detected in a scan:

* No Notification

*  Notify AP

*  Notify Client

* Notify All (Notify both AP and Client detection)

. Configure the Scan Results Trap Report Style to control the way detected stations are reported in the notification:

* Report all detected stations since last scan (default)
* Report all detected stations since start of scan
Click OK.

The results of the Rogue Scan can be viewed in the Status page in the HTTP interface.
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The AP is a bridge between your wired and wireless networking devices. As a bridge, the functions performed by the AP
include:
* MAC address learning
» Forward and filtering decision making
» Spanning Tree protocol used for loop avoidance
Once the AP is connected to your network, it learns which devices are connected to it and records their MAC addresses

in the Learn Table. The table can hold up to 10,000 entries. To view the Learn Table, click on the Monitor button in the
web interface and select the Learn Table tab.

The Bridge tab has four sub-tabs:

e Spanning Tree
* Intra BSS
* Packet Forwarding

Spanning Tree

A Spanning Tree is used to avoid redundant communication loops in networks with multiple bridging devices. Bridges do
not have any inherent mechanism to avoid loops, because having redundant systems is a necessity in certain networks.
However, redundant systems can cause Broadcast Storms, multiple frame copies, and MAC address table instability
problems.

Complex network structures can create multiple loops within a network. The Spanning Tree configuration blocks certain
ports on AP devices to control the path of communication within the network, avoiding loops and following a spanning
tree structure.

For more information on Spanning Tree protocol, please see Section 8.0 of the IEEE 802.1d standard. The Spanning
Tree configuration options are advanced settings. Proxim recommends that you leave these parameters at their default
values unless you are familiar with the Spanning Tree protocol.

NOTE: Spanning Tree protocol is disabled by default. When WDS is enabled, Spanning Tree protocol is automatically
enabled. It may be manually disabled. If Spanning Tree protocol is enabled by WDS and WDS is subsequently
disabled, Spanning tree will remain enabled until it is manually disabled.
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Figure 4-40 Spanning Tree Sub-Tab

Storm Threshold

Storm Threshold is an advanced Bridge setup option that you can use to protect the network against data overload by:

» Specifying a maximum number of frames per second as received from a single network device (identified by its MAC

a

ddress).

» Specifying an absolute maximum number of messages per interface.

The Storm Threshold parameters allow you to specify a set of thresholds for each interface of the AP, identifying separate

values for the number of broadcast messages/second and Multicast messages/second.

When the number of frames for an interface or from a single network device exceeds the maximum value per second, the
AP will ignore all subsequent messages in that second received on that interface or from that network device.

* Address Threshold: Enter the maximum allowed number of packets per second.
» Ethernet Threshold: Enter the maximum allowed number of packets per second.
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* Wireless Threshold: Enter the maximum allowed number of packets per second.

Intra BSS

The wireless clients (or subscribers) that associate with a certain AP form the Basic Service Set (BSS) of a network
infrastructure. By default, wireless subscribers in the same BSS can communicate with each other. However, some
administrators (such as wireless public spaces) may wish to block traffic between wireless subscribers that are
associated with the same AP to prevent unauthorized communication and to conserve bandwidth. This feature enables
you to prevent wireless subscribers within a BSS from exchanging traffic.

Although this feature is generally enabled in public access environments, Enterprise LAN administrators use it to
conserve wireless bandwidth by limiting communication between wireless clients. For example, this feature prevents
peer-to-peer file sharing or gaming over the wireless network.

To block Intra BSS traffic, set Intra BSS Traffic Operation to Block.
To allow Intra BSS traffic, set Intra BSS Traffic Operation to Passthru.

Packet Forwarding

The Packet Forwarding feature enables you to redirect traffic generated by wireless clients that are all associated to the
same AP to a single MAC address. This filters wireless traffic without burdening the AP and provides additional security
by limiting potential destinations or by routing the traffic directly to a firewall. You can redirect to a specific port (Ethernet
or WDS) or allow the bridge’s learning process (and the forwarding table entry for the selected MAC address) to
determine the optimal port.

NOTE: The gateway to which traffic will be redirected should be node on the Ethernet network. It should not be a
wireless client.

Configuring Interfaces for Packet Forwarding

Configure your AP to forward packets by specifying port(s) to which packets are redirected and a destination MAC
address.
1. Within the Packet Forwarding Configuration screen, check the box labeled Enable Packet Forwarding.

2. Specify a destination Packet Forwarding MAC Address. The AP will redirect all unicast, multicast, and broadcast
packets received from wireless clients to the address you specify.

3. Select a Packet Forwarding Interface Port from the drop-down menu. You can redirect traffic to:
— Ethernet
— A WDS connection (see Wireless Distribution System (WDS) for details)
— Any (traffic is redirected to a port based on the bridge learning process)

4. Click OK to save your changes.
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Wi-Fi Multimedia (WMM)/Quality of Service (QoS) Introduction

The AP supports Wi-Fi Multimedia (WMM), which is a solution for QoS functionality based on the IEEE 802.11e
specification. WMM defines enhancements to the MAC for wireless LAN applications with Quality of Service
requirements, which include transport of voice traffic over IEEE 802.11 wireless LANs.

The enhancement are in the form of changes in protocol frame formats (addition of new fields and information elements),
addition of new messages, definition of new protocol actions, channel access mechanisms (differentiated control of
access to medium) and network elements (QoS/WME aware APs, STAs), and configuration management.

WME supports Enhanced Distributed Channel Access (EDCA) for prioritized QoS services. The WME/QoS feature can
be enabled or disabled per wireless interface. For more information on QoS, see “Technical Bulletin 69504 Revision 2” at
<http://keygen.proxim.com/support/orinoco/tb/tb69504 3wmm.pdf>.

Policy
Perform the following procedure to enable QoS and add QoS policies:

1. Click Configure > QoS > Policy.

System 1 Networic \ Interiaces \ Management \ _ Fiering "t
Alzms Bridge \ RADILIS Profiss \ SSIONLANS2cunty \

\_ Pirtornity Mapping \ EDCA ‘\

This page is used to cnable or disable the Cuality of Service (Go5) feature and to configure Goas
policies for each wireless interface. There are b posaitkle DoS polcy types to configure - inbxaamsd
Layer &, outbound Layer 4, inbound Layer J, outbound Layer J, and Spectralink. ¥ihan a Qo5 polecy
iz poded, @ entry Tor each QoF pocy type is created with detault values, You can then modity the
delaull values Tor each Qo5 Policy type, if degired, and anable the Do policy type. Depending on the
policy Bpe, & polcy Mapping index ahodld be specihad. For Layer 1 pabiies, an index lrom the
BO2.1p 1o BOZ.1D mapping table akowld be apecifiod. For Layer ] policses, an index from the BI21p to
IF DECP mapping table should be specified. Ho mapping index is required for Spectralink polcy
rypes. 005 marking ane also supporied and can be configured per policy fype; 005 marking can be
enabled oF disabled.

rhc SLID table id used 1o apply 0ol Policies configurad in the Pobsy Tabla. Go 16 Ihe
[y page and thene you can spodily the Oos Polsty 1o be applied per 3310 based on
e oy indax numbar

Nofec Like with adding a Qo8 Policy, when a QoS policy is deleted, all § QoS policy fypes are
defefed i you oo mol with to have all 5 policy types per policy do nof cedede Dhem, aimply disabie the
ones thal are nol dosired,

Nofe: Changes iy fheae paramelens rsquire sccess point reboot in onder io take affect

Wiraless A
Enable Cualay of Sendce r
065 Manmium Midium Thréihald (50-50 o]
CH y Cancel

Figure 4-41 QoS Policy Sub-Tab

2. To enable QoS, check the Enable Quality of Service checkbox.

3. Configure the QoS Maximum Medium Threshold for all Admission Controls. Admission will be granted if the new
requested traffic stream and already admitted time is less than the medium maximum threshold.
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4. To add a QoS Policy, click the Add button in the “QoS Policies Table” box. The Add Entries box appears.

Syslem \ Netwark \ Interfaces \ Managemant \ Flltering -\

Alarms Bridga OIS 1_ RADIUS Frofiles \ SSIDALANIS ecurily 1
€
Qo5 Policies Table - Add Entries

This page |s used 1o ereate OosS Policies. By defaull when adding a QoS policy, all 5 005 policy types are sdded.
For Layer 2 policies, n pricnty mapping index from the 802.4p to 80240 mapping table should be specthied. For
Layer 3 paolicies, a priarity mapping index from the 832.1p to IP DECF mapping table should be specified. No
prionly mapping index is needed for Speciralink QoS policy Types. You can sleo enable o disable 005 marking
on sach policy type and enalile of disable the different Typ=os.

Naote: Ghanges [0 these parameiers requine #ccess paint reboot in onder to take effect
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Frionty Mapping Index
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Policy Name
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Frictity Mapping Index

Enabile QoS Warking |
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Priority Mapping Index [
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Pricrity Mapping Index
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Policy Mame
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Enable QoS Marking r
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Figure 4-42 Add QoS Policy

5. Enter the Policy Name.
6. Select the Policy Type:

inlayer2: inbound traffic direction, Layer 2 traffic type
inlayer3: inbound traffic direction, Layer 3 traffic type
outlayer2: outbound traffic direction, Layer 2 traffic type
outlayer3: inbound traffic direction, Layer 3 traffic type
spectralink: SpectralLink traffic

7. Enter the Priority Mapping Index.

For layer 2 policies, an index from the 802.1p to 802.1d mapping table should be specified. For layer 3 policies, an
index from the 802.1p to IP DSCP mapping table should be specified. No mapping index is required for SpectraLink.

8. Select whether to Enable QoS Marking.
9. Click OK.
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Priority Mapping

Use this page to configure QoS 802.1p to 802.1d priority mappings (for layer 2 policies) and IP DSCP to 802.1d priority
mappings (for layer 3 policies). The first entry in each table contains the recommended priority mappings. Custom entries
can be added to each table with different priority mappings.

1. Click Configure > QoS > Priority Mapping.

Syslem 1 Networi \ Inedaces \ Kanagement \ Filtering 1
Alams Aridge QoS \ RADILIS Frofiles \ SSIDNLANISecty \
Policy \__ ebca
This page is used to configure GoS 60210 1o B02.1p prionity mappengs and 802.10 To IP DSCP pricrity
mappings. The first entry in each table containg the recommended priority mappings and cannot
be deleted. Custom entries can be added to each table with different priosity mappings.
802.1D to 802.1p Priority Mapping Table
Add Edit
Index BDZ.1D Prigsity 802.1p Priority Slatus
1 o 0 Enable
1 1 1 Enabile
1 2 2 Enable
1 3 3 Enabila
1 4 4 Enabila
1 5 5 Enable
1 B B Enable
1 T T Enabile
802.1D to IP DSCP Priority Mapping Table
Add Edit
Index B02.1D Priority IP DSCP Ramnge Status
1 1 0.7 Enable
1 1 B.15 Enable
1 2 16.23 Enable
1 3 24.31 Enahble
1 4 32.39 Enable
1 8 4047 Enable
1 6 4865 Enahble
1 [ 56.63 Enable

Figure 4-43 Priority Mapping
2. Click Add in the 802.1p and 802.1d priority mapping table.
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Figure 4-44 Add Priority Mapping Entry

Select the 802.1p Priority (from 0-7) for 802.1d Priorities 0-7.
Click OK.

Click Add in the IP Precedence/DSCP ranges and 802.1d Priority table.
Select the IP DSCP Range for each 802.1d Priority.
7. Click OK.

o o~ w

NOTE: Changes to Priority Mapping require a reboot of the AP to take effect.

Enhanced Distributed Channel Access (EDCA)

WME uses Enhanced Distributed Channel Access, a prioritized CSMA/CA access mechanism used by WME-enabled
clients/AP in a WME enabled BSS to realize different classes of differentiated Channel Access.

A wireless Entity is defined as all wireless clients and APs in the wireless medium contending for the common wireless
medium. EDCA uses a separate channel access function for each of the Access Categories (Index) within a wireless
entity. Each channel access function in a wireless entity that contends for the wireless medium as if it were a separate
client contending for the wireless medium. Different channel access functions in a given Wireless Entity contend among
themselves for access to the wireless medium in addition to contending with other clients.

STA EDCA Table and AP EDCA Table

This page is used to configure the client (STA) and AP Enhanced Distributed Channel Access (EDCA) parameters. You
can modify the EDCA values.

The EDCA parameter set provides information needed by the client stations for proper QoS operation during the wireless
contention period. These parameters are used by the QoS enabled AP to establish policy, to change policies when
accepting new stations or new traffic, or to adapt to changes in the offered load. The EDCA parameters assign priorities

to traffic types where higher priority packets gain access to the wireless medium more frequently than lower priority
packets.

NOTE: Default recommended values for EDCA parameters have been defined; Proxim recommends not modifying
EDCA parameters unless strictly necessary.
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Perform the following procedure to configure the Station and AP EDCA tables.

1. Click Configure > QoS > EDCA.

System \ Network \ Interfaces \ Management \ Filtering
Alarms Bridge QoS \ RADIUS Profiles ', SSIDVLAN/Security §
Policy Priority Mapping EDCA \

This page is used to configure the client (STA) and AP Enhanced Distributed Channel Access (EDCA)
parameters. You can modify the EDCA values for both Viireless A and Wireless B (when applicable).
The EDCA parameter set provides information needed by the client stations for proper QoS
operation during the wireless contention period. These parameters are used by the QoS enabled
AP to establish policy, to change policies when accepting new stations or new traffic, or to adapt to
changes in the offered load. The EDCA parameters assign priorities to traffic types where higher
priority packets gain access to the wireless medium more frequently than lower priority packets.
Note: We have defined default recommended values for EDCA parameters; we recommend not
modifying EDCA parameters unless strictly necessary.

STAEDCA Table
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Figure 4-45 EDCA Tables

2. Click Edit and configure the following parameters in each table:

NOTE: Changes to EDCA parameters require a reboot of the AP to take effect.

Index: read-only. Indicates the index of the Access Category (1-4) being defined:

— 1 = Best Effort
— 2= Background
— 3 =Video

— 4 =Voice

CWMin: minimum Contention Window. Configurable range is 0 to 255.

CWMax: maximum Contention Window. Configurable range is 0 to 65535.
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» AIFSN: Arbitration IFS per access category. Configurable range is 2 to 15.

* Tx OP Limit: The Transmission Opportunity Limit. The Tx OP is an interval of time during which a particular QoS
enhanced client has the right to initiate a frame exchange sequence onto the wireless medium. The Tx OP Limit
defines the upper limit placed on the value of Tx OP a wireless entity can obtain for a particular access category.
Configurable range is 0 to 65535.

» MSDU Lifetime: specifies the maximum elapsed time between a MSDU transfer request and delivery to the
destination, beyond which delivery becomes unnecessary. Configurable range is 0 to 500 seconds.

* Admission Control Mandatory: Possible values are True or False. Admission control defines if an Access Point
accepts or rejects a requested traffic stream with certain QoS specifications, based on available channel capacity
and link conditions. Admission control can be configured for each Access Category (Index).

On the Policy sub-tab, the user can also configure a medium maximum threshold for all Admission Controls.
Admission will be granted if the new requested traffic stream and already admitted time is less than the medium
maximum threshold.
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Radius Profiles

Configuring Radius Profiles on the AP allows the administrator to define a profile for RADIUS Servers used by the system
or by a VLAN. The network administrator can define RADIUS Servers per Authentication Mode and per VLAN.

The AP communicates with the RADIUS server defined in a profile to provide the following features:

¢« MAC Access Control Via RADIUS Authentication
+ 802.1x Authentication using RADIUS
* RADIUS Accounting

Also, RADIUS Based Management Access allows centralized user management.

The network administrator can configure default RADIUS authentication servers to be used on a system-wide basis, or in
networks with VLANs enabled the administrator can also configure separate authentication servers to be used for MAC
authentication, EAP authentication, or Accounting in each VLAN. You can configure the AP to communicate with up to six
different RADIUS servers per VLAN/SSID:

* Primary Authentication Server (MAC-based authentication)

» Back-up Authentication Server (MAC-based authentication)

* Primary Authentication Server (EAP/802.1x authentication)

» Back-up Authentication Server (EAP/802.1x authentication)

* Primary Accounting Server

» Back-up Accounting Server

The back-up servers are optional, but when configured, the AP will communicate with the back-up server if the primary
server is off-line. After the AP has switched to the backup server, it will periodically check the status of the primary
RADIUS server every five (5) minutes. Once the primary RADIUS server is again online, the AP automatically reverts

from the backup RADIUS server back to the primary RADIUS server. All subsequent requests are then sent to the
primary RADIUS server.

You can view monitoring statistics for each of the configured RADIUS servers.

RADIUS Servers per Authentication Mode and per VLAN

The user can configure separate RADIUS authentication servers for each authentication mode and for each SSID
(VLAN). For example:
« The user can configure separate RADIUS servers for RADIUS MAC authentication and 802.1x authentication

» The user can configure separate RADIUS servers for each VLAN: VLAN1 could support only WEP clients, whereas
VLAN2 could support 802.1x and WEP clients.

VLAN 1 Authentication

WLAN 1
Authentication

RADIUS
Switch Server

Access Point

- =

VLAN 2 Authentication

VLAN 2

Authentication RADILS

Server

Figure 4-46 RADIUS Servers per VLAN
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This figure shows a network with separate authentication servers for each authentication type and for each VLAN. The
clients in VLAN 1 are authenticated using the authentication servers configured for VLAN 1. The type of authentication
server used depends on whether the authentication is done for an 802.1x client or a non-802.1x client. The clients in

VLAN 2 are authenticated using a different set of authentication servers configured for authenticating users in VLAN 2.

Authentication servers for each VLAN are configured as part of the configuration options for that VLAN. RADIUS profiles
are independent of VLANs. The user can define any profile to be the default and associate all VLANSs to that profile. Four
profiles are created by default, “MAC Authentication”, “EAP Authentication”, Accounting”, and “Management”.

RADIUS Servers Enforcing VLAN Access Control

A RADIUS server can be used to enforce VLAN access control in two ways:

» Authorize the SSID the client uses to connect to the AP. The SSID determines the VLAN that the client gets assigned

to.

» Assigning the user to a VLAN by specifying the VLAN membership information of the user.

Configuring Radius Profiles

A RADIUS server Profile consists of a Primary and a Secondary RADIUS server that get assigned to act as either MAC
Authentication servers, 802.1x/EAP Authentication servers, or Accounting Servers in the VLAN Configuration. See

Configuring Security Profiles.

The RADIUS Profiles tab allows you to add new RADIUS profiles or modify or delete existing profiles.

System L Network \1‘
Alarms Bridge
RADIUS Frofile. % PXUProfiles i

Interfaces

QoS

\

Management \ Filtering

This page is used to configure the RADIUS Server Profiles. A RADIUS server Profile consists

of a Primary and a Secondary RADIUS server.

The RADIUS server profiles created on this page will be assigned to act as MAC
authentication / EAP authentication ! Accounting server in the 55ID configuration

Click on "ADD" to create a new profile. To Modify an exisiting profile, select the profile and
click "Edit". To Delete an existing profile select the profile and click "Delete".

Note: Changes to the RADIUS Server Profiles will not require & reboot of the device.

Add Edi

Delete

Index ProfileName
MAC Authentication

EAP Authentication
Accounting

Xy DG
FS TR (S Y

Management Access

Figure 4-47 RADIUS Server Profiles

Primary Status

Adding or Modifying a RADIUS Server Profile

Perform the following procedure to add a RADIUS server profile and to configure its parameters.

F

Secondary Status

AN ssIDvLANISecurity )

1. Click Add to create a new profile. To Modify an existing profile, select the profile and click Edit. To delete an existing
profile, select the profile and click Delete. You cannot delete a RADIUS server profile if it is applied to an SSID.

2. Configure the following parameters for the RADIUS Server profile (see Figure 4-48):
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NOTE: This page configures only the Primary RADIUS Server associated with the profile. After configuring these
parameters, save them by clicking OK. Then, to configure the Secondary RADIUS Server, edit the profile from

the main page.

Sygiem 1 Mebwork ‘k nenaces 1 Management 1. Fillering

Alanms Bridge Qos

This page is used to adit the selactad RADIUS Sarver Profile. A RADUE server Profile consists of a
Primary and a Secondary RADIUE server

Node: Chamges fo ive RADIUS Server Profiles will mod regeiire 8 reboot of the odevice,
DNS i3 . For configuring server names in the RADNUS profile, enable first.
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Figure 4-48 Add RADIUS Server Profile

Server Profile Name: the profile name. This is the name used to associated a VLAN to the profile. See
Configuring Security Profiles. The Server Profile Name is also used in the Configure > Management > Services

page to specify the RADIUS profile to be used for RADIUS Based Management Access.

MAC Address Format Type: This parameter should correspond to the format in which the clients’ 12-digit MAC
addresses are listed within the RADIUS server and the way passwords are sent to the RADIUS server. Available

options are:

— Dash delimited/SS: MAC addresses are formatted with a dash between each pair of digits (xx-yy-zz-aa-bb),

and the password sent to the RADIUS server is the shared secret (configured below).

— Colon delimited/SS: MAC addresses are formatted with a colon between each pair of digits (xx:yy:zz:aa:bb:cc)

and the password sent to the RADIUS server is the shared secret (configured below).

— Single dash delimited/SS: MAC addresses are formatted with a dash between the sixth and seventh digits
(xxyyzz-aabbcc) and the password sent to the RADIUS server is the shared secret (configured below).

— No delimiters/SS: MAC addresses are formatted with no characters or spaces between pairs of hexadecimal
digits (xxyyzzaabbcc) and the password sent to the RADIUS server is the shared secret (configured below).

— Dash delimited/MAC: MAC addresses are formatted with a dash between each pair of digits (xx-yy-zz-aa-bb),

and the password sent to the RADIUS server is the MAC address of the client.
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— Colon delimited/MAC: MAC addresses are formatted with a colon between each pair of digits
(xx:yy:zz:aa:bb:cc) and the password sent to the RADIUS server is the MAC address of the client.

— Single dash delimited/MAC: MAC addresses are formatted with a dash between the sixth and seventh digits
(xxyyzz-aabbcc) and the password sent to the RADIUS server is the MAC address of the client.

— No delimiters/MAC: MAC addresses are formatted with no characters or spaces between pairs of hexadecimal
digits (xxyyzzaabbcc) and the password sent to the RADIUS server is the MAC address of the client.

Accounting update interval: Enter the time interval (in minutes) for sending Accounting Update messages to the
RADIUS server. A value of 0 (default) means that the AP will not send Accounting Update messages.

Accounting inactivity timer: Enter the accounting inactivity timer. This parameter supports a value from 1-60
minutes. The default is 5 minutes.

Authorization lifetime: Enter the time, in seconds, each client session may be active before being automatically
re-authenticated. This parameter supports a value between 900 and 43200 seconds. The default is 0 (disabled).

Server Addressing Format: select IP Address or Name. If you want to identify RADIUS servers by name, you
must configure the AP as a DNS Client. See DNS Client for details.

Server Name/IP Address: Enter the server’s name or IP address.

Destination Port: Enter the port number which the AP and the server will use to communicate. By default,
RADIUS servers communicate on port 1812.

Server VLAN ID: Indicates the VLAN that uses this RADIUS server profile. If VLAN is disabled, this field will be
grayed out.

Shared Secret and Confirm Shared Secret: Enter the password shared by the RADIUS server and the AP. The
same password must also be configured on the RADIUS server. The default password is “public.”

Response Time (seconds): Enter the maximum time, in seconds, that the AP should wait for the RADIUS server
to respond to a request. The range is 1-10 seconds; the default is 3 seconds.

Maximum Retransmissions (0-4): Enter the maximum number of times an authentication request may be
transmitted. The range is 0 to 4, the default is 3.

Server Status: Select Enable from the drop-down box to enable the RADIUS Server Profile.

Click OK.
Select the Profile and click Edit to configure the Secondary RADIUS Server, if required.

MAC Access Control Via RADIUS Authentication

If you want to control wireless access to the network and if your network includes a RADIUS Server, you can store the list
of MAC addresses on the RADIUS server rather than configure each AP individually. You can define a RADIUS Profile
that specifies the IP Address of the server that contains a central list of MAC Address values identifying the authorized
stations that may access the wireless network. You must specify information for at least the primary RADIUS server. The
back-up RADIUS server is optional.

NOTE: Each VLAN can be configured to use a separate RADIUS server (and backup server) for MAC authentication.

MAC access control can be separately enabled for each VLAN.

NOTE: Contact your RADIUS server manufacturer if you have problems configuring the server or have problems using

RADIUS authentication.

802.1x Authentication using RADIUS

You must configure a primary EAP/802.1x Authentication server to use 802.1x security. A back-up server is optional.

NOTE: Each VLAN can be configured to use a separate RADIUS server (and backup server) for 802.1x authentication.

802.1x authentication (“EAP authentication”) can be separately enabled for each VLAN.
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RADIUS Accounting

Using an external RADIUS server, the AP can track and record the length of client sessions on the access point by
sending RADIUS accounting messages per RFC2866. When a wireless client is successfully authenticated, RADIUS
accounting is initiated by sending an “Accounting Start” request to the RADIUS server. When the wireless client session
ends, an “Accounting Stop” request is sent to the RADIUS server.

NOTE: Each VLAN can be configured to use a separate RADIUS accounting server (and backup accounting server).

Session Length
Accounting sessions continue when a client reauthenticates to the same AP. Sessions are terminated when:

* A client disassociates.

» A client does not transmit any data to the AP for a fixed amount of time.

» Aclient is detected on a different interface.

» |dle-Timeout or Session-Timeout attributes are configured in the Radius server.

If the client roams from one AP to another, one session is terminated and a new session is begun.

NOTE: This feature requires RADIUS authentication using MAC Access Control or 802.1x. Wireless clients configured in
the Access Point’s static MAC Access Control list are not tracked.

Authentication and Accounting Attributes

Additionally, the AP supports a number of Authentication and Accounting Attributes defined in RFC2865, RFC2866,
RFC2869, and RFC3580.

Authentication Attributes

+ State: Received in Access-Accept Packet by the AP during Authentication and sent back as-is during
Re-Authentication.

» Class: Received in Access-Accept Packet by the AP during Authentication and back as in Accounting Packets.

» Session-Timeout

— If the RADIUS server does not send a Session-Timeout, the AP will set the subscriber expiration time to 0, which
means indefinite access.

— The Termination Action attribute defines how the Session-Timeout attribute will be interpreted. If the Termination
Action is DEFAULT, then the session is terminated on expiration of the Session-Timeout time interval. If
Termination Action is RADIUS-Request, then re-authentication is done on expiration on the session.

— If the RADIUS server sends a Session-Timeout, the value specified by the Session-Timeout attribute will take
precedence over the configured Authorization Lifetime value.

¢ Termination-Action

— Valid values are: Default (0), RADIUS-Request (1). When the value is “default,” the Termination-Action attribute
sends an accounting stop message and then reauthenticates. If the value is “RADIUS-Request,” the
Termination-Action attribute reauthenticates without sending an accounting stop.

¢ |dle Timeout

— The AP internally maintains the Idle-Timeout attribute obtained for each of the users during their authentication
process, and uses this time interval in place of accounting inactivity time for timing out clients.

» Calling Station Id
— MAC address of the client being authenticated.
» Called Station Id

— The AP sends the MAC address of its own wireless interface with which the client getting authenticated is getting
associated, appended with the SSID. If VLAN is enabled, the SSID and corresponding VLAN ID get appended.

¢ Acct-Interim-Interval
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— Obtained during the Authentication process and used for determining the time interval for sending Accounting
Update messages.

— This attribute value takes precedence over the value of the Accounting Update Interval.

Accounting Attributes

Acct-Delay-Time

— Indicates how many seconds the AP has been trying to send a particular packet related to a particular user. This
time can be used at the server to determine the approximate time of the event generating this accounting request.

Acct-Session-Id

— Unique accounting ID that aids in tracking client accounting records. This attribute is sent in Start and Stop
RADIUS accounting messages, and contains the client MAC address appended with the unique session ID.

Acct-Session-Time

— Acct-Session-Time is calculated the following way (for each transmitted/retransmitted Acct-Stop):
Acct-Session-Time = time of last sent packet - subscriber login time.

Acct-Input-Octets

— Number of octets (bytes) received by subscriber.
Acct-Output-Octets

— Number of octets (bytes) sent by subscriber.
Acct-Input-Packets

— Number of packets received by subscriber.
Acct-Output-Packets

— Number of packets sent by subscriber.
Acct-Terminate Cause

— Indicates how the session was terminated.
Vendor Specific Attributes
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The ProximUnify enables VLAN roaming for both data and voice clients. VLAN roaming support is required when a client
device roams between APs connected to switches with different VLANs configured.

Figure 4-49 illustrates a scenario in which VLAN roaming is used. Clients connected to AP 1, which supports VLANs A
and B, roam to AP 2, which supports VLANs X and Y. When this occurs, AP 2 communicates with the ProximUnify to
establish a data path, and then tunnels the packets to/from those clients back to AP 1.

Communication between ProximUnify Modules and registered Access Points is secured using Diffie-Hellman for
authentication and RC4 for encryption.
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Figure 4-49 VLAN Roaming Example

Wireless Domain Configuration

In order for the AP and ProximUnify to work together to support VLAN roaming, the administrator must first configure a
ProximUnify profile and enable VLAN capabilities on the AP. For more information on ProximUnify configuration and
management, refer to the ProximUnify User Guide.

A ProximUnify Module can act as a Master, a Backup-Master, or a Client. A wireless domain can support only one Master
and one Backup-Master ProximUnify Module, and up to 30 Client ProximUnify Modules. All ProximUnify Modules,
regardless of their roles, communicate with APs as outlined above. In addition, Master, Backup-Master, and Client
ProximUnify Modules have the following responsibilities in the wireless network:

Master ProximUnify:

Registers Backup-Master ProximUnify Modules
Registers Client ProximUnify Modules

Maintains relevant wireless domain information
Manages mobility information for the wireless domain
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— Manages mobility connections between Client ProximUnify Modules
» Backup-Master ProximUnify:

— Registers with the Master ProximUnify

— Maintains relevant wireless domain information

— Assumes the role of the Master ProximUnify in case the Master ProximUnify stops functioning
» Client ProximUnify Modules:

— Register with a Master/ Backup-Master ProximUnify

— Update the Master or Backup-Master with mobility information

Configuring the ProximUnify Profile
The PXU Profile tab allows you configure the IP address and select the server status to enable or disable the profile.

The PXU Server Profile consists of two servers, a Primary and a Secondary. Configuring PXU Profiles on the AP allows
the administrator to define a profile for PXU Servers used by the system or by a VLAN.

System \ Network \ Interfaces \ Management \ Filtering
Alarms Bridge QoS ' \ SSIDVLANSecurty |
Slatus —
RADIUS Profile - - |

This page is used to configure the PXU Server Profiles. A PXU server Profile consists of a
Primary and a Secondary PXU server.

Manitor Note: Changes to tha PXU Server Profiles require access point raboot in order to take effect.
Commands
Server Parameter Primary Secondary
Help PXU IP Address 0000 0.0.0.0
Domain Name [etaur Detault
_ Shared Secret =0 |essses [casess
Exit . !
Confirm Shared Secret seanes snssen
[2 [2
Reboot 2 3

Disable LJ | Dizable LI

s Staf o
Server Status

Ok Cancel
o

Figure 4-50 PXU Server Profile

To configure the PXU Profile, click Configure>Radius/PXU Profiles>PXU Profile. The PXU Profile page appears.
Following are the configurable fields to set up the PXU Profile to function.

1. PXU IP Address: Enter the IP address. The default is 0.0.0.0.

2. Domain Name: Enter the name of the domain.

3. Shared Secret/ Confirm Shared Secret: Enter the password shared by the PXU server and the AP. The same
password must also be configured on the PXU server. The default password is “public.”

4. Response Time: Enter the maximum time, in seconds, that the AP should wait for the PXU server to respond to a
request. The range is 1-10 seconds; the default is 3 seconds.

5. Retransmission: Enter the maximum number of times an authentication request may be transmitted. The range
is 0 to 4, the default is 3.
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6. Server Status: Select Enable from the drop-down box to enable the PXU Server Profile.
Click OK.
To reset your configuration, click Cancel.

NOTE: Changes to the PXU Server Profiles require access point reboot in order to take effect.
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SSID/VLAN/Security

The AP provides several security features to protect your network from unauthorized access. This section gives an
overview of VLANs and then discusses the SSID/VLAN/Security configuration options in the AP:

* VLAN Overview

* Management VLAN

» Security Profile

* MAC Access

*  Wireless

The AP also provides Broadcast Unique Beacon/Closed System and Rogue Scan to protect your network from
unauthorized access. See the Wireless and Rogue Scan sections from more information.

VLAN Overview

Virtual Local Area Networks (VLANS) are logical groupings of network hosts. Defined by software settings, other VLAN
members or resources appear (to clients) to be on the same physical segment, no matter where they are attached on the
logical LAN or WAN segment. They simplify traffic flow between clients and their frequently-used or restricted resources.

VLANSs now extend as far as the reach of the access point signal. Clients can be segmented into wireless sub-networks
via SSID and VLAN assignment. A Client can access the network by connecting to an AP configured to support its
assigned SSID/VLAN.

AP devices are fully VLAN-ready; however, by default VLAN support is disabled. Before enabling VLAN support, certain
network settings should be configured, and network resources such as a VLAN-aware switch, a RADIUS server, and
possibly a DHCP server should be available.

Once enabled, VLANSs are used to conveniently, efficiently, and easily manage your network in the following ways:

* Manage adds, moves, and changes from a single point of contact
» Define and monitor groups
* Reduce broadcast and multicast traffic to unnecessary destinations

— Improve network performance and reduce latency
* Increase security

— Secure network restricts members to resources on their own VLAN

— Clients roam without compromising security
VLAN tagged data is collected and distributed through an AP's wireless interface(s) based on Network Name (SSID). An
Ethernet port on the access point connects a wireless cell or network to a wired backbone. The access points
communicate across a VLAN-capable switch that analyzes VLAN-tagged packet headers and directs traffic to the
appropriate ports. On the wired network, a RADIUS server authenticates traffic and a DHCP server manages IP

addresses for the VLAN(s). Resources like servers and printers may be present, and a hub may include multiple APs,
extending the network over a larger area.
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Figure 4-51 Components of a Typical VLAN

VLAN Workgroups and Traffic Management

Access Points that are not VLAN-capable typically transmit broadcast and multicast traffic to all wireless Network
Interface Cards (NICs). This process wastes wireless bandwidth and degrades throughput performance. In comparison,
a VLAN-capable AP is designed to efficiently manage delivery of broadcast, multicast, and unicast traffic to wireless
clients.

The AP assigns clients to a VLAN based on a Network Name (SSID). The AP can support up to 16 SSIDs per radio, with
a unique VLAN configurable per SSID.

The AP matches packets transmitted or received to a network name with the associated VLAN. Traffic received by a
VLAN is only sent on the wireless interface associated with that same VLAN. This eliminates unnecessary traffic on the
wireless LAN, conserving bandwidth and maximizing throughput.

In addition to enhancing wireless traffic management, the VLAN-capable AP supports easy assignment of wireless users
to workgroups. In a typical scenario, each user VLAN represents a workgroup; for example, one VLAN could be used for
an EMPLOYEE workgroup and the other for a GUEST workgroup.

In this scenario, the AP would assign every packet it accepted to a VLAN. Each packet would then be identified as
EMPLOYEE or GUEST, depending on which wireless NIC received it. The AP would insert VLAN headers or “tags” with
identifiers into the packets transmitted on the wired backbone to a network switch.

Finally, the switch would be configured to route packets from the EMPLOYEE workgroup to the appropriate corporate
resources such as printers and servers. Packets from the GUEST workgroup could be restricted to a gateway that
allowed access to only the Internet. A member of the GUEST workgroup could send and receive e-mail and access the
Internet, but would be prevented from accessing servers or hosts on the local corporate network.

Typical User VLAN Configurations

VLANs segment network traffic into workgroups, which enable you to limit broadcast and multicast traffic. Workgroups
enable clients from different VLANSs to access different resources using the same network infrastructure. Clients using the
same physical network are limited to those resources available to their workgroup.

The AP can segment users into a maximum of 16 different workgroups, based on an SSID/VLAN grouping (also referred
as a VLAN Workgroup or a Sub-network).

NOTE: VLAN must be enabled to configure security per SSID.
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VLAN Tagging Management

Control Access to the AP

Management access to the AP can easily be secured by making management stations or hosts and the AP itself
members of a common VLAN. Simply configure a non-zero management VLAN ID and enable VLAN to restrict
management of the AP to members of the same VLAN.

CAUTION: If a non-zero management VLAN ID is configured then management access to the AP is restricted to wired
or wireless hosts that are members of the same VLAN. Ensure your management platform or host is a
member of the same VLAN before attempting to manage the AP.

NOTE: When VLAN is enabled, ensure that all devices in the network share the same VLAN ID.

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.
2. Set the VLAN Management ID to a value of between 1 and 4094. (A value of -1 disables VLAN Tagging).
3. Place a check mark in the Enable VLAN Tagging box.

Provide Access to a Wireless Host in the Same Workgroup

The VLAN feature can allow wireless clients to manage the AP. If the VLAN Management ID matches a VLAN User ID,
then those wireless clients who are members of that VLAN will have AP management access.

CAUTION: Once a VLAN Management ID is configured and is equivalent to one of the VLAN User IDs on the AP, all
members of that User VLAN will have management access to the AP. Be careful to restrict VLAN
membership to those with legitimate access to the AP.

NOTE: When VLAN is enabled, ensure that all devices in the network share the same VLAN ID.

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.
2. Set the VLAN Management ID to use the same VLAN ID as one of the configured SSIDs.
3. Place a check mark in the Enable VLAN Tagging box.
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Disable VLAN Tagging

1. Click Configure > SSID/VLAN/Security > Mgmt VLAN.
2. Remove the check mark from the Enable VLAN Tagging box (to disable all VLAN functionality) or set the VLAN
Management ID to -1 (to disable VLAN Tagging only).

NOTE: If you disable VLAN Tagging, you will be unable to configure security per SSID.

Security Profile
See the following sections:

» Security Features

* Authentication Protocol Hierarchy
* VLANSs and Security Profiles

* Configuring Security Profiles

Security Features
The AP supports the following security features:

*  WEP Encryption: The original encryption technique specified by the IEEE 802.11 standard.
» 802.1x Authentication: An IEEE standard for client authentication.
* Wi-Fi Protected Access (WPA/802.11i [WPAZ2]): A new standard that provides improved encryption security over WEP.

NOTE: The AP does not support shared key 802.11 MAC level authentication. Clients with this MAC level feature must
disable it.

WEP Encryption

The IEEE 802.11 standards specify an optional encryption feature, known as Wired Equivalent Privacy or WEP, that is
designed to provide a wireless LAN with a security level equal to what is found on a wired Ethernet network. WEP
encrypts the data portion of each packet exchanged on an 802.11 network using an Encryption Key (also known as a
WEP Key).

When Encryption is enabled, two 802.11 devices must have the same Encryption Keys and both devices must be
configured to use Encryption in order to communicate. If one device is configured to use Encryption but a second device
is not, then the two devices will not communicate, even if both devices have the same Encryption Keys.

802.1x Authentication

IEEE 802.1x is a standard that provides a means to authenticate and authorize network devices attached to a LAN port.
A port in the context of IEEE 802.1x is a point of attachment to the LAN, either a physical Ethernet connection or a
wireless link to an Access Point. 802.1x requires a RADIUS server and uses the Extensible Authentication Protocol
(EAP) as a standards-based authentication framework, and supports automatic key distribution for enhanced security.
The EAP-based authentication framework can easily be upgraded to keep pace with future EAP types.

Popular EAP types include:
+ EAP-Message Digest 5 (MD5): Username/Password-based authentication; does not support automatic key
distribution

» EAP-Transport Layer Security (TLS): Certificate-based authentication (a certificate is required on the server and each
client); supports automatic key distribution

» EAP-Tunneled Transport Layer Security (TTLS): Certificate-based authentication (a certificate is required on the
server; a client’'s username/password is tunneled to the server over a secure connection); supports automatic key
distribution

* PEAP - Protected EAP with MS-CHAP: Secure username/password-based authentication; supports automatic key
distribution
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Different servers support different EAP types and each EAP type provides different features. See the documentation that
came with your RADIUS server to determine which EAP types it supports.

NOTE: The AP supports the following EAP types when Security Mode is set to 802.1x, WPA, or 802.11i (WPA2):
EAP-TLS, PEAP, EAP-TTLS, EAP-MD5, and EAP-SIM.

Authentication Process

There are three main components in the authentication process. The standard refers to them as:

1. Supplicant (client PC)

2. Authenticator (Access Point)
3. Authentication server (RADIUS server)

When the Security Mode is set to 802.1x Station, WPA Station, or 802.11i Station you need to configure your RADIUS
server for authentication purposes.

Prior to successful authentication, an unauthenticated client PC cannot send any data traffic through the AP device to
other systems on the LAN. The AP inhibits all data traffic from a particular client PC until the client PC is authenticated.
Regardless of its authentication status, a client PC can always exchange 802.1x messages in the clear with the AP (the
client begins encrypting data after it has been authenticated).

—
1

Figure 4-53 RADIUS Authentication lllustrated

The AP acts as a pass-through device to facilitate communications between the client PC and the RADIUS server. The
AP (2) and the client (1) exchange 802.1x messages using an EAPOL (EAP Over LAN) protocol (A). Messages sent from
the client station are encapsulated by the AP and transmitted to the RADIUS (3) server using EAP extensions (B).

Upon receiving a reply EAP packet from the RADIUS, the message is typically forwarded to the client, after translating it
back to the EAPOL format. Negotiations take place between the client and the RADIUS server. After the client has been
successfully authenticated, the client receives an Encryption Key from the AP (if the EAP type supports automatic key
distribution). The client uses this key to encrypt data after it has been authenticated.

For 802.11a and 802.11b/g clients that communicate with an AP, each client receives its own unique encryption key; this
is known as Per User Per Session Encryption Keys.
Wi-Fi Protected Access (WPA/802.11i [WPA2])

Wi-Fi Protected Access (WPA) is a security standard designed by the Wi-Fi Alliance in conjunction with the Institute of
Electrical and Electronics Engineers (IEEE). The AP supports 802.11i (WPAZ2), based on the IEEE 802.11i security
standard.

WPA is a replacement for Wired Equivalent Privacy (WEP), the encryption technique specified by the original 802.11
standard. WEP has several vulnerabilities that have been widely publicized. WPA addresses these weaknesses and
provides a stronger security system to protect wireless networks.

WPA provides the following new security measures not available with WEP:

* Improved packet encryption using the Temporal Key Integrity Protocol (TKIP) and the Michael Message Integrity
Check (MIC).

* Per-user, per-session dynamic encryption keys:
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— Each client uses a different key to encrypt and decrypt unicast packets exchanged with the AP
— Adclient's key is different for every session; it changes each time the client associates with an AP
— The AP uses a single global key to encrypt broadcast packets that are sent to all clients simultaneously
— Encryption keys change periodically based on the Re-keying Interval parameter
— WHPA uses 128-bit encryption keys

* Dynamic Key distribution
— The AP generates and maintains the keys for its clients
— The AP securely delivers the appropriate keys to its clients

+ Client/server mutual authentication
— 802.1x
— Pre-shared key (for networks that do not have an 802.1x solution implemented)

The AP supports the following WPA security modes:

*  WPA: The AP uses 802.1x to authenticate clients and TKIP for encryption. You should only use an EAP that supports
mutual authentication and session key generation, such as EAP-TLS, EAP-TTLS, and PEAP. See 802.1x
Authentication for details.

*  WPA-PSK (Pre-Shared Key): For networks that do not have 802.1x implemented, you can configure the AP to
authenticate clients based on a Pre-Shared Key. This is a shared secret that is manually configured on the AP and
each of its clients. The Pre-Shared Key must be 256 bits long, which is either 64 hexadecimal digits or 32
alphanumeric characters. The AP also supports a PSK Pass Phrase option to facilitate the creation of the TKIP
Pre-Shared Key (so a user can enter an easy-to-remember phrase rather than a string of characters).

» 802.11i (also known as WPA2): The AP provides security to clients according to the 802.11i draft standard, using
802.1x authentication, a CCMP cipher based on AES, and re-keying.

» 802.11i-PSK (also known as WPA2 PSK): The AP uses a CCMP cipher based on AES, and encrypts frames to clients
based on a Pre-Shared Key. The Pre-Shared Key must be 256 bits long, which is either 64 hexadecimal digits or 32
alphanumeric characters. The AP also supports a PSK Pass Phrase option to facilitate the creation of the Pre-Shared
Key (so a user can enter an easy-to-remember phrase rather than a string of characters).

NOTE: For more information on WPA, see the Wi-Fi Alliance Web site at http://lwww.wi-fi.org.

Authentication Protocol Hierarchy
There is a hierarchy of authentication protocols defined for the AP. The hierarchy is as follows, from highest to lowest:

» 802.1x authentication (including 802.1x, WPA, WPA-PSK, 802.11i, 802.11i-PSK)

* MAC Access Control via RADIUS Authentication

*  MAC Access Control through individual APs' MAC Access Control Lists

If you have both 802.1x and MAC Access Control authentication enabled, the 802.1x authentication takes precedence

because it is higher in the authentication protocol hierarchy. This is required in order to propagate the WEP/TKIP/AES
keys to the clients in such cases. If you disable 802.1x on the AP, you will see the effects of MAC authentication.

In addition, setting MAC Access Control status to Strict will cause both MAC ACL settings and 802.1x settings to be
applied.

For example, assume that the MAC Access Control List contains MAC addresses to block, and that WPA-PSK is
configured to allow access to clients with the appropriate PSK Passphrase.

» If the MAC ACL status is set to Enable, WPA-PSK will take precedence, and clients in the MAC ACL with the correct
PSK passphrase will be allowed. Only the WPA-PSK setting is taken into consideration.

» If the MAC ACL status is set to Strict, then clients in the MAC ACL will be blocked even if they have the correct PSK
passphrase. Clients will only be allowed if they have the correct passphrase and are NOT listed in the MAC ACL. In
this way, both MAC and WPA-PSK settings are taken into consideration.
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VLANSs and Security Profiles

The AP allows you to segment wireless networks into multiple sub-networks based on Network Name (SSID) and VLAN
membership. A Network Name (SSID) identifies a wireless network. Clients associate with Access Points that share an
SSID. During installation, the Setup Wizard prompts you to configure a Primary Network Name for each wireless
interface.

After initial setup and once VLAN is enabled, the AP can be configured to support up to 16 SSIDs to segment wireless
networks based on VLAN membership.

Each VLAN can associated to a Security Profile and RADIUS Server Profiles. A Security Profile defines the allowed
wireless clients, and authentication and encryption types. See the following sections for configuration details.

Configuring Security Profiles

Security policies can be configured and applied on the AP as a whole, or on a per VLAN basis. When VLAN is disabled
on the AP, the user can configure a security profile for each interface of the AP. When VLANSs are enabled and Security
per SSID is enabled, the user can configure a security profile for each VLAN.

The user defines a security policy by specifying one or more values for the following parameters:

*  Wireless STA types (WPA station, 802.11i (WPA2) station, 802.1x station, WEP station, WPA-PSK, and 802.11i-PSK)
that can associate to the AP.

» Authentication mechanisms (802.1x, RADIUS MAC authentication) that are used to authenticate clients for each type
of station.

» Cipher Suites (CCMP, TKIP, WEP, None) used for encapsulating the wireless data for each type of station.
Up to 16 security profiles can be configured.
1. Click Configure > SSID/VLAN/Security > Security Profile.
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Profile NonSecure WEP B0ZAx  WPA WPAPSH B0Z2.111 PEK

Enabled

Figure 4-54 Security Profile Configuration

2. Click Add in the Security Profile Table to create a new entry. To modify an existing profile, select the profile and click
Edit. To delete an existing profile, select the profile and click Delete. You cannot delete a Security Profile used in an
SSID. Also, the first Security Profile cannot be deleted.
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3. Configure one or more types of wireless stations (security modes) that are allowed access to the AP under the
security profile. The WEP/PSK parameters are separately configurable for each security mode. To enable a security
mode in the profile (Non Secure Station, WEP Station, 802.1x Station, WPA Station, WPA-PSK Station, 802.11i
(WPAZ2) Station, 802.11i-PSK Station), check the box next to the mode. See Figure 4-55.

If the security mode selected in a profile is WEP, WPA-PSK, or 802.11i-PSK, then you must configure the WEP or
Pre-Shared Keys.

NOTE: If an 802.1x client that has already been authenticated attempts to switch to WEP, or if a WEP client that has
already been connected attempts to switch to 802.1x, the AP will not allow the client to switch immediately. If
this happens, either reboot the AP or disable the client/roam to a new AP for five minutes, and then attempt to
reconnect to the AP. If the client is still unable to connect after waiting five minutes, reboot the AP.

4. Configure the parameters as follows for each enabled security mode. See Figure 4-55.
* Non Secure Station:
» Authentication Mode: None. The AP allows access to Stations without authentication.
— Non secure station should be used only with WEP or 802.1x security mode.
» Cipher: None
*  WEP Station:
* Authentication Mode: None
+ Cipher: WEP
« Encryption Key 0, Encryption Key 1, Encryption Key 2, Encryption Key 3

NOTE: When VLAN tagging is enabled, only Key 0 can be configured.

« Encryption Key Length: 64, 128, or 152 Bits.

— For 64-bit encryption, an encryption key is 10 hexadecimal characters (0-9 and A-F) or 5 ASCII characters
(see ASCII Character Chart).

— For 128-bit encryption, an encryption key is 26 hexadecimal characters or 13 ASCII characters.
— For 152-bit encryption, an encryption key is 32 hexadecimal characters or 16 ASCII characters.
* Encryption Transmit Key: select Key 0, Key 1, Key 2, or Key 3

NOTE: When VLAN tagging is enabled, only Key 0 can be configured.

+ 802.1x Station:
* Authentication Mode: 802.1x
* Cipher: WEP
+ Encryption Key Length: 64 or 128 Bits.

— 1f 802.1x is enabled simultaneously with WEP, the 802.1x Station’s encryption key length is determined by
the WEP encryption key.

*  WPA Station:
* Authentication Mode: 802.1x
+ Cipher: TKIP
+  WPA-PSK Station:
* Authentication Mode: PSK
* Cipher: TKIP

+ PSK Passphrase: an 8-63 character user-defined phrase. It is recommended a passphrase of at least 13
characters, including both letters and numbers, and upper and lower case characters, be used to ensure that
the generated key cannot be easily deciphered by network infiltrators.

« 802.11i Station:
« Authentication Mode: 802.1x
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+ Cipher: CCMP based on AES
* 802.11i-PSK Station:

* Authentication Mode: PSK

* Cipher: CCMP based on AES

+ PSK Passphrase: an 8-63 character user-defined phrase. It is recommended a passphrase of at least 13
characters, including both letters and numbers, and upper and lower case characters, to ensure that the
generated key cannot be easily deciphered by network infiltrators.

5. When finished configuring all parameters, click OK.

6. If you selected a Security Mode of 802.1x Station, WPA Station, or 802.11i Station, you must configure a RADIUS
802.1x/EAP server. See the Configuring Radius Profiles section.

Security Profile 1 will be used by default for all wireless interfaces.
7. Reboot the AP.
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Figure 4-55 Security Profile Table - Add Entries
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MAC Access

The MAC Access sub-tab allows you to build a list of stations, identified by their MAC addresses, authorized to access
the network through the AP. The list is stored inside each AP within your network. Note that you must reboot the AP for
any changes to the MAC Access Control Table to take effect. Up to 1000 entries can be made in the table.

The “MAC ACL Status” parameter (configurable on the SSID/VLAN/Security > Wireless sub-tab) is per VLAN if VLAN
Management is enabled. All other parameters besides “MAC ACL Status” are configured per AP, even if VLAN is
enabled.

The following list details the configurable MAC Access parameters.

NOTE: MAC Access Control status is controlled on the SSID/VLAN/Security > Wireless sub-tab. When set to Strict,
changes to the MAC ACL table will take effect immediately with a unit reboot. When not set to Strict, changes will
not take effect until the unit is rebooted.

* Operation Type: Choose between Passthru and Block. This determines how the stations identified in the MAC
Access Control Table are filtered.
— If set to Passthru, only the addresses listed in the Control Table will pass through the bridge.
— If set to Block, the bridge will block traffic to or from the addresses listed in the Control Table.

*» MAC Access Control Table: Click Add to create a new entry. Click Edit to change an existing entry. Each entry
contains the following field:

— MAC Address: Enter the wireless client's MAC address.

— Comment: Enter an optional comment such as the client’s name.

— Status: The entry is enabled automatically when saved (so the Status field is only visible when editing an entry).
You can also disable or delete entries by changing this field’s value.

NOTE: For larger networks that include multiple Access Points, you may prefer to maintain this list on a centralized
location using the MAC Access Control Via RADIUS Authentication.
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gl ¥LAN Sacurity Frofila “1 Wingless 1
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MAC Addresses. Wiith the ntroduction of the Security per 5500 feature MAC access
control status is now configured in the 55| A Security page.

Note: Changed to thopo DAramMelor requine accots point rebood in order fo take offoct,

Oparation Type |-'--wr‘r- L
(]} J Cancal J

MAC Access Control Table

Add ] Edi J

MAL Address Lomment Slatus

Figure 4-56 MAC Access Configuration Screen
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Wireless

Each SSID can have its own Security Profile that defines its security mode, authentication mechanism, and encryption,
so that customers can have multiple types of clients (non-WEP, WEP, 802.1x, WPA, WPA-PSK, 802.11i, 802.11i-PSK) on
the same system separated per VLAN. See the Security Profile section for more information. Each SSID can support a
unique VLAN. In order for the AP to support multiple SSID/VLANs, VLAN Tagging must be enabled. These parameters
are configurable on the Wireless screens.

Configuring an SSID/VLAN with VLAN Tagging Disabled

With VLAN tagging disabled (from the SSID/VLAN/Security > Mgmt VLAN tab), only one SSID can be configured. All
parameters set on the Wireless tab will be applied to that SSID.

1. Click SSID/VLAN/Security > Wireless.
The SSID, VLAN, and Security Configuration page is displayed.
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Qi Cancal '
Figure 4-57 SSID, VLAN, and Security Configuration (VLAN Tagging Disabled)

2. Enable or disable RADIUS accounting on the VLAN/SSID by selecting Enable or Disable from the Accounting
Status drop-down menu.

3. Control the functionality of RADIUS MAC Authentication on the VLAN/SSID by selecting one of the following from the
the RADIUS Authentication Status drop-down menu.
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* Enable: MAC addresses in the MAC Access Control List stored on the RADIUS server are blocked or allowed,
based on the MAC ACL settings. If a higher priority authentication protocol is also enabled, the higher-priority
settings will override the MAC ACL settings. See Authentication Protocol Hierarchy.

» Disable: RADIUS MAC ACL settings are disabled.

» Strict: RADIUS MAC ACL settings are enabled. If a higher-priority authentication protocol is also enabled,
RADIUS MAC ACL settings will be applied in addition to the higher priority authentication protocol settings. See
Authentication Protocol Hierarchy.

4. Control the functionality of the MAC Access Control List on the VLAN/SSID by selecting one of the following from the

MAC ACL Status drop-down menu:

» Enable: MAC addresses in the MAC Access Control List are blocked or allowed, based on the MAC ACL settings.
If a higher priority authentication protocol is also enabled, the higher-priority settings will override the MAC ACL
settings. See Authentication Protocol Hierarchy.

* Disable: MAC ACL settings are disabled.

» Strict: MAC ACL settings are enabled. If a higher-priority authentication protocol is also enabled, MAC ACL
settings will be applied in addition to the higher priority authentication protocol settings. See Authentication
Protocol Hierarchy. When MAC ACL Status is set to Strict, changes to the MAC ACL table (configured on the MAC
Access page) will take effect without a device reboot.

5. Enter Rekeying Interval in seconds (between 300 and 65525). When set to 0, this parameter is disabled. The default
is 900 seconds.

6. Enter the Security Profile used by the VLAN in the Security Profile field. See the Security Profile section for more
information.

7. Define the RADIUS Server Profile Configuration for the VLAN/SSID:
* RADIUS MAC Authentication Profile
* RADIUS EAP Authentication Profile
* RADIUS Accounting Profile
If 802.1x, WPA, or 802.11i security mode is used, the RADIUS EAP Authentication Profile must have a value.

A RADIUS Server Profile for authentication for each VLAN shall be configured as part of the configuration options
for that VLAN. RADIUS profiles are independent of VLANs. The user can define any profile to be the default and
associate all VLANSs to that profile. Four profiles are created by default, “MAC Authentication”, “EAP
Authentication”, Accounting”, and “Management”
8. If desired, scroll down to the scroll down to the SSID and VLAN Table and click Edit to modify the Network Name,
VLAN ID, or QoS profile of the SSID/VLAN.

NOTE: Because VLAN tagging is disabled, attempting to add a new SSID/VLAN will produce an error message.
The Edit Entries screen will be displayed. See Figure 4-58.
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Figure 4-58 SSID/VLAN Edit Entries Screen (VLAN Tagging Disabled)

9. Enter a unique Network Name (SSID) between 1 and 32 characters. This parameter is mandatory.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the

name.

10.Enter a unique VLAN ID. This parameter is mandatory.

A VLAN ID is a number from -1 to 4094. A value of -1 means that an entry is “untagged.”

You can set the VLAN ID to “-1” or “untagged” if you do not want clients that are using a specific SSID to be
members of a VLAN workgroup.

The VLAN ID must match an ID used by your network; contact your network administrator if you need assistance
defining the VLAN IDs.

11. Specify a QoS profile. See the Policy section for more information.

12.Specify a 802.1p Priority.

13.Set the Maximum TX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.
14.Set the Maximum RX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.

15.Select the status of Closed System to control whether the SSID is advertised in the beacon and manage the way
probe requests are handled, as follows:

Enable: The SSID is not advertised in the beacon, and the AP will respond to probe requests with an SSID only if
the client has specified the SSID in the probe request. If the client sends a probe request with a null or “ANY”
SSID, the AP will not respond.

Partial: The SSID is advertised in the beacon, and the AP will not respond to "ANY" SSID requests. The Partial
setting reduces network traffic by eliminating the repeated broadcast of SSIDs in probe responses.

Disable: The SSID is advertised in the beacon, and the AP will respond with each configured SSID, whether or
not an SSID has been specified in the probe request.
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16.Enable Broadcast Unique Beacon using the drop-down menu. When enabled, Broadcast Unique Beacon allows the
broadcast of a up to four unique beacons when the AP is configured for multiple SSIDs. If Closed System (above) is
set to Partial or Disable, each beacon (up to four) will be broadcast a single SSID. If more than four SSIDs are
configured, then three SSIDs will be broadcast in individual beacons; the fourth and subsequent SSIDs will be
combined in one beacon and will not be broadcast. If Closed System is set to Enable, the SSID will not be broadcast
in the beacon. If Broadcast Unique Beacon is disabled, a combined beacon will be broadcast.

NOTE: Enabling Broadcast Unique Beacon will lower the total throughput of the AP by 2-4%. Enabling Broadcast
Unique Beacon simultaneously with Rogue Scan will cause a drift in the beacon interval and the occasional
missing of beacons.

17.Set the 802.1p Priority given to packets tagged with this VLAN ID. Enter a number between 0-7.

18.1f editing an entry, enable or disable the parameters on this page by electing Enable or Disable from the Status
drop-down menu. If adding a new entry, this drop-down menu will not appear.

19.Click OK to return to Wireless Security Configuration Screen.
20.Reboot the AP.

Configuring SSID/VLANs with VLAN Tagging Enabled

With VLAN Tagging enabled (from the SSID/VLAN/Security > Mgmt VLAN tab), multiple SSID/VLANs are supported.
Parameters set on the Wireless tab can be enabled per SSID by choosing the Enable Security per SSID option.

1. Click SSID/VLAN/Security > Wireless.
2. Select the Enable Security Per SSID option. The screen will update to the following:
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Figure 4-59 SSID/VLAN Configuration (VLAN Tagging Enabled)
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NOTE: If you disable (uncheck) the Enable Security per SSID option, you will be able to add multiple SSID/VLANSs,
but the same configuration parameters (described below) will applied to all of them.

3. Click Add to configure additional SSIDs, VLANSs, and their associated security profiles and RADIUS server profiles, or
click Edit to modify existing SSIDs.

The Add Entries or Edit Entries screen appears. See Figure 4-60.

Syglem \ Nebwork ‘\ Ingnaces \ Managermem ! Fillering \

Alarms Brdge =] RADIUS Profiles

S5ID, VLAN, and Security Table - Wireless A - Add Entries.

This page is used to configure additional 55i0s, VLANS, and their associaled security profiles and RADIUS
server profiles. Each table entry requires & umigue 5310, VLAN I and a valid security profile.

are used to configure the allowed security modes. H RADIUS MAC, B0 1x, WPA or RADINS
accounting is enabled in the 55I10°s security profile then the respective should be
configured and aszigned to this S210.

MNote: Changes to these parameiens requlne access point reboot in onger fo take effect.

Metwiark name (SSI10

VLAM ID (D-4084

e — wrragged
Claged Systen IE-'l-:-Il "I
Brosdeast Uniqua Baacan I:.ueu. .|
SSID sutharization IE.u:u - I
Accounting Status Cracie -
RADILS MAC I“——_'-I
Cuacle -
Agthanbcation Status L
MAC ACL Status IC-HcI! - I
xEE g Indenval =
RADIUS EAP Authentication
Profile
RADILS Accouwnting Profile
QoS Profile
802 1p priority Fi
Max Ty Bandwidth(Kbps
JFi
M ax Ax Bandwidthikbps
JFi
LA J Cancal @

Figure 4-60 SSID/VLAN Edit Entries Screen (VLAN Tagging Enabled)

4. Enter a uniqgue Network Name (SSID) between 1 and 32 characters. This parameter is mandatory.

NOTE: Do not use quotation marks (single or double) in the Network Name; this will cause the AP to misinterpret the
name.

5. Enter a unique VLAN ID. This parameter is mandatory.
* AVLAN ID is a number from -1 to 4094. A value of -1 means that an entry is “untagged.”
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* You can set the VLAN ID to “-1” or “untagged” if you do not want clients that are using a specific SSID to be
members of a VLAN workgroup. Only one “untagged” VLAN ID is allowed per interface.

* The VLAN ID must match an ID used by your network; contact your network administrator if you need assistance
defining the VLAN IDs.

6. Select the status of Closed System to control whether the SSID is advertised in the beacon and manage the way
probe requests are handled, as follows:

» Enable: The SSID is not advertised in the beacon, and the AP will respond to probe requests with an SSID only if
the client has specified the SSID in the probe request. If the client sends a probe request with a null or “ANY”
SSID, the AP will not respond.

* Partial: The SSID is advertised in the beacon, and the AP will not respond to "ANY" SSID requests. The Partial
setting reduces network traffic by eliminating the repeated broadcast of SSIDs in probe responses.

» Disable: The SSID is advertised in the beacon, and the AP will respond with each configured SSID, whether or
not an SSID has been specified in the probe request.

7. Enable Broadcast Unique Beacon using the drop-down menu. When enabled, Broadcast Unique Beacon allows the
broadcast of a up to four unique beacons when the AP is configured for multiple SSIDs. If Closed System (above) is
set to Partial or Disable, each beacon (up to four) will be broadcast a single SSID. If more than four SSIDs are
configured, then three SSIDs will be broadcast in individual beacons; the fourth and subsequent SSIDs will be
combined in one beacon and will not be broadcast. If Closed System is set to Enable, the SSID will not be broadcast
in the beacon. If Broadcast Unique Beacon is disabled, a combined beacon will be broadcast.

NOTE: Enabling Broadcast Unique Beacon will lower the throughput of the AP by 2-4%. Enabling Broadcast Unique
Beacon simultaneously with Rogue Scan will cause a drift in the beacon interval and the occasional missing of
beacons.

8. Enable or disable the SSID Authorization status from the drop-down menu. SSID Authorization is the RADIUS-based
authorization of the SSID for a particular client. The authorized SSIDs are sent as the tunnel attributes.
9. Enable or disable RADIUS accounting on the VLAN/SSID under the Accounting Status drop-down menu.

10.Enable or disable RADIUS MAC authentication status on the VLAN/SSID under the RADIUS Authentication Status
drop-down menu.

11.Enable or disable MAC Access Control List status on the VLAN/SSID under the MAC ACL Status drop-down menu.

12.Enter the Rekeying Interval in seconds (between 300 and 65525). When set to 0, this parameter is disabled. The
default is 900 seconds.

13.Enter the Security Profile used by the VLAN in the Security Profile field.
NOTE: If you have two or more SSIDs per interface using a Security Profile with a security mode of Non Secure, be
aware that security being applied in the VLAN is not being applied in the wireless network.
14.Define the RADIUS Server Profile Configuration for the VLAN/SSID:
* RADIUS MAC Authentication Profile
* RADIUS EAP Authentication Profile
* RADIUS Accounting Profile
If 802.1x, WPA, or 802.11i security mode is used, the RADIUS EAP Authentication Profile must have a value.

A RADIUS Server Profile for authentication for each VLAN shall be configured as part of the configuration options for
that VLAN. RADIUS profiles are independent of VLANs. The user can define any profile to be the default and
associate all VLANSs to that profile. Four profiles are created by default, “MAC Authentication”, “EAP Authentication”,
Accounting”, and “Management”.

15.Specify a QoS Profile. See the Policy section for more information.

16.Set the 802.1p Priority given to packets tagged with this VLAN ID. Enter a number between 0-7.
17.Set the Maximum TX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.
18.Set the Maximum RX Bandwidth in Kbps. If this parameter is set to 0, full bandwidth is available.
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19.If editing an entry, enable or disable the parameters on this page using Status drop-down menu. If adding a new entry,
this drop-down menu will not appear.

20.Reboot the AP.

137



AP-700 User Guide

Monitoring

This chapter discusses the following monitoring options:

Version: Provides version information for the Access Point’s system components.

ICMP: Displays statistics for Internet Control Message Protocol packets sent and received by the AP.
IP/ARP Table: Displays the AP’s IP Address Resolution table.

Learn Table: Displays the list of nodes that the AP has learned are on the network.

IAPP: Provides statistics for the Inter-Access Point Protocol messages sent and received by the AP.
RADIUS: Provides statistics for the configured RADIUS server(s).

Interfaces: Displays the Access Point’s interface statistics (Wireless and Ethernet).

Station Statistics: Displays statistics for stations and Wireless Distribution System links.

Mesh Statistics: Displays statistics for the Mesh portal, including the network topology and the Neighbor Table. This
page is not relevant to the AP-700.

To monitor the AP using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for
instructions.

You may also monitor the AP using the command line interface. See Command Line Interface (CLI) for more information

To monitor the AP via HTTP/HTTPS:

1. Click the Monitor button located on the left-hand side of the screen. The main Monitor screen will be displayed.

RADIUS |  interfaces | Staon Statistics Mesh A
version 4 ICHP L PARPTable % LeamTable IAPP | 1
Status Menitor
Configure There are nine main categories that provide monitoring and diagnostics information on the access point.
provides information on the version of the access point and its system components.
Commands displays statistics on Internet Control Message Protocol messages received and transmitted by the
access point.
Help provides information on the IP Address Resolution table.
Exit displays entries that have been learned by the access point bridge.
provides statistics on the Inter-Access Point Protocol messages received and transmitted by the
Reboat access point.
provides statistics on the primary and backup RADIUS server(s) configured to communicate with
the access point.
displays access point interface statistics - Ethernet and Wireless.
is used to Monitor Statistics of Wireless Stations and WDS links.
is used to Monitor Mesh neighbor and topology statistics.

Figure 5-1 Monitor Main Screen

2. Click the tab that corresponds to the statistics you want to review. For example, click Learn Table to see the list of

nodes that the AP has discovered on the network.

3. If necessary, click the Refresh () button to update the statistics.

Each Monitor tab is described in the remainder of this chapter.
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Version

From the HTTP interface, click the Monitor button and select the Version tab. The list displayed provides you with
information that may be pertinent when calling Technical Support. With this information, your Technical Support
representative can verify compatibility issues and make sure the latest software are loaded. This screen displays the

following information for each Access Point component:

» Serial Number: The component’s serial number, if applicable.

* Name/ID: The AP identifies a system component based on its name or ID. Each component has a unique identifier.

» Variant: Several variants may exist of the same component (for example, a hardware component may have two
variants, one with more memory than the other).

* Version: Specifies the component’s version or build number. The Software Image version is the most useful
information on this screen for the typical end user.
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Version
1.255.255

— S L L

-]

= =]
=

\

Figure 5-2 Version Monitoring Tab
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ICMP

This tab provides statistical information for both received and transmitted messages directed to the AP. Not all ICMP
traffic on the network is counted in the ICMP (Internet Control Message Protocol) statistics.

RADILS \ Interfaces 1 smunnsmsucs\ Kesh Statistics \
Version ICHP \ IP ARP Table \ Leam Table \ IAPP \

Thi= taby provides etatstics on the Internet Contral Message Profocod (ICMP) packets transmitted and
received by the sccess point.

)

Messages Received Messages Transmitted

Tolal ICKP Packets il Tolal ICMP Packets @
Errars il Ermars @
Destinzlion Unreachablz i} Destination Unrezchable vl
Time Exceedsd il Time Exceeded @
Faramsier Problems il Paramsier Froblems [}
Saurce Quench o Sowurce Cuench @
Redirecls o Redirscls o)
Echos o Echos o]
Echo Reply ) Echo Reply Q
Time Slamp3 o Time Slampa Q
Time Slamp Reply @ Time Slamp Raply Q
Address Mask Ul Address Mask Q

Ul @

&ddress Mask Reply Address Mask Reply

Figure 5-3 ICMP Monitoring Tab
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IP/ARP Table
This tab provides information based on the Address Resolution Protocol (ARP), which relates MAC Address and IP
Addresses.
RADIUS 1 Intaitacas \ Station Stalistics \ Mazh Statistics 1
ersion o ICKP IF 4RF Tzhlz mLeam Tahla _‘\ 1AFP ‘1.

aidrees resciution.

MAC Address
OO20AG 55 F3 5

1P fddress
160254 503

KMedia Type
Sishc

This tab provides details on the [P Address Resclution Protocol (AR table. Thiz inble displays @ to MAC

&)

Figure 5-4 IP/ARP Table Monitoring Tab
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Learn Table

This tab displays information relating to network bridging. It reports the MAC address for each node that the device has
learned is on the network and the interface on which the node was detected. There can be up 10,000 entries in the Learn
Table.

RADIUS \ Interfaces \ Stalion Stalictics \ Mesh Sialistics -\
-

Version IGHP IP ARP Table Learn Table \ LAFP \

This tzb displays the bridge learn lable, that containg MAC addresses and part numbers on which wired
hosts and wircless clients reside.

9)

MAC Adilrass Por
pOo=1ED1 AQSD ]

Figure 5-5 Learn Table Monitoring Tab
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IAPP

This tab displays statistics relating to client handovers and communications between Access Points.

RADIUS \ Interfaces \ Station Stalistics \ Mesh Stalistics \

Wersion ICMF IF AR Table Learn Table AFF 1_

This tab digplays Inter Access Podnt Protocol (LAPP) siatistics. Siatatics include IAPP packets recenved and
transmitled by the stcess poant &8 well a8 the number of roamdng wiréless chents,

)
Handover Response Received i Announce Regquesi Sent 2
Annpunce Request Recenead i Announce Response Sent 1682
Announce Respanse Received 0 Handover Reguest Sent )
Handover Request Recened ] Handover Response Sent o
Handover Requést Retransmission o Dmopped FDUs o
Number of Roaming Clients o

Figure 5-6 IAPP Monitoring Tab
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RADIUS

This tab provides RADIUS authentication, EAP/802.1x authentication, and accounting information for both the Primary
and Backup RADIUS servers for each RADIUS Server Profile.

NOTE: Separate RADIUS servers can be configured for each RADIUS Server Profile.

Select the RADIUS Server Profile to view statistics on from the Select Server Profile drop-down menu.

Version -\ ICHIP

'\ IP ARP Table '\ Leaim Table

Select Server Profile

IsFP RADILS

Inlerfaces

Primary Server Authentication
Statistics

Access Requesis

Access Accapls

Access Relransmissions

Access Rejecs

&ccess Challenges

kaHormed Access Responsas
suthentication Bad Authenticators
Timaguis

Primary Server Accounting
Statistics

Accounting Requests
Accounling Relransmissions
Acgounng RESponsés
Accounting Bad Authenlicalors

oo oo o

L= = =T =1

| MAC Authenbcation ;]

Backup Server Authentication
Statistics

ACoRSss Regquests

ACCass Accepis

Access Relransmissions

Access Rejecls

Access Challenges

llafformed Access Responses
futhentication Bad Authenfcators
Timeouts

Backup Server Accounting
Statistics

Accounling Requests
Aacoounling Relransmissions
Arcounling Responsas
Accounling Bad Authenticalons

iR === == = =]

CoQQ

Station Statistics \ Mesh Statistics \

This tab provides siatietcs on the primary and backup RADUS [Authentication and Actounting) server{g)
with which the access point is configured 1o COmMMUNCate.

()

Figure 5-7 RADIUS Monitoring Tab
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Interfaces

This tab displays statistics for the Ethernet and wireless interfaces.

version \ ICMP \ IP ARP Tabis \ Leam Table 1

laPP RADIUS

This tab provides information and statistics on the acoess point Ethermet interface.

Type elamel-camacd
Descripion
0 Sa

Admin Status

Speed

Maximum Packet Size
In Octels (byt

In Unicast Els
In Man-unicasl Packels 270
In Discard

In Errors

Linkrigws Prolacals

ul Oclets (byles JB05d

0

Ot Linicast Packets BO0S
Ot Mon-unicast Packets 1042
Ok Discards ¥
Okt Errors i
Cutput Queue Length 1]
Alignment Emor 0
FC=3 Errors {
Single Collision Frames

Mulliple Collision Framsss

Excessim Collisions
Internal MAC Transmit Erors

SCOooooLoo D

1 Slalion Statislies \ llesh Sialistics -\_

()

Figure 5-8 Interface Monitoring Tab (Ethernet)

Description of Interface Statistics

The following statistics are displayed for the Ethernet interface only, the wireless interface only, or for both the Ethernet

and Wireless interfaces:

» Admin Status (Ethernet/Wireless): The desired state of the interface: Up (ready to pass packets), Down (not ready to

pass packets, or Testing (testing and unable to pass packets).

« Alignment Error (Ethernet): The number of frames received that are not an integral number of octets in length and do

not pass the Frame Check Sequence check.

» Carrier Sense Errors (Ethernet): The number of times that the carrier sense condition was lost or never asserted
when attempting to transmit a frame. The count increments at most once per transmission attempt.

* Deferred Transmission (Ethernet): The number of frames for which the first transmission attempt is delayed because

the medium is busy.This number does not include frames involved in collisions.

» Description (Ethernet/Wireless): Information about the interface (e.g., the name of the manufacturer, the product

name and the version of the hardware interface).

* Duplicate Frame Count (Wireless): The number of duplicate frames received.
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Ethernet Chipset (Ethernet): Identifies the chipset used to realize the interface.

Excessive Collisions (Ethernet): The number of frames for which transmission fails due to excessive collisions.
Failed ACK Count (Wireless): The number of times an acknowledgment (or ACK) is not received when expected.
Failed Count (Wireless): The number of packets not transmitted successfully due to too many transmit attempts.

Failed RTS Count (Wireless: The number of times a Clear to Send (CTS) is not received in response to a Request to
Send (RTS).

FCS Error (Wireless): The number of Frame Check Sequence errors detected in received MAC Protocol Data Units
(MPDUs).

FCS Errors (Ethernet): The number of frames received that are an integral number of octets in length but do not pass
the Frame Check Sequence check.

Frames Too Long (Ethernet). The number of frames received that exceed the maximum permitted frame size.

In Discards (Ethernet/Wireless): The number of error-free inbound packets that were chosen to be discarded to
prevent their being deliverable to a higher-layer protocol. One possible reason for discarding such a packet could be
to free up buffer space.

In Errors (Ethernet/Wireless): The number of inbound packets that contained errors preventing them from being
deliverable to a higher-layer protocol.

In Non-unicast Packets (Ethernet/Wireless): The number of non-unicast (i.e., subnetwork-broadcast or
subnetwork-multicast) packets delivered to a higher-layer protocol.

In Octets (bytes) (Ethernet/Wireless): The total number of octets received on the interface, including framing
characters.

In Unicast Packets (Ethernet/Wireless): The number of subnetwork unicast packets delivered to a higher-layer
protocol.

Internal MAC Receive Errors (Ethernet). The number of frames for which reception fails due to an internal MAC
sublayer transmit error. A frame is only counted if it is not counted by the Frames Too Long, Alignment Error, or FCS
Error counters.

Internal MAC Transmit Errors (Ethernet): The number of frames for which transmission fails due to an internal MAC
sublayer transmit error. A frame is only counted if it is not counted by Late Collision, Excession Collision, or Carrier
Sense Error counters.

Last Change (Ethernet/Wireless): The value of the sysUpTime object at the time the interface entered its current
operational state.

Late Collisions (Ethernet): The number of times that a collision is detected on a particular interface later than 512
bit-times into the transmission of a packet

MAC Address (Wireless): The station's assigned, unique MAC address,
Maximum Packet Size (Ethernet/Wireless): The size (in octets) of the largest datagram which can be sent/received

MIB Specific Definition (Ethernet/Wireless): A reference to MIB definitions specific to the particular media being
used to realize the interface. For example, if the interface is an Ethernet interface, then this field refers to a document
defining objects specific to ethernet.

Multicast Received Frame Count (Wireless): The number of multicast packets received.
Multicast Transmitted Frame Count (Wireless): The number of multicast packets transmitted.

Multiple Collision Frames (Ethernet): The number of successfully transmitted frames for which transmission is
inhibited by more than one collision.

Multiple Retry Count (Wireless): The number of packets successfully transmitted after more than one
retransmission.

Operational Status (Ethernet/Wireless): The current state of the interface: Up (ready to pass packets), Down (not
ready to pass packets, or Testing (testing and unable to pass packets).

Out Discards (Ethernet/Wireless): The number of error-free outbound packets chosen to be discarded to prevent
their being transmitted. One possible reason for discarding such a packet could be to free up buffer space.
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Out Errors (Ethernet/Wireless): The number of outbound packets that could not be transmitted because of errors.

Out Non-unicast Packets (Ethernet/Wireless): The total number of packets that higher-level protocols requested be
transmitted to a non-unicast (i.e., a subnetwork-broadcast orsubnetwork-multicast) address, including those that were
discarded or not sent.

Out Octets (bytes) (Ethernet/Wireless): The total number of octets transmitted out of the interface, including framing
characters.

Out Unicast Packets (Ethernet/Wireless): The total number of packets that higher-level protocols requested be
transmitted to a subnetwork-unicast address, including those that were discarded or not sent.

Output Queue Length (Ethernet/Wireless): The length of the output packet queue (in packets).

Physical Address (Ethernet): The interface's address at the protocol layer immediately below the network layer in the
protocol stack.

Received Fragment Count (Wireless): The number of successfully received Data or Management MAC Protocol
Data Units (MPDUs).

Retry Count (Wireless): The number of packets successfully transmitted after one or more retransmissions.

Single Collision Frames (Ethernet): The number of successfully transmitted frames for which transmission is
inhibited by exactly one collision

Speed (Ethernet/Wireless): An estimate of the interface's current bandwidth in bits per second.

SQE Test Errors (Ethernet): The number of times that the Signal Quality Error (SQE) Test Error message is
generated by the physical layer signalling (PLS) sublayer.

Successful RTS Count (Wireless): The number of times a Clear to Send (CTS) is received in response to an
Request to Send (RTS).

Transmitted Fragment Count (Wireless): The number of transmitted fragmented packets.
Transmitted Frame Count (Wireless): This number of successfully transmitted packets.

Type (Ethernet/Wireless): The type of interface, distinguished according to the physical/link protocol(s) immediately
below the network layer in the protocol stack.

Unknown Protocols (Ethernet/Wireless): The number of packets received that were discarded because of an
unknown or unsupported protocol.

WEP Undecryptable Count (Wireless): The number of undecryptable WEP frames received.
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Station Statistics

This tab displays information on wireless clients attached to the AP and on Wireless Distribution System.

Enable the Monitoring Station Statistics feature (Station Statistics are disabled by default) by checking Enable
Monitoring Station Statistics and click OK.

You do not need to reboot the AP for the changes to take effect. If clients are connected to the device or WDS links are
configured for the device, the statistics will now be shown on the screen. Click Select to view the more detailed statistics
for a client.

Click on the Refresh button in the browser window to view the latest statistics. If any new clients associate to the AP, you
can see the statistics of the new clients after you click the refresh button.

Version \ ICMP \ IP ARP Table \ Learn Table \

IAPP RADIUS Interfaces Station Statistics \ Mesh \
This screen displays the statistics related to associated stations and WDS links.

The foll

wing information is displayed:

: MAC address of associated station or partner MAC address of WDS link.

: IP Address of associated station/Mesh Unit or 0.0.0.0 for WDS links.

Interface on which the station is associated or the WDS link is configured.

: 5TA (5tation) or WDS

col : 802.11a, 802.11b or 802.11g

5 Signal to Noise Ratio.

TSLF : Time since last frame was received from the associated station or WDS link partner.

ess

A station will no lor
WDS links are show

e client

Enable Monitoring Station Statistics 72
OK ; Cancel
MAC Address IP Address Interface Protocol SNR  TSLF
Select J

Number of stations and WDS links : 0

Figure 5-9 Station Statistics Monitoring Tab

Description of Station Statistics

The following stations statistics are displayed:

MAC Address: The MAC address of the wireless client for which the statistics are gathered. For WDS links, this is the
partner MAC address of the link.

IP Address: The IP address of the associated wireless station for which the Statistics are gathered. (0.0.0.0 for WDS
links)

Interface to which the Station is connected: The interface number on which the client is connected with the AP. For
WDS links this is the interface on which the link is configured.

Type: The type of wireless client (STA or WDS).

MAC Protocol: The MAC protocol for this wireless client (or WDS link partner). The possible values are 802.11a,
802.11b, 802.11g.

Signal / Noise: The Signal /Noise Level measured at the AP when frames are received from the associated wireless
station (or WDS link partner).

148



Monitoring AP-700 User Guide
Station Statistics

» Time since Last Frame Received: The time elapsed since the last frame from the associated wireless station (or
WDS link partner) was received.

*  Number of Stations and WDS Links: The number of stations and WDS links monitored.

The following stations statistics are available through SNMP:

* Octets Received: The number of octets received from the associated wireless station (or WDS link partner) by the
AP.

* Unicast Frames Received: The number of Unicast frames received from the associated wireless station (or WDS link
partner) by the AP.

* Non-Unicast Frames Received: The number of Non-Unicast frames received (i.e. broadcast or multicast) from the
associated wireless station (or WDS link partner) by the AP.

* Octets Transmitted: The number of octets sent to the associated wireless station (or WDS link partner) from the AP.

* Unicast Frames Transmitted: The number of Unicast frames transmitted to the associated wireless station (or WDS
link partner) from the AP.
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Mesh Statistics

As the AP-700 does not support Mesh functionality, this tab contains no information. Visit www.proxim.com for
information on Mesh.

Version \ ICMP \ IP ARP Table \ Learn Table \

IAPP RADIUS Interfaces Station Statistics llesh \

This tab provides information and statistics on mesh.

Mesh cannot be used on this AP and no Mesh statistics are available.

Figure 5-10 Mesh Monitoring Tab
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Commands

This chapter contains information on the following Command functions:

Introduction to File Transfer via TFTP or HTTP: Describes the available file transfer methods.
Update AP: Download files via TFTP or HTTP to the AP.

Retrieve File: Upload configuration files from the AP to a TFTP server.

Reboot: Reboot the AP in the specified number of seconds.

Reset: Reset all of the Access Point’s configuration settings to factory defaults.

Help Link: Configure the location where the AP Help files can be found.

To perform commands using the HTTP/HTTPS interface, you must first log in to a web browser. See Logging In for
instructions.

You may also perform commands using the command line interface. See Command Line Interface (CLI) for more
information.

To perform commands via HTTP/HTTPS:

1. Click the Commands button located on the left-hand side of the screen.
Update AP | RefrieveFile 1§ Reboot L Reset L Helplink  §
Status Commands
CUﬂﬂng[e There are five commands that can be executed on the access |)0i|ll.

Manitor
is used to upload files via TFTP/HTTP to the access point. This feature can be used to upgrade
the access point and upload configuration files.
is used to retrieve configuration file from the access point via TFTP/HTTP. This feature can be
used to backup the access point configuration file,
Help
allows you to reboot the access point in the specified number of seconds.
Exit set .qurati . . : ault v
will reset all the configuration settings of the access point to the factory default values.
Reboot is used to configure where the access point help information can be retrieved.

Figure 6-1 Commands Main Screen

2. Click the tab that corresponds to the command you want to issue. For example, click Reboot to restart the unit.

Following a brief introduction to TFTP and HTTP file transfer, each Commands tab is described in the remainder of this
chapter.
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Introduction to File Transfer via TFTP or HTTP
There are two methods of transferring files to or from the AP: TFTP or HTTP (or HTTPS if enabled):

» Downloading files (Configuration, AP Image, Bootloader, License, Private Key, Certificate, CLI Batch File) to the AP
using one of these two methods is called “Updating the AP.”

* Uploading files (Configuration, CLI Batch File, etc) from the AP is called “Retrieving Files.”

TFTP File Transfer Guidelines

A TFTP server must be running and configured to point to the directory containing the file.

If you do not have a TFTP server installed on your system, install the TFTP server from the installation CD.

HTTP File Transfer Guidelines

HTTP file transfer can be performed either with or without SSL enabled.

HTTP file transfers with SSL require enabling Secure Management and Secure Socket Layer. HTTP transfers that use
SSL may take additional time.

NOTE: SSL requires Internet Explorer version 6, 128 bit encryption, Service Pack 1, and patch Q323308.

Image Error Checking During File Transfer

The Access Point performs checks to verify that an image downloaded through HTTP or TFTP is valid. The following
checks are performed on the downloaded image:

» Zero Image size

* Large image size

* Non VxWorks image

* AP image

» Digital signature verification

If any of the above checks fail on the downloaded image, the Access Point deletes the downloaded image and retains the
old image. Otherwise, if all checks pass successfully, the AP deletes the old image and retains the downloaded image.

These checks are to ensure that the AP does not enter an invalid image state. The storage of the two images is only
temporary to ensure the proper verification; the two images will not be stored in the AP permanently.

Image error checking functions automatically in the background. No user configuration is required.
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Update AP

Update AP via TFTP

Use the Update AP via TFTP tab to download Configuration, AP Image, Bootloader files, Certificate and Private Key files,
and CLI Batch File to the AP. A TFTP server must be running and configured to point to the directory containing the file.

Jala AP \]\ Rabieve File \l\ Riebaoat \]k Resal ‘\ Hizlp Link 1
WaTFTP \ wia HTTP -\

This page is used to update software images, license file and configuration file in
the Access Point using TFTP.

Hote: On updating configuration file the Access Point will reboot by itsalf.

System Infermation

oftware Version a.4.0
o0t Laader Yersion 310

(=

TFTP Information

Server IF Address [0z
File Hame [2F sai
Fila Type II‘Hat .I
Fila Oparation [vedsta ar =]
Lipdata AP 3 Cantel 8

Figure 6-2 Update AP via TFTP Command Screen

If you do not have a TFTP server installed on your system, install the TFTP server from the installation CD. You can either
install the TFTP server from the CD Wizard or run OEM-TFTP-Server.exe found in the CD’s Xtras/SolarWinds
sub-directory.

The Update AP via TFTP tab shows version information and allows you to enter TFTP information as described below.

+ Server IP Address: Enter the TFTP server IP Address.
— Double-click the TFTP server icon on your desktop and locate the IP address assigned to the TFTP server.

NOTE: This is the IP address that will be used to point the Access Point to the AP Image file.

* File Name: Enter the name of the file to be downloaded (including the file extension).
— Copy the file to the TFTP server’s root folder.
» File Type: Select the proper file type. Choices include:
— Config: configuration information, such as System Name, Contact Name, and so on.

NOTE: The AP will reboot automatically when downloading a Config file.

— Image: AP Image (executable program).

— Upgrade BspBIl: Bootloader software.

— SSL Certificate: the digital certificate for authentication in SSL communications.

— SSL Private Key: the private key for encryption in SSL communications.

— S8SH Public Key: the public key in SSH communications. See Secure Shell (SSH) Settings for more information.
— SSH Private Key: the private key in SSH communications. See Secure Shell (SSH) Settings for more information.

153



Commands AP-700 User Guide
Update AP

— CLI Batch File: a CLI Batch file that contains CLI commands to configure the AP. This file will be executed by the
AP immediately after being uploaded. See CLI Batch File for more information.

» File Operation: Select either Update AP or Update AP & Reboot. You should reboot the AP after downloading files.

Update AP via HTTP

Use the Update AP via HTTP tab to download Configuration, AP Image, Bootloader files, and Certificate and Private Key
files to the AP.

Once on the Update AP screen, click on the via HTTP tab.
"\ Rerievarie | Reboot | Reset | Heplink |
via TFTP 3 HTTF \k

This page is used to update software images, license file and configuration files in
the Access Point uging HTTP file transfer. Click on the browse button to search Tor
the file or enter the path in the téxt box Select the file type and click the Update AP
bution to start the file transfer,

Rote: On updating configuration file the Acceas Poinl will reboot by itgel

System Infarmation

Saftware Version XXX
Boat Loader Version XXX

File Type IImage "I
File Name  [AP.sei Browse... I

Update AF | Can:el|

Figure 6-3 Update AP via HTTP Command Screen

The Update AP via HTTP tab shows version information and allows you to enter HTTP information as described below.

1. Select the File Type that needs to be updated from the drop-down box. Choices include:
— Image for the AP Image (executable program).
— Config for configuration information, such as System Name, Contact Name, and so on.

NOTE: The AP will reboot automatically when downloading a Config file.

— SSL Certificate: the digital certificate for authentication in SSL communications.
— SSL Private Key: the private key for encryption in SSL communications.
— Upgrade BSPBL.: the Bootloader software.

— CLI Batch File: a CLI Batch file that contains CLI commands to configure the AP. This file will be executed by the
AP immediately after being uploaded. See CLI Batch File for more information.

— SSH Public Key: the public key in SSH communications. See Secure Shell (SSH) Settings for more information.
— SSH Private Key: the private key in SSH communications. See Secure Shell (SSH) Settings for more information.

2. Use the Browse button or manually type in the name of the file to be downloaded (including the file extension) in the
File Name field. If typing the file name, you must include the full path and the file extension in the file name text box.

3. To initiate the HTTP Update operation, click the Update AP button.

A warning message gets displayed that advises the user that a reboot of the device will be required for changes to
take effect.
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x|
:.::") You &re updatng Image file to the A7, You wil nead to reboot the device fior chamges to tzke affect. Do you want to procssd 7
0K I Cancel I

Figure 6-4 Warning Message

4. Click OK to continue with the operation or Cancel to abort the operation.
NOTE: An HTTP file transfer using SSL may take extra time.

If the operation completes successfully the following screen appears.

HTTP Update was Successiul.

Figure 6-5 Update AP Successful

If the operation did not complete successfully the following screen appears, and the reason for the failure is displayed.

HTTF Uprdate of AP was not successful.
File was Fero Bytes.

Figure 6-6 Update AP Unsuccessful
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Retrieve File

Retrieve File via TFTP

Use the Retrieve File via TFTP tab to upload files from the AP to the TFTP server. The TFTP server must be running
and configured to point to the directory to which you want to copy the uploaded file. We suggest you assign the file a
meaningful name, which may include version or location information.

If you don’t have a TFTP server installed on your system, install the TFTP server from the installation CD. You can either
install the TFTP server from the CD Wizard or run OEM-TFTP-Server.exe found in the CD’s Xtras/SolarWinds
sub-directory.

The Retrieve AP via TFTP tab shows version information and allows you to enter TFTP information as described below.

» Server IP Address: Enter the TFTP server IP Address.

— Double-click the TFTP server icon on your desktop and locate the IP address assigned to the TFTP server.
» File Name: Enter the name of the file to be uploaded.
» File Type: Select the type of file to be uploaded: Config file, CLI Batch File, or CLI Batch (Error) Log.

Use the following procedure to retrieve a file from an AP to a TFTP server:

1. If retrieving a Config file, configure all the required parameters in their respective tabs. Reboot the device.

2. Retrieve and store the file. Click the Retrieve File button to initiate the upload of the file from the AP to the TFTP
server.

3. If you retrieved a Configuration file, update the file as necessary.

4. If you retrieved a CLI Batch File or CLI Batch Log, you can examine the file using a standard text editor. For more
information on CLI Batch Files, see CLI Batch File.

Update AP Refrieva File \ Reboot \_ Reset \'.‘_ Help Link \
via TFTF \ vig HTTP \

This page i% used 1o retrieve configuration file, latest CLI bateh rile, and CLI bateh e
expecution log from the Access Point using TFTP

System Infermation

Softerare Version J.4.0
Boot Loader Version 310

TFTP Infermation

Sarer P Address [180.254 122 122
File Mame [FILENAME
File Type | config =]

CLI Bateh File .
CLI Batch Lag Cancel 3

Figure 6-7 Retrieve File via TFTP Command Screen
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Retrieve File via HTTP

Use the Retrieve File via HTTP tab to retrieve configuration files, CLI Batch Files, or CLI Batch Logs from the AP. For

more information on CLI Batch Files and CLI Batch Logs see CLI Batch File.

1. Select the type of file (Config, CLI Batch File, CLI Batch Log) from the File Type drop-down menu.

2. Click on the Retrieve File button to initiate the operation.

Lpdate AP Refrieve Flle \ Reboot \ Resel \
via TFTP via HTTF \

This page is used Lo retrieve configuralion file, lstest CLI ateh Tile, and CLI bateh Mile
execution log from the Aceess Point using HTTP file transfer. Click the Retrieve File
burtton o start the file transfer.

System Information

Softwrare Version J.4.0
Boot Loader Version 3.1.0
File Type [Contig =

CLI Bateh Fila -
LI Bateh Log Cancel 4

Help Link

\

Figure 6-8 Retrieve File via HTTP Command Screen

A confirmation message is displayed, asking if the user wants to proceed with retrieving the file.

Microsoft Internet Explorer x|

i\?‘) ou are retrieving Config fle From the AP, Do wow want to procesd 7

[ ox | comel |

Figure 6-9 Retrieve File Confirmation Dialog

3. Click OK to continue with the operation or Cancel to abort the operation. On clicking OK, the File Download window

appears.
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File Download

Saome fles can harm your computer. IF the file nfarmation balow
looks suspecious, o pou da nok fully trust the sowmce, do not open o
save thiz file,

File name:  AP-Config
File type:
From: 169.254.50.3

‘w'oudd wou like to open the file or save it bo your computer?

Open || Save I Cancel More Info

|

¥ Alwaps ask before opening this bpe of fle

Figure 6-

10 File Download Dialog Box

4. On clicking the Save button the Save As window displays. Select an appropriate filename and location and click OK.
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Reboot

Use the Reboot tab to save configuration changes (if any) and reset the AP. Enter a value between 0 and 65535
seconds; entering a value of 0 (zero) seconds causes an immediate reboot. Note that Reset, described below, does not
save configuration changes.

CAUTION: Rebooting the AP will cause all users who are currently connected to lose their connection to the network
until the AP has completed the restart process and resumed operation.

Updale AP Retrieve File Rebool & Reset % Heplink %

Thie tab i used to reboot the access point by epecifying the number of seconds
before the next reboot. The access point reboots immediately by entering a value of
ZEero.

Warmning: Rebooting the access point will cause aff users wito are corrently connected
to lose their connection to the wetwork uatif the pnit has completed the rostart
process and resurred operation.

Please enter the time o reboot (seconds) Io

Raboa '

Figure 6-11 Reboot Command Screen
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Reset

Use the Reset tab to restore the AP to factory default conditions. Since this will reset the AP’s current IP address, a new
IP address must be assigned. See Logging In for more information.

CAUTION: Resetting the AP to its factory default configuration will permanently overwrite all changes that have made to
the unit. The AP will reboot automatically after this command has been issued.

Update AP Ratrieve File Reboot Reset \ Help Link 1

This taby is used to reset the access point configuration to factorny defaull values.

Waraing: Resedting the gccess point to iz factory defaunt confiquration will canse alf changoes that have
Bep mrade to the gl to e perimarertly fost, The dccess podut will reboot orce this functioR @5 execaied.

Reszat to Factory Default d

Figure 6-12 Reset to Factory Defaults Command Screen
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Help Link
Use the Help tab to configure the location of the AP Help files.

During initialization, the AP on-line help files are downloaded to the default location:

C:/Program Files/ORiINOCO/AP700/HTML/index.htm.

To enable the Help button on each page of the Web interface to access the help files, however, copy the entire Help

folder to a web server, then specify the new HTTP path in the Help Link box.

NOTE: The configured Help Link must point to an HTTP address in order to enable the Help button on each page of the

Web interface.

NOTE: Use the forward slash character ("/") rather than the backslash character ("\") when configuring the Help Link

location.

NOTE: Add the AP’s management IP address into the Internet Explorer list of Trusted Sites.

Update AP Retriave File Reboot Reset Help Link

This tab is used to configure the location of access point help information. Please enter a localion where
woir brdvaeser can fimd the Help Infarmation
For example:

* A Pathto a Local Directory (i.e. file:i0C:Program Fileshelpaccesspointindex. htm),
# A Path to a Mapped Drive (Le. filewiGrsharedhelpiaccesspointindee.htmp, or
# An HTTPURL Address (e hiflpuiswwwaccesspoint.oomobelpindeshtm)

Mote: Dwe to securily changes in wiernet Explorar, @ fink to @ focal or mapped drive may mot work vufess
the IP address of the Access Polut iz added to the Trasted Sites of kternet Explorer (Security fab undoer
Inferaet Qptions), There is po Erows method for epabliing finks to focal oF mapped drives with Melscape,
The wser may instafi the kelp fites on an fnternal or exteranal web site and point the link to it

Halp Link 'Tlle:.'.ﬁti:.l’rugram Fileshelp/accesspointindex.html

(0] 4 i Cancel 'i

X

Figure 6-13 Help Link Configuration Screen
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Troubleshooting

This chapter provides information on the following:

Troubleshooting Concepts
Symptoms and Solutions
Recovery Procedures
Related Applications

NOTE: This section helps you locate problems related to the AP device setup. For details about RADIUS, TFTP, serial

communication programs (such as HyperTerminal), Telnet applications, or web browsers, please see the
documentation that came with the respective application for assistance.

Troubleshooting Concepts

The following list identifies important troubleshooting concepts and topics. The most common initialization and
installation problems relate to IP addressing. For example, you must have valid IP addresses for both the AP and the
management computer to access the unit’'s HTTP interface.

IP Address management is fundamental.

Factory default units are set for “Dynamic” (DHCP) IP Address assignment. The default IP address for the AP is
169.254.128.132 if your network does not have a DHCP server. If you connect the AP to a network with an active
DHCP server, then use ScanTool to locate the IP address of your unit. If a DHCP server is not active on your subnet,
then use ScanTool to assign a static IP address to the unit.

The Trivial File Transfer Protocol (TFTP) provides a means to download and upload files. These files include
the AP Image (executable program) and configuration files.

If the AP password is lost or forgotten, you will need to reset to default values. The Soft Reset to Factory
Defaults or Hard Reset to Factory Defaults procedures reset the configuration, but do not change the current AP
Image.

The AP Supports a Command Line Interface (CLI). If you are having trouble locating your AP on the network,
connect to the unit directly using the serial interface and see Command Line Interface (CLI) for CLI command syntax
and parameter names.

ScanTool does not work over routers. You must be connected to the same subnet/physical LAN segment to use
ScanTool. Note that ScanTool also works over the wireless interface; you can run it on a wireless client connected to
the target AP or an AP connected to the same LAN segment/subnet.

If all else fails... Use the Forced Reload procedure to erase the current AP Image and configuration file and then
download a new image.
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Symptoms and Solutions

Connectivity Issues

Connectivity issues include any problem that prevents you from powering up or connecting to the AP.

AP Unit Will Not Boot - No LED Activity
1. Make sure your power source is operating.
2. Make sure all cables are connected to the AP correctly.
3. If you are using PoE, make sure you are using a Category 5, foiled, twisted pair cable to power the AP.

Serial Link Does Not Work
1. Make sure you are using a standard, straight-through, 9-pin serial cable.
2. Double-check the physical network connections.
3. Make sure your PC terminal program (such as HyperTerminal) is active and configured to the following values:
— Com Port: (COM1, COM2, etc. depending on your computer);
— Baud rate: 9600; Data bits: 8; Stop bits: 1; Flow Control: None; Parity: None;

— Line Feeds with Carriage Returns
(In HyperTerminal select: File > Properties > Settings > ASCII Setup > Send Line Ends with Line Feeds)

Ethernet Link Does Not Work

1. Double-check the physical network connections. Use a known-good unit to make sure the network connection is
present. Once you have the AP IP address, you can use the “Ping” command over Ethernet to test the IP Address. If
the AP responds to the Ping, then the Ethernet Interface is working properly.

2. By default, the Access Point will attempt to automatically detect the Ethernet settings. However, if you are having
problems with the Ethernet link, manually configure the Access Point’s Ethernet settings. For example, if your switch
operates at 100 Mbits/sec/Full Duplex, manually configure the Access Point to use these settings (see Ethernet). If
you cannot access the unit over Ethernet, then use the CLI interface over the serial port to configure the Ethernet port
(see Command Line Interface (CLI) and Set Ethernet Speed and Transmission Mode).

3. Perform network infrastructure troubleshooting (check switches, routers, etc.).

Basic Software Setup and Configuration Problems

Lost AP, Telnet, or SNMP Password

1. Perform the Soft Reset to Factory Defaults in this guide. This procedure resets system and network parameters, but
does not affect the AP Image. The default AP HTTP, Telnet, and SNMP passwords are all public.

Client Computer Cannot Connect
1. Client computers should have the same Network Name and security settings as the AP.
2. Network Names should be allocated and maintained by the Network Administrator.
3. See the documentation that came with your client card for additional troubleshooting suggestions.

AP Has Incorrect IP Address

1. Default IP Address Assignment mode is dynamic (DHCP). If you do not have a DHCP server on your network, the
default IP Address is 169.254.128.132. If you have more than one unintialized AP connected to the network, they will
all have the same default IP address and you will not be able to communicate with them (due to an IP address
conflict). In this case, assign each AP a static IP address via the serial cable or turn off all units but one and change
the IP address using ScanTool one at a time.
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2. The AP only contacts a DHCP server during boot-up. If your network’s DHCP server is not available while the AP is
booting, the device will use the default IP address (169.254.128.132). Reboot the AP once your DHCP server is
on-line again or use the ScanTool to find the Access Point’s current IP address.

3. To find the unit’s current IP address if using DHCP, open the IP Client Table in the DHCP Server and match the
Access Point’s IP address to its MAC address (found on the product label). Alternatively, use ScanTool to identify an
Access Point’s current IP address.

4. Once you have the current IP address, use the HTTP or CLI Interface to change the unit’s IP settings, if necessary.

5. If you use static IP Address assignments, and cannot access the unit over Ethernet, use the Initializing the IP Address
using CLI procedure. Once the IP Address is set, you can use the Ethernet Interface to complete configuration.

6. Perform the Soft Reset to Factory Defaults in this guide. This will reset the unit to “DHCP” mode. If there is a DHCP
Server on the network, the DHCP Server will assign an IP Address to the AP.

HTTP Interface or Telnet Interface Does Not Work
1. Make sure you are using a compatible browser:
— Microsoft Internet Explorer 6 with Service Pack 1 or later
— Netscape 7.1 or later

2. Make sure you have the proper IP address. Enter your Access Point’s IP Address in the browser address bar, similar
to this example:
http://192.168.1.100
When the Enter Network Password window appears, leave the User Name field empty and enter the HTTP
password in the Password field. The default HTTP password is public.

3. Use the CLI over the serial port to check the IP Access Table, which can be restricting access to Telnet and HTTP.

HTML Help Files Do Not Appear

1. Verify that the HTML Help files are installed in the default directory:
C:/Program Files/ORiINOCO/AP700/HTML.

If the Help files are not located in this folder, contact your network administrator to find out where the Help files are
located on your server.

2. Copy the entire folder to your Web server.
3. Perform the following steps to specify the path for the Help files:
a. Click the Commands button in the HTTP interface.
b. Select the Help tab located at the top of the screen.
c. Enter the pathname where the Help files are located in the Help Link box. This must be an HTTP address.
d. Click OK.

Telnet CLI Does Not Work

1. Make sure you have the proper IP Address. Enter your AP IP address in the Telnet connection dialog, from a DOS
prompt, type:
C:\> telnet <AP IP Address>

2. Use the CLI over the serial port to check the IP Access Table, which can be restricting access to Telnet and HTTP.

TFTP Server Does Not Work
1. Make sure the TFTP Server has been started.
2. Verify the IP address of the TFTP Server. The server may be local or remote, so long as it has a valid IP address.

3. Configure the TFTP Server to “point” to the folder containing the file to be downloaded (or to the folder in which the file
is to be uploaded).

4. Verify that you have entered the proper AP Image file name (including the file extension) and directory path (if
needed).
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5. If you have a problem uploading a file, verify that the TFTP server is configured to allow uploads (typically the default
setting is to allow only downloads).

Client Connection Problems

Client Software Finds No Connection

Make sure you have configured your client software with the proper Network Name and Security settings. Network
Names and WEP Keys are typically allocated and maintained by your network administrator.

Client PC Card Does Not Work
1. Make sure you are using the latest PC Card driver software.
2. Download and install the latest ORINOCO client software from http://support.proxim.com.

Intermittent Loss of Connection
1. Make sure you are within range of an active AP.
2. You can check the signal strength using the signal strength gauge on your client software.

Client Does Not Receive an IP Address - Cannot Connect to Internet

1. If the AP is configured as a DHCP server, open the Web-browser Interface and select the Configure button and then
the Network tab to make sure the proper DHCP settings are being used.

2. If you are not using the DHCP server feature on the AP, then make sure that your local DHCP server is accessible
from the Access Point’s subnet.

3. If using PoE, make sure you are not using a crossover Ethernet cable between the AP and the hub.

VLAN Operation Issues

Verifying Proper Operation of the VLAN Feature

The correct VLAN configuration can be verified by “pinging” both wired and wireless hosts from both sides of the AP
device and the network switch. Traffic can be “sniffed” on both the wired (Ethernet) and wireless (WDS) backbones (if
configured). Bridge frames generated by wireless clients and viewed on one of the backbones should contain IEEE
802.1Q compliant VLAN headers or tags. The VLAN ID in the headers should correspond to one of the VLAN User IDs
configured for the AP.

NOTE: The AP-700 supports 16 VLAN/SSID pairs, each with a configured security profile.

VLAN Workgroups

The correct VLAN assignment can be verified by pinging the AP to ensure connectivity, by pinging the switch to ensure
VLAN properties, and by pinging hosts past the switch to confirm the switch is functional. Ultimately, traffic can be
“sniffed” on the Ethernet or WDS interfaces (if configured) using third-party packages. Most problems can be avoided by
ensuring that 802.1Q compliant VLAN tags containing the proper VLAN ID have been inserted in the bridged frames. The
VLAN ID in the header should correspond to the user’s assigned network name.

What if network traffic is being directed to a nonexistent host?

» All sessions are disconnected, traffic is lost, and a Forced Reload is necessary.
*  Workaround: you can configure the switch to mimic the nonexistent host.

I have just configured the Management ID and now | can't manage the AP?

» Check to ensure your password is correct. If your password is incorrect or all inbound packets do NOT have the
correct tag, then a Forced Reload is necessary.
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CAUTION: The Forced Reload procedure disconnects all users and resets all values to factory defaults.

Power-Over-Ethernet (PoE)

The AP Does Not Work
1. Verify that you are using a standard UTP Category 5 cable.

2. Try a different port on the same PoE hub (remember to move the input port accordingly) — if it works, there is probably
a faulty port or bad RJ-45 port connection.

3. If possible, try to connect the AP to a different PoE hub.

4. Try using a different Ethernet cable — if it works, there is probably a faulty connection over the long cable, or a bad
RJ-45 connection.

5. Check power plug and hub.
6. If the Ethernet link goes down, check the cable, cable type, switch, and hub.

There Is No Data Link
1. Verify that the indicator for the port is “on.”
2. Verify that the PoE hub is connected to the Ethernet network with a good connection.

3. Verify that the Ethernet cable is Category 5 or better and is less than 100 meters (approximately 325 feet) in length
from the Ethernet source to the AP.

4. Try to connect a different device to the same port on the PoE hub — if it works and a link is established, there is
probably a faulty data link in the AP.

5. Try to re-connect the AP to a different output port (remember to move the input port accordingly) — if it works, there is
probably a faulty output or input port in the PoE hub or a bad RJ-45 connection.

“Overload” Indications
1. Verify that you are not using a cross-over cable between the PoE output port and the AP.
2. Verify that there is no short over any of the twisted pair cables.

3. Move the device into a different output port (remember to move the input port accordingly); if it works, there is
probably a faulty port or bad RJ-45 connection.
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Recovery Procedures

The most common installation problems relate to IP addressing. For example, without the TFTP server IP Address, you
will not be able to download a new AP Image to the AP. IP Address management is fundamental. We suggest you create
a chart to document and validate the IP addresses for your system.

If the password is lost or forgotten, you will need to reset the AP to default values. The Soft Reset to Factory Defaults and
Hard Reset to Factory Defaults procedures reset configuration settings, but do not change the current AP Image.

If the AP has a corrupted software image, follow the Forced Reload procedure to erase the current AP Image and
download a new image.

Soft Reset to Factory Defaults

Use this procedure to reset the network configuration values, including the password, IP address, and subnet mask. The
current AP Image is not deleted.

1. Click Commands > Reset.

2. Click Reset to Factory Default; the device is reset to its factory default state.

3. If not using DHCP, use the ScanTool or use CLI over a serial connection to set the IP address, subnet mask, and other
IP parameters. See Command Line Interface (CLI) for CLI information.

If you do not have access to the HTTP or CLI interfaces, use the procedure described in Hard Reset to Factory Defaults.

Hard Reset to Factory Defaults

If you cannot access the unit or you have lost its password, you can reset the unit to the factory default settings using the
Reload button on the unit, as described below.

1. Using the end of a paper clip or pin, depress and hold the Reload button on the back of the unit for a minimum of 5
seconds but no more than 10 seconds. The configuration is deleted from the unit and the unit reboots, using a factory
default configuration.

NOTE: You need to use a pin or the end of a paperclip to press the button.

CAUTION: If you hold the Reload button for longer than 20 seconds, you may go into Forced Reload mode, which
erases the unit’'s embedded software. This software must be reloaded through an Ethernet connection
with access to a TFTP server. See Forced Reload below for instructions.

2. If not using DHCP, use the ScanTool or use CLI over a serial connection to set the IP address, subnet mask, and other
IP parameters. See Command Line Interface (CLI) for CLI information.

Forced Reload

With Forced Reload, you bring the unit into bootloader mode by erasing the embedded software. Use this procedure only
as a last resort if the unit does not boot and the procedure did not help.

CAUTION: By completing this procedure, the embedded software in the AP will be erased. You will need to reload the
software before the unit is operational.

To do a forced reload:

1. While the unit is running, use a pin or the end of a paperclip to press the RESET button.
The AP reboots and the indicators begin to flash.

2. Press and hold the RELOAD button for about 20 seconds until the POWER LED turns amber.
The AP deletes the current AP Image.

3. Follow one of the procedures below to load a new AP Image to the Access Point:
— Download a New Image Using ScanTool
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— Download a New Image Using the Bootloader CLI

Because the CLI option requires a physical connection to the unit’s serial port, Proxim recommends the ScanTool
option.

Download a New Image Using ScanTool

To download the AP Image, you will need an Ethernet connection to the computer on which the TFTP server resides and
to a computer that is running ScanTool (this is either two separate computers connected to the same network or a single
computer running both programs).

ScanTool detects if an Access Point does not have a valid software image installed. In this case, the TFTP Server and
Image File Name parameters are enabled in the ScanTool's Change screen so you can download a new image to the
unit. (These fields are grayed out if ScanTool does not detect a software image problem.)

Preparing to Download the AP Image

Before starting, you need to know the Access Point’s IP address, subnet mask, the TFTP Server IP Address, and the AP
Image file name. Make sure the TFTP server is running and configured to point to the folder containing the image to be
downloaded.

Download Procedure
Follow these steps to use ScanTool to download a software image to an Access Point with a missing image:

Download the latest software from http://support.proxim.com.

Copy the latest software updates to your TFTP server.

Launch ScanTool.

Highlight the entry for the AP you want to update and click Change.
Set IP Address Type to Static.

PO =

NOTE: You need to assign static IP information temporarily to the Access Point since its DHCP client functionality is not
available when no image is installed on the device.

5. Enter an unused IP address that is valid on your network in the IP Address field. You may need to contact your
network administrator to get this address.
6. Enter the network’s Subnet Mask in the field provided.

7. Enter the network’s Gateway IP Address, if necessary. You may need to contact your network administrator to get
this address. You should only need to enter the default gateway address (169.254.128.133) if the Access Point and
the TFTP server are separated by a router.

8. Enter the IP address of your TFTP server in the field provided.

9. Enter the Image File Name (including the file extension). Enter the full directory path and file name. If the file is
located in the default TFTP directory, you need enter only the file name.

10.Click OK.

The Access Point will reboot and the download will begin automatically. You should see downloading activity begin
after a few seconds within the TFTP server’s status screen.

11.Click OK when prompted that the device has been updated successfully to return to the Scan List screen.
12.Click Cancel to close the ScanTool.
13.When the download process is complete, configure the AP.

Download a New Image Using the Bootloader CLI

To download the AP Image, you will need an Ethernet connection to the computer on which the TFTP server resides.
This can be any computer on the LAN or connected to the AP with a cross-over Ethernet cable.
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You must also connect the AP to a computer with a standard serial cable and use a terminal client, such as
HyperTerminal. From the terminal, enter CLI Commands to set the IP address and download an AP Image.

Preparing to Download the AP Image

Before starting, you need to know the Access Point’s IP address, subnet mask, the TFTP Server IP Address, and the AP
Image file name. Make sure the TFTP server is running and configured to point to the folder containing the image to be
downloaded.

Download Procedure

1.

Download the latest software from http://support.proxim.com.

2. Copy the latest software updates to your TFTP server’s default directory.
3.
4. Open your terminal emulation program (like HyperTerminal) and set the following connection properties:

Use a straight-through serial cable to connect the Access Point’s serial port to your computer’s serial port.

*  Com Port: <COM1, COM2, etc., depending on your computer>
* Baud rate: 9600

» Data Bits: 8

»  Stop bits: 1

* Flow Control: None

* Parity: None

. Under File > Properties > Settings > ASCII Setup, enable the Send line ends with line feeds option.

HyperTerminal sends a line return at the end of each line of code.
Press the RESET button on the AP.

The terminal display shows Power On Self Tests (POST) activity. After approximately 30 seconds, a message
indicates: Sending Traps to SNMP manager periodically. After this message appears, press the ENTER key
repeatedly until the following prompt appears:

[Device name]>

Enter only the following statements:

Device name]> show (to view configuration parameters and values)
Device name set ipaddrtype static

set ipaddr <Access Point IP Address>
set ipsubmask <IP Mask>

set tftpipaddr <TFTP Server IP Address>

>
Device name]>
>
>
> set tftpfilename <AP Image File Name, including file extension>
>
>
>

Device name

Device name

Device name set ipgw <Gateway IP Address>

Device name

[ ]
[ ]
[ ]
[ ]
[Device name]
[ ]
[ ]
[ 1> show (to confirm your new settings)
[ ]

Device name reboot

Example:

[Device name]> show

[Device name]> set ipaddrtype static
[Device name]> set ipaddr 10.0.0.12

[Device name]> set ipsubmask 255.255.255.0
[Device name]> set tftpipaddr 10.0.0.20
[Device name]> set tftpfilename MyImage.bin
[Device name]> set ipgw 10.0.0.30

[Device name]> show
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[Device name]> reboot

The AP will reboot and then download the image file. You should see downloading activity begin after a few seconds
within the TFTP server’s status screen.

8. When the download process is complete, configure the AP.

Setting IP Address using Serial Port

Use the following procedure to set an IP address over the serial port using the CLI. The network administrator typically
provides the AP IP address.

Hardware and Software Requirements
» Standard straight-through serial data (RS-232) cable (not included with shipment).
» ASCII Terminal software, such as HyperTerminal.

Attaching the Serial Port Cable
1. Connect one end of the serial cable to the AP and the other end to a serial port on your computer.
2. Power on the computer and AP, if necessary.

Initializing the IP Address using CLI

After installing the serial port cable, you may use the CLI to communicate with the AP. CLI supports most generic terminal
emulation programs, such as HyperTerminal (which is included with the Windows operating systems). In addition, many
web sites offer shareware or commercial terminal programs you can download. Once the IP address has been assigned,
you can use the HTTP interface or the CLI over Telnet to complete configuration.

Follow these steps to assign the AP an IP address:

1. Open your terminal emulation program (like HyperTerminal) and set the following connection properties:
*  Com Port: <COM1, COM2, etc., depending on your computer>
* Baud rate: 9600
» Data Bits: 8
»  Stop bits: 1
*  Flow Control: None
* Parity: None
2. Under File > Properties > Settings > ASCII Setup, enable the Send line ends with line feeds option.
HyperTerminal sends a line return at the end of each line of code.
3. Press the RESET button on the AP.

The terminal display shows Power On Self Tests (POST) activity, and then displays a CLI prompt, similar to the
example below. This process may take up to 90 seconds.

[Device name]> Please enter password:

4. Enter the CLI password (default is public).
The terminal displays a welcome message and then the CLI Prompt:
[Device name]>

5. Enter show ip. Network parameters appear:
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[Device Namel> show ip
IP/Network Group Parameters

ipadde e 1A.8.8.1
ipsubmask S 255.8.8.8
ipgw 2 18.8.8.1
ipttl H 64
ipaddrtype 2 static

[Device Namel> _

Figure 7-1 Result of “show ip” CLI Command

6. Change the IP address and other network values using set and reboot CLI commands, similar to the example below
(use your own IP address and subnet mask). Note that IP Address Type is set to Dynamic by default. If you have a
DHCP server on your network, you should not need to manually configure the Access Point’s IP address; the Access
Point will obtain an IP address from the network’s DHCP server during boot-up.

After each entry the CLI reminds you to reboot; however wait to reboot until all commands have been entered.
Device name]>set ipaddrtype static
Device name]> set ipaddr <IP Address>

]

]
Device name]>set ipsubmask <IP Subnet Mask>
Device name]>set ipgw <Default Gateway IP Address>
]

[
[
[
[
[Device name]>show ip (to confirm your new settings)
[Device name]> reboot 0

7. After the AP reboots, verify the new IP address by reconnecting to the CLI and enter a show ip command.
Alternatively, you can ping the AP from a network computer to confirm that the new IP address has taken effect.

8. When the proper IP address is set, use the HTTP interface or CLI over Telnet to configure the rest of the unit’s
operating parameters.
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Related Applications

RADIUS Authentication Server

If you enabled RADIUS Authentication on the AP, make sure that your network’s RADIUS servers are operational.
Otherwise, clients will not be able to log in. There are several reasons the authentication server services might be
unavailable, here are two typical things to check:

» Make sure you have the proper RADIUS authentication server information setup configured in the AP. Check the
RADIUS Authentication Server’s Shared Secret and Destination Port number (default is 1812; for RADIUS
Accounting, the default is 1813).

» Make sure the RADIUS authentication server RAS setup matches the AP.

TFTP Server

The “Trivial File Transfer Protocol” (TFTP) server allows you to transfer files across a network. You can upload
configuration files from the AP for backup or copying, and you can download configuration files or new software images.
The TFTP software is located on the installation CD.

If a TFTP server is not configured and running, you will not be able to download and upload images and configuration
files to/from the AP. Remember that the TFTP server does not have to be local, so long as you have a valid TFTP IP
address. Note that you do not need a TFTP server running unless you want to transfer files to or from the AP.

After the TFTP server is installed:

» Check to see that TFTP is configured to point to the directory containing the AP Image.

* Make sure you have the proper TFTP server IP Address, the proper AP Image file name, and that the TFTP server is
connected.

» Make sure the TFTP server is configured to both Transmit and Receive files (on the TFTP server’s Security tab), with
no automatic shutdown or time-out (on the Auto Close tab).
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This section discusses the following:

General Notes

Command Line Interface (CLI) Variations
CLI Command Types

Using Tables and Strings

Configuring the AP using CLI commands
CLI Monitoring Parameters

Parameter Tables

CLI Batch File

CLI commands can be used to initialize, configure, and manage the Access Point.

CLI commands may be entered in real time through a keyboard or submitted with CLI scripts.

A CLI Batch file is a user-editable configuration file that provides a user-friendly way to change the AP configuration
through a file upload. The CLI Batch file is an ASCII file that facilitates Auto Configuration because it does not require
the user to access one of the AP’s management interfaces to make configuration changes as is required with the
proprietary LTV format configuration file.

The CLI is available through both the Serial Port interface and over the Ethernet interface using Telnet.

NOTE: All CLI commands and parameters are case-sensitive.
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General Notes

Prerequisite Skills and Knowledge

To use this document effectively, you should have a working knowledge of Local Area Networking (LAN) concepts,
network access infrastructures, and client-server relationships. In addition, you should be familiar with software setup
procedures for typical network operating systems and servers.

Notation Conventions

Computer prompts are shown as constant width type. For example: [Device-Name] >

Information that you input as shown is displayed in bold constant width type. For example:
[Device name]> set ipaddr 10.0.0.12

The names of keyboard keys, software buttons, and field names are displayed in bold type. For example: Click the
Configure button.

Screen names are displayed in bold italics. For example, the System Status screen.

Important Terminology

Configuration Files - Database files containing the current Access Point configuration. Configuration items include the
IP Address and other network-specific values. Config files may be downloaded to the Access Point or uploaded for
backup or troubleshooting.

Download vs. Upload - Downloads transfer files to the Access Point. Uploads transfer files from the Access Point. The
TFTP server performs file transfers in both directions.

Group - A logical collection of network parameter information. For example, the System Group is composed of several
related parameters. Groups can also contain Tables. All items for a given Group can be displayed with a show
<Group> CLI Command.

Image File - The Access Point software executed from RAM. To update an Access Point you typically download a new
Image File. This file is often referred to as the “AP Image”.

Parameter - A fundamental network value that can be displayed and may be changeable. For example, the Access
Point must have a unique IP Address and the Wireless interface must be assigned an SSID. Change parameters with
the CLI set Command, and view them with the CLI show Command.

Table - Tables hold parameters for several related items. For example, you can add several potential managers to the
SNMP Table. All items for a given Table can be displayed with a show <Table> CLI Command.

TFTP - Refers to the TFTP Server, used for file transfers.

Navigation and Special Keys

This CLI supports the following navigation and special key functions to move the cursor along the prompt line.

Key Combination Operation
Delete or Backspace Delete previous character
Ctrl-A Move cursor to beginning of line
Ctrl-E Move cursor to end of line
Ctrl-F Move cursor forward one character
Ctrl-B Move cursor back one character
Ctrl-D Delete the character the cursor is on
Ctrl-U Delete all text to left of cursor
Ctrl-P Go to the previous line in the history buffer
Ctrl-N Go to the next line in the history buffer
Ctrl-W Delete the previous word
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Key Combination Operation
Tab Complete the command line
? List available commands

CLI Error Messages

The following table describes the error messages associated with improper inputs or expected CLI behavior.

Error Message Description

Syntax Error Invalid syntax entered at the command prompt.

Invalid Command A non-existent command has been entered at the command prompt.

Invalid Parameter Name An invalid parameter name has been entered at the command prompt.

Invalid Parameter Value An invalid parameter value has been entered at the command prompt.

Invalid Table Index An invalid table index has been entered at the command prompt.

Invalid Table Parameter An invalid table parameter has been entered at the command prompt.

Invalid Table Parameter Value |An invalid table parameter value has been entered at the command prompt.

Read Only Parameter User is attempting to configure a read-only parameter.

Incorrect Password An incorrect password has been entered in the CLI login prompt.

Download Unsuccessful The download operation has failed due to incorrect TFTP server IP Address or file
name.

Upload Unsuccessful The upload operation has failed due to incorrect TFTP server IP Address or file
name.
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Command Line Interface (CLI) Variations

Administrators use the CLI to control Access Point operation and monitor network statistics. The AP supports two types
of CLI: the Bootloader CLI and the normal CLI. The Bootloader CLI provides a limited command set, and is used when
the current AP Image is bad or missing. The Bootloader CLI allows you to assign an IP Address and download a new
image. Once the image is downloaded and running, the Access Point uses the normal CLI. This guide covers the normal
CLI unless otherwise specified.

Bootloader CLI

The Bootloader CLI is a minimal subset of the normal CLI used to perform initial configuration of the AP. This interface is
only accessible via the serial interface if the AP does not contain a software image or a download image command over
TFTP has failed.

The Bootloader CLI provides you with the ability to configure the initial setup parameters as well as download a software
image to the device.

The following functions are supported by the Bootloader CLI:

» configuration of initial device parameters using the set command

* show command to view the device’s configuration parameters

* help command to provide additional information on all commands supported by the Bootloader CLI
* reboot command to reboot the device

The parameters supported by the Bootloader CLI (for viewing and modifying) are:
» System Name

* |IP Address Assignment Type

* |P Address

* |P Mask

* Gateway IP Address

* TFTP Server IP Address

* Image File Name (including the file extension)

The following lists display the results of using the help command in the Bootloader CLI:

[Device namel> help

Command List Description

set Set system parameters

show Show running system information

help Description of commands. command usage and parameters
reboot reboot the target

Command Usage

set <{parameter name> {parameter value> <{cr’>
show <{cr>

help <ce>

rehoot <{cr>

Parameter List Description

sysname System Name

ipaddr System IP Address

ipsubmask System Subnet Mask

ipgw System Default Gateway IP Address
tftpipaddr TFTP Server IP Address

tftpfilename Image or Binary File name

ipaddrtype System IP Address Type — STATIC or DYNAMIC

[Device namel>

Figure A-1 Results of “help” bootloader CLI command

The following lists display the results of using the show command in the Bootloader CLI:
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[Device namel> show

sysname Device System Name

ipaddr 1A.8.8.1 System IP Address

ipsubmask 255.8.8.8 System Subnet Mask

ipgw 1A8.8.8.1 System Default Gateway IP Address
ipaddrtype DYNAMIC IP Address type

tftpipaddr 1A.8.8.2 TFTP Server IP Address
tftpfilename FILENAME Image or Binary File Name

[Device namel>

Figure A-2 Results of “show” bootloader CLI command
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CLI Command Types

This guide divides CLI Commands into two categories: Operational and Parameter Controls.

Operational CLI Commands

These commands affect Access Point behavior, such as downloading, rebooting, and so on. After entering commands
(and parameters, if any) press the Enter key to execute the Command Line.

Operational commands include:

» ?: Typing a question mark lists CLI Commands or parameters, depending on usage (you do not need to type Enter
after typing this command)

* done, exit, quit: Terminates the CLI session

» download: Uses a TFTP server to download “image” files, “config” files, “bootloader upgrade” files, a “license” file,

“SSL certificates”, “SSL private keys”, “SSH public keys”, “SSH private keys”, or “CLI Batch Files” to the Access Point
* help: Displays general CLI help information or command help information, such as command usage and syntax
* history: Remembers commands to help avoid re-entering complex statements
» passwd: Sets the Access Point’s CLI password
* reboot: Reboots the Access Point in the specified time
» search: Lists the parameters in a specified Table
» upload: Uses TFTP server to upload “config” files from Access Point to TFTP default directory or specified path

? (List Commands)
This command can be used in a number of ways to display available commands and parameters.

The following table lists each operation and provides a basic example. Following the table are detailed examples and
display results for each operation.

Operation Basic Example
Display the Command List (Example 1) [Device-Name]>?
Display commands that start with specified letters [Device-Name]>s?
(Example 2)
Display parameters for set and show Commands [Device-Name] >set ?
(Examples 3a and 3b) [Device-Name] >show ipa?
Prompt to enter successive parameters for [Device-Name] >download ?
Commands (Example 4)

Example 1. Display Command list
To display the Command List, enter ?.

[Device-Name] >?

[Device Mamel>
show

set

down load
upload

rehoot

passwd

help

quit

done

exit

history

search

[Device Namel> _

Figure A-3 Result of “?” CLI command
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Example 2. Display specific Commands

To show all commands that start with specified letters, enter one or more letters, then ? with no space between letters
and ?.

[Device-Name]>s?

[Device Mamel> s
show set search

Figure A-4 Result of “s?” CLI command

Example 3. Display parameters for set and show

Example 3a allows you to see every possible parameter for the set (or show) commands. Notice from example 3a that
the list is very long. Example 3b shows how to display a subset of the parameters based on initial parameter letters.

Example 3a. Display every parameter that can be changed

[Device-Name] >set ?

[Device Mamel> set
Command Description:
The set command modifies the value of a given scalar parameter or tahle entry.

Command Usage:
set {parameter> {parameter value> <CR>
set <table> <{index> <argl> <valuel> ..... <argN> <valueN> <{CR>

Example :

set sysname "My Wireless Device' {CR>

set mgmtipaccessthl B ipaddr 18.8.8.18 ipmask 255.255.8.8 cmt "Test WorkStation"
<CR>

[Device Mamel> set
broadcastfltthl
dhcpgw
dhcpippoolthl
dhcppridns ipaddr
dhcpsecdns ipaddr
dhcpstatus
dnsdomainname
dnsprisvripaddr
dnssecsvripaddr
dnsstatus
etherfltifhitmask

telsessiontout
tftpfilename
tftpfiletype
tftpipaddr
vlanidthl
vlanmgmtid
vlanstatus
wdsthl

wif

wifsec

[Device Mamel> set

Figure A-5 Result of “set ?” CLI command

Example 3b. Display parameters based on letter sequence

This example shows entries for parameters that start with the letter “i”. The more letters you enter, the fewer the results
returned. Notice that there is no space between the letters and the question mark.

[Device-Name] > show ipa?

[Device Namel> show ipa
ipaddr ipaddrtype iparp
iparpf ltipaddr iparpfltstatus iparpf ltsubmask

Figure A-6 Result of “show ipa?” CLI command

[Device-Name] > show iparp?
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[Device Namel> show iparp

iparp iparpf ltipaddr iparpfltstatus
iparpf ltsubmask

[Device Namel> show iparp_

Figure A-7 Result of “show iparp?” CLI command

Example 4. Display Prompts for Successive Parameters

Enter the command, a space, and then ?. Then, when the parameter prompt appears, enter the parameter value. The
parameter is changed and a new CLI line is echoed with the new value (in the first part of the following example, the
value is the IP Address of the TFTP server).

After entering one parameter, you may add another ? to the new CLI line to see the next parameter prompt, and so on

until you have entered all of the required parameters. The following example shows how this is used for the download
Command. The last part of the example shows the completed download Command ready for execution.

[Device-Name] > download ?
<TFTP IP Address>

[Device-Name] > download 192.168.0.101 ?

<File Name>

[Device-Name] > download 192.168.0.101 apimage ?
<file type (config/img/bootloader)>

[Device-Name] > download 192.168.0.101 apimage img <CR>

done, exit, quit
Each of the following commands ends a CLI session:

[Device-Name] > done
[Device-Name] > exit
[Device-Name]> quit

download

Downloads the specified file from a TFTP server to the Access Point. Executing download in combination with the
asterisks character (“*”) will make use of the previously set TFTP parameters. Executing download without parameters

will display command help and usage information.
1. Syntax to download a file:
[Device-Name]>download <tftp server address> <path and filename> <file type>

Example:
[Device-Name] >download 192.168.1.100 APImage2 img

2. Syntax to display help and usage information:
[Device-Name] >download

3. Syntax to execute the download Command using previously set (stored) TFTP Parameters:
[Device-Name] >download *
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help

Displays instructions on using control-key sequences for navigating a Command Line and displays command information
and examples.

1. Using help as the only argument:
[Device-Name] >help

[Device Namel> help
Type ? at the command prompt for a command list.

Complete command description and command usage can be provided hy:
help <command name> <{CR>
<command name> help <CR>

Special keys supported:
Arrow Keys

DEL. BS .... delete previous character
Ctrl-A .... go to beginning of line
Ctrl-E .... go to end of line
Ctrl-F .... go forward one character
Ctrl-B .... go backward one character
Ctrl-D .... delete current character
Ctrl-U. ¥ .. delete to beginning of line
Ctrl-K .... delete to end of line
Cterl-W ..... delete previous word
Ctrl=-T .oco:oc transpose previous character
Ctrl-P .... go to previous line in history buffer
Ctrl-N .... go to next line in history buffer
Tahb we-- will attempt command completion
# .... Comment Character
? we-- will provide command listing
Examples:
ry list all the supported commands
*sh?! list all commands that start with sh
*show ?7* list all arguments to the show command
*sh{TAB>* complete the ‘show’ command

[Device Mamel>

Figure A-8 Results of “help” CLI command

2. Complete command description and command usage can be provided by:
[Device-Name] >help <command name>
[Device-Name] ><command name> help

history

Shows content of Command History Buffer. The Command History Buffer stores command statements entered in the
current session. To avoid re-entering long command statements, use the keyboard “up arrow” (Ctrl-P) and “down arrow”
(Ctrl-N) keys to recall previous statements from the Command History Buffer. When the desired statement reappears,
press the Enter key to execute, or you may edit the statement before executing it.

[Device—-Name] > history

passwd
Changes the CLI Password.

[Device-Name] > passwd oldpassword newpassword newpassword

reboot
Reboots Access Point after specified number of seconds. Specify a value of 0 (zero) for immediate reboot.

[Device-Name]> reboot 0
[Device-Name] > reboot 30
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search

Lists the parameters supported by the specified table. This list corresponds to the table information displayed in the
HTTP interface. In this example, the CLI returns the list of parameters that make up an entry in the IP Access Table.

[Device-Name] > search mgmtipaccesstbl

[Device Mamel> search mgmtipaccessthl
The supported elements are:

index

ipaddr

ipmask

cmt

status

Figure A-9 Results of “search mgmtipaccesstbl” CLI command

upload

Uploads a text-based configuration file from the AP to the TFTP Server. Executing upload with the asterisk character
(“*”) will make use of the previously set/stored TFTP parameters. Executing upload without parameters will display
command help and usage information.

1. Syntax to upload a file:
[Device-Name] >upload <tftp server address> <path and filename> <filetype>

Example:
[Device-Name] >upload 192.168.1.100 APconfig.sys config

2. Syntax to display help and usage information:
[Device-Name] >help upload

3. Syntax to execute the upload command using previously set (stored) TFTP Parameters:
[Device-Name] >upload *

Parameter Control Commands

The following sections cover the two Parameter Control Commands (show and set) and include several tables showing
parameter properties. These commands allow you to view (show) all parameters and statistics and to change (set)
parameters.

» show: To see any Parameter or Statistic value, you can specify a single parameter, a Group, or a Table.

» set: Use this CLI Command to change parameter values. You can use a single CLI statement to modify Tables, or
you can modify each parameter separately.

“show” CLI Command

Displays the value of the specified parameter, or displays all parameter values of a specified group (parameter table).
Groups contain Parameters and Tables. Tables contain parameters for a series of similar entities.

To see a definition and syntax example, type only show and then press the Enter key. To see a list of available
parameters, enter a question mark (?) after show (example: show ?).

Syntax:

[Device-Name] >show <parameter>
[Device-Name] >show <group>
[Device-Name] >show <table>

Examples:
[Device-Name] >show ipaddr
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[Device-Name] >show network
[Device-Name] >show mgmtipaccesstbl
“set” CLI Command

Sets (modifies) the value of the specified parameter. To see a definition and syntax example, type only set and then
press the Enter key. To see a list of available parameters, enter a space, then a question mark (?) after set (example:
set?).

Syntax:
[Device-Name] >set <parameter> <value>
[Device-Name] >set <table> <index> <argument 1> <value 1> ... <argument N> <value N>

Example:

[Device-Name] >set sysloc “Main Lobby”
[Device-Name] >set mgmtipaccesstbl 0 ipaddr 10.0.0.10 ipmask 255.255.0.0

Configuring Objects that Require Reboot
Certain objects supported by the Access Point require a device reboot in order for the changes to take effect. In order to
inform the end-user of this behavior, the CLI provides informational messages when the user has configured an object
that requires a reboot. The following messages are displayed as a result of the configuring such object or objects.
Example 1: Configuring objects that require the device to be rebooted
The following message is displayed every time the user has configured an object that requires the device to be rebooted.

[Device-Name] >set ipaddr 135.114.73.10
The following elements require reboot

ipaddr

Example 2: Executing the “exit”, “quit”, or “done” commands when an object that requires reboot has been
configured

In addition to the above informational message, the CLI also provides a message as a result of the exit, quit, or done
command if changes have been made to objects that require reboot. If you make changes to objects that require reboot
and execute the exit command the following message is displayed:

[Device-Name] >exit<CR> OR quit<CR> OR done<CR>
Modifications have been made to parameters that require the device to be rebooted. These changes will only take effect after the next reboot.

“set” and “show” Command Examples

In general, you will use the CLI show Command to view current parameter values and use the CLI set Command to
change parameter values. As shown in the following examples, parameters may be set individually or all parameters for
a given table can be set with a single statement.

Example 1 - Set the Access Point IP Address Parameter
Syntax:

[Device-Name] >set <parameter name> <parameter value>

Example:
[Device-Name] > set ipaddr 10.0.0.12

IP Address will be changed when you reboot the Access Point. The CLI reminds you when rebooting is required for a
change to take effect. To reboot immediately, enter reboot 0 (zero) at the CLI prompt.
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Example 2 - Create a table entry or row

Use 0 (zero) as the index to a table when creating an entry. When creating a table row, only the mandatory table
elements are required (comment is usually an optional table element). For optional table elements, the default value is
generally applied if you do not specify a value.

Syntax:
[Device-Name] >set <table name> <table index> <element 1> <value 1> ..
<element n> <value n>

Example:
[Device-Name] > set mgmtipaccesstbl 0 ipaddr 10.0.0.10 ipmask 255.255.0.0

A new table entry is created for IP address 10.0.0.10 with a 255.255.0.0 subnet mask.

Example 3 - Modify a table entry or row

Use the index to be modified and the table elements you would like to modify. For example, suppose the IP Access Table
has one entry and you wanted to modify the IP address:

[Device-Name] >set mgmtipaccesstbl 1 ipaddr 10.0.0.11

You can also modify several elements in the table entry. Enter the index number and specific table elements you would
like to modify. (Hint: Use the search Command to see the elements that belong to the table.)

[Device-Name] >set mgmtipaccesstbl 1 ipaddr 10.0.0.12 ipmask 255.255.255.248
cmt “First Row”

Example 4 - Enable, Disable, or Delete a table entry or row
The following example illustrates how to manage the second entry in a table.

Syntax:
[Device-Name] >set <Table> index status <enable, disable, delete>
[Device-Name] >set <Table> index status <l=enable, 2=disable, 3=delete>

Example:
[Device-Name
[Device-Name
[Device-Name
[Device-Name

>set mgmtipaccesstbl 2 status enable
>set mgmtipaccesstbl 2 status disable
>set mgmtipaccesstbl 2 status delete
>set mgmtipaccesstbl 2 status 2

[

NOTE: You may need to enable a disabled table entry before you can change the entry’s elements.

Example 5 - Show the Group Parameters
This example illustrates how to view all elements of a group or table.
Syntax:

[Device-Name] > show <group name>

Example:
[Device-Name] >show network

The CLI displays network group parameters. Note show network and show ip return the same data.
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[Device Mamel> show network
IP/Network Group Parameters

ipadder o 1A.8.8.1
ipsubmask H 255.8.8.8
ipgw H 1i8.8.8.1
ipttl £ 64
ipaddrtype H static

[Device Namel> show ip
IP/Network Group Parameters

ipadde £ 1A.8.8.1
ipsubmask H 255.8.8.8
ipgw H 1i8.8.8.1
ipttl o 64
ipaddrtype H static

[Device Namel> _

Figure A-10 Results of “show network” and “show ip” CLI Commands

Example 6 - Show Individual and Table Parameters
1. View a single parameter.

Syntax:
[Device-Name] >show <parameter name>

Example:
[Device-Name] > show ipaddr

Displays the Access Point IP address.

[Device Namel> show ipaddr
ipaddr

18.8.8.1

[Device Namel> _

Figure A-11 Result of “show ipaddr” CLI Command

2. View all parameters in a table.

Syntax:
[Device-Name]> show <table name>
Example: [Device-Name] > show mgmtipaccesstbl

The CLI displays the IP Access Table and its entries.
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Using Tables and Strings

Working with Tables

Each table element (or parameter) must be specified, as in the example below.

[Device-Name] >set mgmtipaccesstbl 0 ipaddr 10.0.0.10 ipmask 255.255.0.0

Below are the rules for creating, modifying, enabling/disabling, and deleting table entries.

Creation

— The table name is required.

— The table index is required — for table entry/instance creation the index is always zero (0).

— The order in which the table arguments or objects are entered in not important.

— Parameters that are not required can be omitted, in which case they will be assigned the default value.
Modification

— The table name is required.

— The table index is required — to modify the table, “index” must be the index of the entry to be modified.
— Only the table objects that are to be modified need to be specified. Not all the table objects are required.
— If multiple table objects are to be modified the order in which they are entered is not important.

— If the entire table entry is to be modified, all the table objects have to be specified.

Enabling/Disabling

— The table name is required.

— The table index is required — for table enabling/disabling the index should be the index of the entry to be
enabled/disabled.

— The entry’s new state (either “enable” or “disable”) is required.

Deletion

— The table name is required.

— The table index is required — for table deletion the index should be the index of the entry to be deleted.
— The word “delete” is required.

Using Strings

Since there are several string objects supported by the AP, a string delimiter is required for the strings to be interpreted
correctly by the command line parser. For this CLI implementation, the single quote or double quote character can be
used at the beginning and at the end of the string.

For example:
[Device-Name] > set sysloc Lobby - Does not need quote marks
[Device-Name] > set sysloc “Front Lobby” - Requires quote marks.

The scenarios supported by this CLI are:

“My Desk in the office” Double Quotes

‘My Desk in the office’ Single Quotes

“My ‘Desk’ in the office” Single Quotes within Double Quotes
‘My “Desk” in the office’ Double Quotes within Single Quotes
“Daniel’s Desk in the office” One Single Quote within Double Quotes
‘Daniel’s Desk in the office’ One Double Quote within Single Quotes
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The string delimiter does not have to be used for every string object. The single quote or double quote only has to be
used for string objects that contain blank space characters. If the string object being used does not contain blank spaces,
then the string delimiters, single or double quotes, mentioned in this section are not required.
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Configuring the AP using CLI commands

Log into the AP using HyperTerminal

1. Open your terminal emulation program (like HyperTerminal) and set the following connection properties:
+ Com Port: <COM1, COM2, etc., depending on your computer>
+ Baud rate: 9600
+ Data Bits: 8
+  Stop bits: 1
*  Flow Control: None
* Parity: None
2. Under File > Properties > Settings > ASCII Setup, enable the Send line ends with line feeds option.
HyperTerminal sends a line return at the end of each line of code.
3. Enter the CLI password (default is public).

NOTE: Proxim recommends changing your default passwords immediately. To perform this operation using CLI
commands, see Change Passwords.

Log into the AP using Telnet
The CLI commands can be used to access, configure, and manage the AP using Telnet. Follow these steps:
1. Confirm that your computer’s IP address is in the same IP subnet as the AP.

NOTE: If you have not previously configured the Access Point’s IP address and do not have a DHCP server on
the network, the Access Point will default to an IP address of 169.254.128.132.
2. Go to the DOS command prompt on your computer.
3. Type telnet <IP Address of the unit>.
4. Enter the CLI password (default is public).

NOTE: Proxim recommends changing your default passwords immediately. To perform this operation using CLI
commands, see Change Passwords.
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Set Basic Configuration Parameters using CLI Commands

There are a few basic configuration parameters that you may want to setup right away when you receive the AP. For
example:

» Set System Name, Location and Contact Information

» Set Static IP Address for the AP

* Download an AP Configuration File from your TFTP Server

» Set up Auto Configuration

» Set Network Names for the Wireless Interface

* Enable 802.11d Support and Set the Country Code

* Enable and Configure TX Power Control for the Wireless Interface
» Configure SSIDs (Network Names), VLANSs, and Profiles

* Download an AP Configuration File from your TFTP Server

» Backup your AP Configuration File

Set System Name, Location and Contact Information

NOTE: System name must:
» Contain only letters, numbers, and hyphens.
* Be limited to 31 characters.
* Not begin with a number or hyphen.
* Not contain blank spaces.

[Device-Name] >set sysname <Name> sysloc <Unit Location>
[Device-Name] >set sysctname <Contact Name>

[Device-Name] >set sysctphone <Contact Phone Number> sysctemail <Contact E-mail address>
[Device-Name] >show system

[Device Namel> show system
System Parameters

sysname s Device

sysloc s System Location
sysctname = Contact Hame

sysctemail s namel@0rganization.com
sysctphone = Contact Phone Number
sysuptime (DD:HH:MM:858> : B:11: 6:48

sysoid 5 1.3.6.1.4.1.11898.2.4.6
sysdescr = AP v3.3.8 SH-82UT165768684 v3.1.9
sysservices = 2

sysf lashupdate s a

sysf lashbckint = 128

sysresettodefaults a

[Device Namel> _

Figure A-12 Result of “show system” CLI Command

Set Static IP Address for the AP
NOTE: The IP Subnet Mask of the AP must match your network’s Subnet Mask.

[Device-Name] >set ipaddrtype static
[Device-Name] >set ipaddr <fixed IP address of unit>
[Device-Name] >set ipsubmask <IP Mask>
[Device-Name] >set ipgw <gateway IP address>
[Device-Name] >show network

Change Passwords

[Device-Name] >passwd <O0ld Password> <New Password> <Confirm Password> (CLI password)
[Device-Name] >set httppasswd <New Password> (HTTP interface password)
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[Device-Name] >set snmprpasswd <New Password> (SNMP read password)
[Device-Name] >set snmprwpasswd <New Password> (SNMP read/write)

[Device-Name] >set snmpv3authpasswd <New Password> (SNMPv3 authentication password)
[Device-Name] >set snmpv3privpasswd <New Password> (SNMPv3 privacy password)
[Device-Name]>reboot 0

CAUTION: Proxim strongly urges you to change the default passwords to restrict access to your network devices to
authorized personnel. If you lose or forget your password settings, you can always perform the Soft Reset to
Factory Defaults.

Set Network Names for the Wireless Interface

[Device-Name] >set wif 3 netname <Network Name (SSID) for wireless interface>
[Device-Name] >show wif

[Device Hame]> show wif

Wireless Interface Table

Index 2 3

Hetwork Hame 5 My Wireless Hetwork A
Distance Between APs = large

Interference Robustness z disable

DTIH Period : 1

Automatic Channel Selection : enable

Frequency Channel z 56

RTS/CTS Medium Reservation : 2347

Hulticast Rate H 2 HBps

Closed System i disable

Load Balancing 2 enable

Hedium Density Distribution 2 disable

HAC Address i 88:30:F1:65:A9:E9
Supported Data Rates % 6 9 12 18 24 36 48 54
Supported Frequency Channels z 52 56 60 64 36 40 4% 48 149 153 157 161
Physical Layer Type : OFDH

Regulatory Domain List i UsSA (FCC)

Transmit Rate 2 5}

TurboHode : disable

Figure A-13 Results of “show wif’ CLI command for an AP

Enable 802.11d Support and Set the Country Code
NOTE: On APs with model numbers ending in -WD, these commands are not available.
Perform the following command to enable 802.11d IEEE 802.11d support for additional regulatory domains.
[Device-Name]>set wif 3 dotlldstatus <enable/disable>
Perform the following command to set a country code:
[Device-Name] >set syscountrycode <country code>

Select a country code from the following table, derived from ISO 3166. Available countries will vary based on regulatory
domain. Refer to the ISO/IEC 3166-1 CountryCode drop-down menu on the Configure > Interfaces > Operational
Mode page; this menu contains a list of all the available countries in your regulatory domain.

NOTE: If you select a country code that is not supported in your regulatory domain, clients may attempt to connect to a
channel that is not supported by your AP.

Country Code Country Code Country Code
Algeria DZ Honduras HN Panama PA
Albania AL Hong Kong HK Papua New Guinea PG
Argentina AR Hungary HU Peru PE
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Country Code Country Code Country Code
Armenia AM Iceland IS Philippines PH
Australia AU India IN Poland PL
Austria AT Indonesia ID Portugal PT
Azerbaijan AZ Ireland 5.8 GHz 11 Puerto Rico PR
Bahrain BH Israel IL Qatar QA
Belarus BY Italy IT Romania RO
Belgium BE Jamaica JM Russia RU
Belize BZ Japan JP Samoa WS
Bolivia BO Japan2 J2 Saudi Arabia SA
Brazil BR Jordan JO Singapore SG
Brunei Darussalam BN Kazakhstan KZ Slovak Republic SK
Bulgaria BG North Korea KP Slovenia SI
Canada CA Korea Republic KR South Africa ZA
Chile CL Korea Republic2 K2 South Korea KR
China CN Kuwait KW Spain ES
Colombia CO Latvia LV Sweden SE
Costa Rica CR Lebanon LB Switzerland CH
Croatia HR Liechtenstein LI Syria SY
Cyprus CYy Lithuania LT Taiwan TW
Czech Republic Cz Luxembourg LU Thailand TH
Denmark DK Macau MO Turkey TR
Dominican Republic DO Macedonia MK Ukraine UA
Ecuador EC Malaysia MY United Arab Emirates AE
Egypt EG Malta MT United Kingdom GB
El Salvador SV Mexico MX United Kingdom 5.8 GHz G1
Estonia EE Monaco MC United States us
Finland Fl Morocco MA United States World uw
France FR Netherlands NL United States DFS U1
Georgia GE New Zealand NZ Uruguay uy
Germany DE Nicaragua NI Venezuela VE
Greece GR Norway NO Vietnam VN
Guam GU Oman oM
Guatemala GT Pakistan PK

Enable and Configure TX Power Control for the Wireless Interface

The TX Power Control feature lets the user configure the transmit power level of the card in the AP.
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Perform the following commands to enable TX Power Control and set the transmit power level:

[Device-Name] >set txpowercontrol enable

[Device-Name] >set wif <interface number> currentbackofftpcvalue <0-9 dBml-35 dBm>

Configure SSIDs (Network Names), VLANSs, and Profiles
Perform the following command to configure SSIDs and VLANS, and to assign Security and RADIUS Profiles.

[Device-Name] >set wifssidtbl <Wireless Interface Index.SSID Index> ssid <Network Name>
vlanid <-1 to 1094> ssidauth <enable/disable> acctstatus <enable/disable> secprofile
<Security Profile Nmuber> radmacprofile <MAC Authentication Profile Name> radeapprofile
<EAP Authentication Profile Name> radacctprofile <Accounting Profile Name>
radmacauthstatus <enable/disable> aclstatus <enable/disable>

Example:

[Device-Name] >set wifssidtbl 3.1 ssid accessptl vlanid 22 ssidauth enable acctstatus
enable secprofile 1 radmacprofile "MAC Authentication" radeapprofile "EAP Authentication"
radacctprofile "Accounting" radmacauthstatus enable aclstatus enable

Download an AP Configuration File from your TFTP Server

Start the Solarwinds TFTP program (available on the installation CD), and click on the Security tab to verify that the TFTP
server is configured to both transmit and receive files. (Note that TFTP programs other than Solarwinds may also require
this setting.) Then enter the following commands:

[Device-Name] >set tftpfilename <file name> tftpfiletype config
tftpipaddr <IP address of your TFTP server>

[Device-Name] >show tftp (to ensure the filename, file type, and the IP address are correct)
[Device-Name] >download *

[Device-Name]>reboot 0

Atfter following the complete process (above) once, you can download a file of the same name (so long as all the other
parameters are the same), with the following command:

[Device-Name] >download *

Backup your AP Configuration File

Start the Solarwinds TFTP program (available on the installation CD), and click on the Security tab to verify that the TFTP
server is configured to both transmit and receive files. (Note that TFTP programs other than Solarwinds may also require
this setting.) Then enter the following commands:

[Device-Name]>upload <TFTP Server IP address> <tftpfilename (such as “config.sys”’)> config
[Device-Name] >show tftp (to ensure the filename, file type, and the IP address are correct)

After setting the TFTP parameters, you can backup your current file (so long as all the other parameters are the same),
with the following command:

[Device-Name] >upload *

Set up Auto Configuration

The Auto Configuration feature which allows an AP to be automatically configured by downloading a specific
configuration file from a TFTP server during the boot up process.

Perform the following commands to enable and set up automatic configuration:
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NOTE: The configuration filename and TFTP server IP address are configured only when the AP is configured for Static
IP. If the AP is configured for Dynamic IP these parameters are not used and obtained from DHCP.
The default filename is “config”. The default TFTP IP address is “169.254.128.133".

[Device-Name] >set autoconfigstatus <enable/disable>
[Device-Name] >set autoconfigfilename <configuration file name>
[Device-Name] >set autoconfigTFTPaddr <TFTP IP address>
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Other Network Settings
There are other configuration settings that you may want to set for the AP. Some of them are listed below.

» Configure the AP as a DHCP Server

* Configure the DNS Client

» Configure DHCP Relay and Configure DHCP Relay Servers
* Maintain Client Connections using Link Integrity
» Change Wireless Interface Settings

» Set Ethernet Speed and Transmission Mode

» Set Interface Management Services

« Configure Wireless Distribution System

» Configure MAC Access Control

* Set RADIUS Parameters

» Set Rogue Scan Parameters

» Set Hardware Configuration Reset Parameters
» Set VLAN/SSID Parameters

» Set Security Profile Parameters

NOTE: See Advanced Configuration for more information on these settings.

Configure the AP as a DHCP Server

NOTE: You must have at least one entry in the DHCP Server IP Address Pool Table before you can set the DHCP
Server Status to Enable.

[Device-Name] >set dhcpstatus disable

[Device-Name] >set dhcpippooltbl 0 startipaddr <start ip address>
endipaddr <end ip address>

[Device-Name] >set dhcpgw <gateway ip address>

[Device-Name] >set dhcppridnsipaddr <primary dns ip address>

[Device-Name] >set dhcpsecdnsipaddr <secondary dns ip address>

[Device-Name] >set dhcpstatus enable

[ ]

Device-Name] >reboot 0

CAUTION: Before enabling this feature, confirm that the IP address pools you have configured are valid addresses on
the network and do not overlap the addresses assigned by any other DHCP server on the network. Enabling
this feature with incorrect address pools will cause problems on your network.

Configure the DNS Client

[Device-Name] >set dnsstatus enable

[Device-Name] >set dnsprisvripaddr <IP address of primary DNS server>
[Device-Name] >set dnssecsvripaddr <IP address of secondary DNS server>
[Device-Name] >set dnsdomainname <default domain name>

[ ]

Device-Name] >show dns

[Device Mamel> show dns
DNE Client Group

dnsstatus 5
dnsprisvripaddr =

dnssecsvripaddr :
dnsdomainname

=E
=o6
l&&u‘
=58

Figure A-14 Results of “show dns” CLI command
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Configure DHCP Relay
Perform the following command to enable or disable DHCP Relay Agent Status.

NOTE: You must have at least one entry in the DHCP Relay Server Table before you can set the DHCP Relay Status to
Enable.

[Device-Name] >set dhcprelaystatus enable

Configure DHCP Relay Servers

Perform the following command to configure and enable a DHCP Relay Server. The AP allows the configuration of a
maximum of 10 server settings in the DHCP Relay Agents server table.

[Device-Name] >set dhcprlyindex 1 dhcprlyipaddr <ip address> dhcprlycmt <comment>
dhcprlystatus 1 (1 to enable, 2 to disable, 3 to delete, 4 to create)

Maintain Client Connections using Link Integrity

[Device-Name] >show linkinttbl (this shows the current links)
[Device-Name]>set linkinttbl <1-5 (depending on what table row you wish to address)>

ipaddr <ip address of the host computer you want to check>
[Device-Name] >set linkintpollint <the interval between link integrity checks>
[Device-Name] >set linkintpollretx <number of times to retransmit before considering the
link down>
[Device-Name] >set linkintstatus enable
[Device-Name]>show linkinttbl (to confirm new settings)
[Device-Name] >reboot 0

Change Wireless Interface Settings

See Interfaces for information on the parameters listed below. The AP uses index 3.

Operational Mode
[Device-Name] >set wif 3 mode <see table>
Mode Operational Mode
1 dot11b-only
2 dot11g-only
3 dot11bg
4 dot11a-only
5 dot11g-wifi

Autochannel Select (ACS)
ACS is enabled by default. Reboot after disabling or enabling ACS.

[Device-Name] >set wif 3 autochannel <enable/disable>
[Device-Name]>reboot 0

Dynamic Channel Selection (DCS)
[Device-Name] >set dcs <1 (enable)/2 (disable)>

[Device-Name] >set dcsthreshold <value 1-10>
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The values for the DCS Threshold range from 1 to 10. The default value is 5.

Enable/Disable Closed System

[Device-Name] >set wif 3 closedsys <enable/disable>

Shutdown/Resume Wireless Service

[Device-Name] >set wif 3 wssstatus <1 (resume)/2 (shutdown)>

Set Load Balancing Maximum Number of Clients

[Device-Name] >set wif 3 lbmaxclients <1-63>

Set the Multicast Rate (802.11a/b/g)

[Device-Name] >set wif 3 multrate <6, 12, 24 (Mbits/sec)>

Enable/Disable Super Mode (802.11a/g only)

[Device-Name]>set wif 3 supermode <enable/disable>

Enable/Disable Turbo Mode (802.11a/g only)
[Device-Name] >set wif 3 turbo <enable/disable>

NOTE: Super mode must be enabled on the interface before Turbo mode can be enabled.

Configure Antenna Diversity
[Device-Name]>set wif 3 atdiversity <1, 2, 5(auto)> (see below)

[Device-Name]>reboot 0

Value Corresponding Antenna Enabled
802.11a/b/g (connector 1)
2 802.11a/b/g (connector 2)
5 (auto) |Both antennas

NOTE: See Antennas for more information on internal and external antenna ports.

Set the Distance Between APs
[Device-Name]>set wif 3 distaps <1-5> (see below)

[Device-Name]>reboot 0
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Value Distance Between APs

Large

Medium

Small
Mini
Micro

al | WO N| =

Set Ethernet Speed and Transmission Mode

[Device-Name] >set etherspeed <value> (see below)
[Device-Name] >reboot 0

Ethernet Speed and Value
Transmission Mode

10 Mbits/sec - half duplex 10halfduplex

10 Mbits/sec - full duplex 10fullduplex

10 Mbits/sec - auto duplex 10autoduplex

100 Mbits/sec - half duplex 100halfduplex

100 Mbits/sec - full duplex 100fullduplex

Auto Speed - half duplex autohalfduplex

Auto Speed - auto duplex autoautoduplex (default)

Set VLAN parameters
[Device-Name]> set ethvlanmode <value 0-3>

This command is configured to select any of the four modes. The values represent the four VLAN modes. They are as
follows:

0-Transparent Mode

1-Trunk Mode

2-Access Mode and

3-Mixed Mode.

[Device-Name] >ethvlanaccessid <value 1-4094>
This command stands for the Access VLAN ID configuration. The values range from 1 to 4094.
[Device-Name] >set ethvlanpriority <value 0-7>
For Access VLAN Priority, there are eight values. The default is 0 and the maximum is 7.
[Device-Name] >set ethvlanid0l-16 <value -1-4094>

For the VLAN 1 to 16, the values range from -1 to 4094. The value -1 represents the untagged frames.

Set Interface Management Services

Edit Management IP Access Table

[Device-Name] >set mgmtipaccesstbl <index> ipaddr <IP address> ipmask <subnet mask>
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Configure Management Ports

[Device-Name] >set snmpifbitmask <(see below)>
[Device-Name] >set httpifbitmask <(see below)>
[Device-Name] >set telifbitmask < (see below)>

Choose from the following values:

Interface Bitmask Description
0 or 2 = Disable (all interfaces) |All management channels disabled
1 or 3 = Ethernet only Ethernet only enabled
4 or 6 = Wireless only Wireless A only enabled
5 or 7 = Enable all interfaces All management channels enabled

Set Communication Ports

[Device-Name] >set httpport <HTTP port number (defaultis 80)>
[Device-Name]>set telport <Telnet port number (defaultis 23)>

Configure Secure Socket Layer (HTTPS)

Enabling SSL and configuring a passphrase allows encrypted Secure Socket Layer communications to the AP through
the HTTPS interface.

[Device-Name] >set sslstatus <enable/disable>

The user must change the SSL passphrase when uploading a new certificate/private key pair, which will have a
corresponding passphrase.

[Device-Name] >set sslpassphrase <SSL certificate passphrase>
[Device-Name] >show http (to view all HTTP configuration information including SSL.)

Set Telnet Session Timeouts

[Device-Name] >set tellogintout <time in seconds between 1 and 300 (default is 30)>
[Device-Name] >set telsessiontout <time in seconds between 1 and 36000 (default is 900)>

Configure Serial Port Interface

NOTE: To avoid unexpected performance issues, leave Flow Control at the default setting (none) unless you are sure
what this setting should be.

[Device-Name] >set serbaudrate <2400, 4800, 9600, 19200, 38400, 57600>
[Device-Name] >set serflowctrl <none, xonxoff>
[Device-Name] >show serial

[Device Mamel> show serial
Serial Interface Group Parameters

serbaudrate 5 2688
serdatabits H 8
serparity s none
seprstopbits s 1
serflowctrl H none

Figure A-15 Result of “show serial” CLI Command
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Configure Syslog

Device-Name] >set syslogpriority <1-7 (default is 6)>

>set syslogstatus <enable/disable>

>set sysloghbstatus <enable/disable> (default is disable)

>set sysloghbinterval <1-604800> (default is 900 seconds)
Device-Name]>set sysloghosttbl <index> ipaddr <ipaddress> cmt <comment> status

<enable/disable>

Device-Name

e e

[
[
[Device-Name
[Device-Name
[

Configure Intra BSS

[Device-Name] >set intrabssoptype <passthru (default)/block)>
Configure Wireless Distribution System

Create/Enable WDS

[Device-Name] >set wdstbl <Index> partnermacaddr <MAC Address> status enable

Enable/Disable WDS
[Device-Name] >set wdstbl <Index> status <enable/disable>
NOTE: <Index> is 3.1-3.6. To determine the index, type show wdstbl at the prompt.

NOTE: When WDS is enabled, spanning tree protocol is automatically enabled. It may be manually disabled. If Spanning
Tree protocol is enabled by WDS and WDS is subsequently disabled, Spanning tree will remain enabled until it is
manually disabled. See Spanning Tree Parameters.

Configure MAC Access Control

Setup MAC (Address) Access Control

[Device-Name] >set wifssidtbl <index> aclstatus enable/disable
[Device-Name] >set macacloptype <passthru, block>
[Device-Name]>reboot 0

Add an Entry to the MAC Access Control Table

[Device-Name] >set macacltbl 0 macaddr <MAC Address> status enable
[Device-Name] >show macacltbl

Disable or Delete an Entry in the MAC Access Control Table

[Device-Name] >set macacltbl <index> status <disable/delete>
[Device-Name] >show macacltbl

NOTE: For larger networks that include multiple Access Points, you may prefer to maintain this list on a centralized
location using the RADIUS parameters (see Set RADIUS Parameters).

Set RADIUS Parameters

Configure RADIUS Authentication servers

Perform the following command to configure a RADIUS Server and assign it to a VLAN. The RADIUS Server Profile
index is specified by the index parameter and the subindex parameter specifies whether you are configuring a primary or
secondary RADIUS server.

[Device-Name] >set radiustbl <Index> profname <Profile Name> seraddrfmt <1 - IP Address 2
- Name> sernameorip <IP Address or Name> port <value> ssecret <value> responsetm <value>
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maxretx <value> acctupdtintrvl <value> macaddrfmt <value> authlifetm <value>

radaccinactivetmr <value> vlanid <vlan id -1 to 4094> status enable

NOTE: To create a new RADIUS profile, use 0 for <Index>.

Examples of Configuring Primary and Secondary RADIUS Servers and Displaying the RADIUS Configuration

Primary server configuration:

[Device-Name] >set radiustbl 1.1 profname "MAC Authentication" seraddrfmt 1 sernameorip
20.0.0.20 port 1812 ssecret public responsetm 3 maxretx 3 acctupdtintrvl 0 macaddrfmt 1
authlifetm 900 radaccinactivetmr 5 vlanid 22 status enable

Secondary server configuration:

[Device-Name] >set radiustbl 1.2 profname "MAC Authentication" seraddrfmt 1 sernameorip
20.0.0.30 port 1812 ssecret public responsetm 3 maxretx 3 acctupdtintrvl 0 macaddrfmt 1
authlifetm 900 radaccinactivetmr 5 vlanid 33 status enable

[Device-Name] >show radiustbl

Index

Primary/Backup

Profile Name

Server Status

Server Addressing Format
IP Address/Host Name
Destination Port

VLAN Identifier

MAC Address Format
Response Time

Maximum Retransmission
Authorization Lifetime
Accounting Update Interval
Accounting Inactivity Timer

Index

Primary/Backup

Profile Name

Server Status

Server Addressing Format
IP Address/Host Name
Destination Port

VLAN Identifier

MAC Address Format
Response Time

Maximum Retransmission

Index
Primary/Backup
Profile Name

1

Primary

MAC Authentication
notReady

ipaddr

0.0.0.0

1812

-1

dashdelimited

3

3
0
0

5

1

Backup

MAC Authentication
notReady
ipaddr
0.0.0.0

1812

-1
dashdelimited
3

3

4
Backup
Management Access
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Server Status : notReady
Server Addressing Format : ipaddr
IP Address/Host Name : 0.0.0.0
Destination Port : 1812
VLAN Identifier : -1

MAC Address Format : dashdelimited
Response Time : 3
Maximum Retransmission : 3
Authorization Lifetime 0
Accounting Update Interval 0
Accounting Inactivity Timer : 5

Figure A-16 Result of “showradiustbl” CLI Command

Set Rogue Scan Parameters

Perform the following command to enable or disable Rogue Scan on a wireless interface and configure the scanning
parameters.

The cycletime parameter is only configured for background scanning mode.

[Device-Name] >set rscantbl 3 mode <1 for background scanning, 2 for continuous scanning>
cycletime <cycletime from 1-1440 minutes> status <enable/disable>

NOTE: Rogue Scan cannot be enabled on a wireless interface when the Wireless Service Status on that interface is
shutdown. First, resume service on the wireless interface.
Set Hardware Configuration Reset Parameters

The Hardware Configuration Reset commands allows you to enable or disable the hardware reset functionality and to
change the password to be used for configuration reset during boot up.

To disable hardware configuration reset, enter:
[Device-Name] >set hwconfigresetstatus disable
To enable hardware configuration reset, enter:
[Device-Name] >set hwconfigresetstatus enable

To define the Configuration Reset Password to be used for configuration reset during boot up, enter the following
command

[Device-Name] >set configresetpasswd <password>
It is important to safely store the

NOTE: It is important to safely store the configuration reset password. If a user forgets the configuration reset password,
the user will be unable to reset the AP to factory default configuration if the AP becomes inaccessible and the
hardware configuration reset functionality is disable.

Set VLAN/SSID Parameters

Enable VLAN Management

[Device-Name] >set vlanstatus enable
[Device-Name] >set vlanmgmtid <1-4094>

[Device-Name]>show wifssidtbl (to review your settings)
[Device-Name] >reboot 0
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Disable VLAN Management

[Device-Name] >set vlanstatus disable or
[Device-Name] >set vlanmgmtid -1
[Device-Name]>reboot 0

Add a Entry to the WIFSSID Table

[Device-Name] >set wifssidtbl <index> ssid <Network Name> vlanid <-1 (untagged) or 1-4094>
status enable

Set Security Profile Parameters

Configure a Security Profile with Non Secure Security Mode
[Device-Name] >set secprofiletbl <index> secmode nonsecure status enable

Example:
[Device-Name] >set secprofiletbl 2 secmode nonsecure status enable

Configure a Security Profile with WEP Security Mode

[Device-Name] >set secprofiletbl <index> secmode wep encryptkey<0-3> <value>
encryptkeylength <value> encryptkeytx <value> status enable

Example:
[Device-Name] >set secprofiletbl 3 secmode wep encryptkeyO0 12345 encryptkeylength 1
encryptkeytx 0 status enable

Configure a Security Profile with 802.1x Security Mode

[Device-Name] >set secprofiletbl <index> secmode 802.1x encryptkeylength <value> status
enable

Example:
[Device-Name] >set secprofiletbl 4 secmode 802.1x encryptkeylength 1 status enable

Configure a Security Profile with WPA Security Mode
[Device-Name] >set secprofiletbl <index> secmode wpa status enable

Example:
[Device-Name] >set secprofiletbl 5 secmode wpa status enable

Configure a Security Profile with WPA-PSK Security Mode
[Device-Name] >set secprofiletbl <index> secmode wpa-psk passphrase <value> status enable

Example:
[Device-Name] >set secprofiletbl 6 secmode wpa-psk passphrase 12345678 status enable

Configure a Security Profile with 802.11i Security Mode
[Device-Name] >set secprofiletbl <index> secmode 802.11i status enable

Example:
[Device-Name] >set secprofiletbl 7 secmode 802.11i1i status enable

Configure a Security Profile with 802.11i-PSK Security Mode

[Device-Name] >set secprofiletbl <index> secmode 802.11li-psk passphrase <value> status
enable
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Example:
[Device-Name] >set secprofiletbl 8 secmode 802.11i-psk passphrase 12345678 status enable
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CLI Monitoring Parameters

Using the show command with the following table parameters will display operating statistics for the AP (these are the
same statistics that are described in the Monitoring section).

» staticmp: Displays the ICMP statistics.

» statarptbl: Displays the IP ARP Table statistics.

« statbridgetbl: Displays the Learn Table.

- statiapp: Displays the |IAPP statistics.

» statradius: Displays the RADIUS Authentication statistics.

» statif: Displays information and statistics about the Ethernet and wireless interfaces.
» stat802.11: Displays additional statistics for the wireless interfaces.

» statethernet: Displays additional statistics for the Ethernet interface.

» statmss: Displays station statistics and Wireless Distribution System links.
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Parameter Tables

Objects contain groups that contain both parameters and parameter tables. Use the following Tables to configure the
Access Point. Columns used on the tables include:

Name - Parameter, Group, or Table Name

Type - Data type

Value - Value range, and default value, if any

Access = access type, R = Read Only (show), RW = Read-Write (can be “set”), W = Write Only
CLI Parameter - Parameter name as used in the Access Point

Access Point network objects are associated with Groups. The network objects are listed below and associated
parameters are described in the following Parameter Tables:

System Parameters - Access Point system information
— Inventory Management Information - Hardware, firmware, and software version information
Network Parameters - IP and Network Settings
— IP Configuration Parameters - Configure the Access Point’s IP settings
+ DNS Client for RADIUS Name Resolution - Configure the Access Point as a DNS client
— DHCP Server Parameters - Enable or disable dynamic host configuration
— SNTP Parameters - Configure
— Link Integrity Parameters - Monitor link status
Interface Parameters - Configure Wireless and Ethernet settings
— Wireless Interface Parameters
*  Wireless Distribution System (WDS) Parameters - Configure the WDS partnerships

— Wireless Interface SSID/VLAN/Profile Parameters - Configure the SSIDs, VLANs, and security modes. Up to 16
SSIDs are supported; different security settings can be applied to each SSID, and a unique VLAN can be
configured per SSID.

— Ethernet Interface Parameters - Set the speed and duplex of the Ethernet port.
Management Parameters - Control access to the AP’s management interfaces
— SNMP Parameters - Set read and read/write passwords

— HTTP Parameters - Set up the graphical web browser interface. If required, enable SSL and configure the SSL
certificate passphrase.

— Telnet Parameters - Telnet Port setup
— Serial Port Parameters - Serial Port setup

— RADIUS Based Management Access Parameters - Configure RADIUS Based Management Access for HTTP and
Telnet access.

— SSH Parameters - Enable SSH and configure the host key.
— TFTP Server Parameters - Set up for file transfers; specify IP Address, file name, and file type
— IP Access Table Parameters - Configure range of IP addresses that can access the AP

— Auto Configuration Parameters - Configure the Auto Configuration feature which allows an AP to be automatically
configured by downloading a configuration file from a TFTP server during boot up.

Filtering Parameters

— Ethernet Protocol Filtering Parameters - Control network traffic based on protocol type

— Static MAC Address Filter Table - Enable and disable specific addresses

— Proxy ARP Parameters - Enable or disable proxy ARP for wireless clients

— IP ARP Filtering Parameters - Control which ARP messages are sent to wireless clients based on IP settings
— Broadcast Filtering Table - Control the type of broadcast packets forwarded to the wireless network
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— TCP/UDP Port Filtering - Filter IP packets based on TCP/UDP port
* Alarms Parameters
— SNMP Table Host Table Parameters - Enter the list of IP addresses that will receive alarms from the AP
— Syslog Parameters - Configure the AP to send Syslog information to network servers
* Bridge Parameters
Spanning Tree Parameters - Used to help prevent network loops
Storm Threshold Parameters - Set threshold for number of broadcast packets
Intra BSS Subscriber Blocking - Enable or disable peer to peer traffic on the same AP
Packet Forwarding Parameters - Redirect traffic from wireless clients to a specified MAC address
* RADIUS Parameters
— Set RADIUS Parameters - Configure RADIUS Servers and assign them to VLANS.
» Security Parameters - Access Point security settings
— MAC Access Control Parameters - Control wireless access based on MAC address
— Rogue Scan Configuration Table - Enable and configure Rogue Scan to detect Rogue APs and clients.
— 802.1x Parameters - Configure 802.1X Supplicant Timeout parameter

— Hardware Configuration Reset - Disable or enable hardware configuration reset and configure a configuration
reset password.

— Other Parameters - Configure Security Profiles that define allowed security modes (wireless clients), and
encryption and authentication mechanisms.

*  VLAN/SSID Parameters - Enable the configuration of multiple subnetworks based on VLAN ID and SSID.
e Other Parameters
— |APP Parameters - Enable or disable the Inter-Access Point Protocol

—  Wireless Multimedia Enhancements (WME)/Quality of Service (QoS) parameters - Enable and configure Wireless
Multimedia Enhancement/Quality of Service parameters, QoS policies, mapping priorities, and EDCA parameters.
Apply a configured QoS policy to a particular SSID.
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System Parameters

Name Type Value Access CLI Parameter
System Group N/A R system
Name DisplayString User Defined Rw sysname
Location DisplayString User Defined RW sysloc
Country Identifier* DisplayString See Country Identifiers |[RW sysworldcountrycode
below
Contact Name DisplayString User Defined RW sysctname
Contact E-mail DisplayString User Defined RW sysctemail
Contact Phone DisplayString User Defined RW sysctphone
max 254 characters
FLASH Backup Interval |Integer 0 - 65535 seconds RwW sysflashbckint
Flash Update 0 RW sysflashupdate
1
System OID DisplayString N/A R sysoid
Descriptor DisplayString System Name, flash R sysdescr
version, S/N, bootloader
version
Up Time Integer dd:hh:mm:ss R sysuptime
dd - days
hh - hours
mm - minutes
ss - seconds
System Security ID DisplayString Retrieved from flash ID |R sysinvmgmtsecurityid
Emergency Restore to Resets all parameters to |RW sysresettodefaults
defaults default factory values Note: You must enter the
following command twice to
reset to defaults:
set sysresettodefaults 1

* Available only on APs with model numbers ending in -WD. When available, this object must be configured before any interface parameters

can be set.

Country Identifiers

NOTE: All countries may not be available on your AP.

Country Indoor/Outdoor Identifier
Austria Indoor AT1
Outdoor AT2
Belgium Indoor BE1
Outdoor BE2
Cyprus Indoor CY1
Outdoor CY2
Czech Republic Indoor CZ1
Outdoor Ccz2
Denmark Indoor DKA1
Outdoor DK2
Estonia Indoor EE1
Outdoor EE2
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Country Indoor/Outdoor Identifier
Finland Indoor Fl1
Outdoor Fl2
France Indoor FR1
Outdoor FR2
Germany Indoor DE1
Outdoor DE2
Greece Indoor GR1
Outdoor GR2
Hungary Indoor HU1
Outdoor HU2
Ireland Indoor IE1
Outdoor IE2
Italy Indoor 1T
Outdoor IT2
Latvia Indoor LV1
Outdoor LV2
Lithuania Indoor LT1
Outdoor LT2
Luxembourg Indoor LU1
Outdoor LU2
Malta Indoor MT1
Qutdoor MT2
Netherlands Indoor NLA1
Outdoor NL2
Norway Indoor NO1
Outdoor NO2
Poland Indoor PLA1
Outdoor PL2
Portugal Indoor PT1
Outdoor PT2
Puerto Rico Indoor PR1
Outdoor PR2
Russia Indoor/Outdoor RU
Spain Indoor ES1
Outdoor ES2
Sweden Indoor SE1
Outdoor SE2
Switzerland Indoor CH1
Outdoor CH2
United Kingdom/ Indoor GB1
Great Britain Outdoor GB2
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Inventory Management Information

The inventory management commands display advanced information about the AP’s installed components. You may be
asked to report this information to a representative if you contact customer support.

Name Type Value Access CLI Parameter
System Inventory Subgroup N/A R sysinvmgmt
Management
Component Table Subgroup N/A R sysinvmgmtcmptbl
Component Interface Subgroup N/A R sysinvmgmtcmpiftbl
Table
Network Parameters
IP Configuration Parameters
Name Type Value Access CLI Parameter
Network Group N/A R network
IP Configuration Group N/A R ip (Note: The network and
ip parameters display the
same information)
IP Address IpAddress User Defined RwW ipaddr
IP Mask IpAddress User Defined RwW ipmask
Default Router IP IpAddress User Defined RwW ipgw
Address
Default TTL Integer User Defined (seconds) |RW ipttl
0 - 255, 64 (default)
Address Type Integer static RwW ipaddrtype

dynamic (default)

NOTE: The IP Address Assignment Type (ipaddrtype) must be set to static before the IP Address (ipaddr), IP Mask
(ipmask) or Default Gateway IP Address (ipgw) values can be entered.
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DNS Client for RADIUS Name Resolution

Name Type Value Access CLI Parameter
DNS Client Group N/A R dns
DNS Client status Integer enable RwW dnsstatus
disable (default)
Primary DNS Server IP  |IpAddress User Defined RwW dnspridnsipaddr
Address
Secondary DNS Server |IpAddress User Defined RW dnssecdnsipaddr
IP Address
Default Domain Name Integer32 User Defined (up to 254 |RW dnsdomainname
characters)
DHCP Server Parameters
Name Type Value Access CLI Parameter
DHCP Server Group N/A R dhcp
DHCP Server Status* Integer enable (1) (default) RW dhcpstatus
disable (2)
delete (3)
Gateway IP Address IpAddress User Defined RwW dhcpgw
Primary DNS IP Address |IpAddress User Defined RW dhcppridnsipaddr
Secondary DNS IP IpAddress User Defined RwW dhcpsecdnsipaddr
Address
Number of IP Pool Table |Integer32 N/A R dhcpippooltblent
Entries

* The DHCP Server (dhcpstatus) can only be enabled after a DHCP IP Pool table entry has been created.

DHCP Server table for IP pools

Name Type Value Access CLI Parameter
DHCP Server IP Address |Table N/A R dhcpippooltbl
Pool Table
Table Index Integer User Defined N/A index
Start IP Address* IpAddress User Defined RW startipaddr
End IP Address*t IpAddress User Defined RwW endipaddr
Widtht Integer User Defined RwW width
Default Lease Time Integer32 3600 - 86400 sec RwW defleasetm
(optional) (default)
Maximum Lease Time Integer32 3600 - 86400 sec RwW maxleasetm
(optional) (default)
Comment (optional) DisplayString User Defined RW cmt
Status (optional) Integer enable (1) RW status
disable (2)
delete (3)

*

1 Set End IP Address or Width, but not both.

IP addresses must be from within the same subnet as the AP.
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DHCP Relay Group
The DHCP Relay Group allows you to enable or disable DHCP Relay Agent Status.

Name Type Value Access CLI Parameter
DHCP Relay Group Group N/A R dhcprelay
Status Integer enable RwW dhcprelaystatus
disable
DHCP Relay Server Table N/A R dhcprelaytbl
Table

DHCP Relay Server Table

The DHCP Relay Server Table contains the commands to set the table entries. The AP supports the configuration of a
maximum of 10 server settings in the DHCP Relay Agents server table.

Name Type Value Access CLI Parameter

DHCP Relay Server Table N/A R dhcprelaytbl
Table
DHCP Relay Server Integer32 1-10 R dhcprlyindex
Table Entry Index
DHCP Relay Server IpAddress User Defined RwW dhcprlyipaddr
Table Entry IP Address
DHCP Relay Server DisplayString User Defined RwW dhcprlycmt
Table Entry Comment
DHCP Relay Server Integer enable (1) RwW dhcprlystatus
Table Entry Status disable (2)

delete (3)

create (4)
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SNTP Parameters

Name Type Value Access CLI Parameter
SNTP Group Group N/A R sntp
SNTP Status Integer enable RwW sntpstatus
disable
Primary Server Name or |DisplayString 0 - 255 characters RwW sntpprisvr
IP Address
Secondary Server Name |DisplayString 0 - 255 characters RwW sntpsecsvr
or IP Address
Time Zone Integer See MIB for RwW sntptimezone
requirements
Daylight Savings Time Integer -2 RW sntpdaylightsaving
-1
0
+1
+2
Year Integer32 N/A RW sntpyear
Month Integer32 1-12 RwW sntpmonth
Day Integer32 1-31 RwW sntpday
Hour Integer32 0-23 RW sntphour
Minutes Integer32 0-59 RW sntpmins
Seconds Integer32 0-59 RW sntpsecs
Addressing Format Integer ipaddress RW sntpaddrfmt
name
Link Integrity Parameters
Name Type Value Access CLI Parameter
Link Integrity Group N/A R linkint
Link Integrity Status Integer enable RW linkintstatus
disable (default)
Link Integrity Poll Interval Integer 500 - 15000 ms RwW linkintpollint
(in increments of 500ms)
500 ms (default)
Link Integrity Poll Integer 0-255 RwW linkintpollretx
Retransmissions 5 (default)
Link Integrity IP Target Table
Name Type Value Access CLI Parameter
Link Integrity IP Target Table|Table N/A R linkinttbl
Table Index Integer 1-5 N/A index
Target IP Address IpAddress User Defined RwW ipaddr
Comment (optional) DisplayString User Defined (up to 254 |RW cmt
characters)
Status (optional) Integer enable RwW status
disable (default)
delete
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Interface Parameters

Wireless Interface Parameters

The wireless interface group parameter is wif. The wireless interface uses table index 3.

Common Parameters to 802.11a and 802.11b/g

2 (Antenna 2)
5 (Auto; both antennas)
(See Configure Antenna Diversity)

Name Type Value Access CLI Parameter
Wireless Interfaces Group N/A R wif
Table Index Integer 3 R index
Operational Mode Integer 1 = dot11b-only RW mode
2 = dot11g-only
3 =dot11bg
4 =dot11a
5 = dot11g-wifi
Network Name DisplayString |1 - 32 characters RW netname
My Wireless Network (default)
Auto Channel Select Integer enable (default) RW autochannel
(ACS)* disable
DTIM Period Integer 1-255 RW dtimperiod
1 = default
RTS/CTS Medium Integer 0-2347 RwW medres
Reservation Default is 2347 (off)
MAC Address PhyAddress |12 hex digits R macaddr
Wireless Service StatusT |Integer 1 =resume RW wssstatus
2 = shutdown
Supported Frequency Octet String Depends on Regulatory Domain  |R suppchannels
Channels
Load Balancing Max Integer 1-63 RW Ibmaxclients
Clients
Distance Between APs¥ Integer 1 (large) (default) RW distaps
2 (medium)
3 (small)
4 (minicell)
5 (microcell)
AP Link Length** Integer 200 - 45000 RwW aplinklength
Transmit Power Control Integer enable RW txpowercontrol
disable
Transmit Power Control Integer 0 - 35 (dBm) RwW currentbackofftpcvalue
Back-Off
Antenna Diversity Integer 1 (Antenna 1) RW atdiversity

* For 802.11a APs certified in the ETSI and TELEC regulatory domains and operating in the middle frequency band, disabling Auto Channel

Select will limit the available channels to those in the lower frequency band.

T Wireless Service Status cannot be shut down on an interface where Rogue Scan is enabled.

1 Distance Between APs allows the AP to perform better in high noise environments by increasing the receive sensitivity and transmit defer

threshold, as follows:
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Distance Between Receive Sensitivity Transmit Defer Threshold
APs Threshold (dBm) (dBm)
Large -96 -62
Medium -86 -62
Small -78 -52
Mini -70 -42
Micro -62 -36

** Each 802.11 packet is acknowledged by the receiving station. On links longer than about 100m, the time that it takes for the ACK to get back
to the sending station is long enough to cause the sending station to believe that the packet was not properly received. This problem can be
corrected by adjusting the AP Link Length parameter to a value that is larger than the length in meters of the longest link being serviced by

that AP.

802.11a Specific Parameters

Name

Type

Value

Access

CLI Parameter

Channel

Operating Frequency

Integer

Varies by regulatory domain and
country. See Available Channels

RW

channel

Supported Data Rates

Octet String

See Transmit Rate, below

R

suppdatarates

Transmit Rate

Integer32

0 (Auto Fallback)
6 Mbits/sec

9 Mbits/sec

12 Mbits/sec

18 Mbits/sec

24 Mbits/sec

36 Mbits/sec

48 Mbits/sec

54 Mbits/sec

RW

txrate

Physical Layer Type

Integer

ofdm (orthogonal frequency division
multiplexing)

phytype

Regulatory Domain List

DisplayString

Varies by regulatory domain:
USA -- FCC

Hong Kong -- HK
Australia -- AU
Europe -- ETSI
Russia -- RU
Japan -- TELEC
Singapore -- IDA
Taiwan -- TW
China -- CN

Asia

Brazil

Argentina

Saudi Arabia
World Mode -- WO
Undefined

regdomain

Super Mode

Integer

enable
disable (default)

RW

supermode

Turbo Mode*t

Integer

enable
disable (default)

RW

turbo

* Available for the 5 GHz frequency band in the FCC regulatory domain only.
1 Super mode must be enabled before Turbo mode can be enabled.
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802.11b Specific Parameters

Name

Type

Value

Access

CLI Parameter

Operating Frequency
Channel

Integer

1 - 14; available channels vary by

regulatory domain/country; see
Available Channels

RW

channel

Multicast Rate

Integer

1 Mbits/sec (1)

2 Mbits/sec (2) (default)
5.5 Mbits/sec (3)

11 Mbits/sec (4)

RW

multrate

Closed Wireless System

Integer

enable
disable (default)

RW

closedsys

MAC Address

PhyAddress

12 hex digits

macaddr

Supported Data Rates

Octet String

1 Mbits/sec
2 Mbits/sec
5.5 Mbits/sec
11 Mbits/sec

suppdatarates

Transmit Rate

Integer32

0 (auto fallback; default)
1 Mbits/sec

2 Mbits/sec

5.5 Mbits/sec

11 Mbits/sec

RW

txrate

Physical Layer Type

Integer

dsss (direct sequence spread
spectrum) for 802.11b

phytype

Regulatory Domain List

DisplayString

Varies by regulatory domain:
U.S./Canada -- FCC

Europe -- ETSI

Japan -- TELEC

regdomain

802.11b/g Specific Parameters

Name

Type

Value

Access

CLI Parameter

Operating Frequency
Channel

Integer

1 - 14; available channels vary by

regulatory domain/country; see
Available Channels

RW

channel

Supported Data Rates

Octet String

See Transmit Rate, below

suppdatarates

215




Command Line Interface (CLI)
Parameter Tables

AP-700 User Guide

Name

Type

Value

Access

CLI Parameter

Transmit Rate

Integer32

For 802.11b-only mode:
0 (auto fallback; default)
1 Mbits/sec

2 Mbits/sec

5.5 Mbits/sec

11 Mbits/sec

For 802.11g-only mode:*
0 (auto fallback; default)
6 Mbits/sec

9 Mbits/sec

12 Mbits/sec

18 Mbits/sec

24 Mbits/sec

36 Mbits/sec

48 Mbits/sec

54 Mbits/sec

For 802.11b/g mode:
0 (auto fallback; default)
1 Mbits/sec

2 Mbits/sec

5.5 Mbits/sec

11 Mbits/sec

6 Mbits/sec

9 Mbits/sec

12 Mbits/sec

18 Mbits/sec

24 Mbits/sec

36 Mbits/sec

48 Mbits/sec

54 Mbits/sec

RW

txrate

Physical Layer Type

Integer

ERP (Extended Rate Protocol)

phytype

Regulatory Domain List

DisplayString

Varies by regulatory domain:
USA -- FCC
Europe -- ETSI
Russia -- RU
Japan -- TELEC
Brazil

Argentina

Saudi Arabia
Israel -- IL

World Mode -- WO
Undefined

regdomain

Super Modet

Integer

enable
disable (default)

RW

supermode

* Also for 802.11g-wifi mode. 802.11g-wifi has been defined for Wi-Fi testing purposes; it is not recommended for use in your wireless network

environment.

1 Available in 802.11b/g or 802.11g modes only.
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Wireless Distribution System (WDS) Parameters

Name Type Value Access CLI Parameter
WDS Table Table N/A R wdstbl
Port Index Integer 3.1 - 3.6 (Wireless) R portindex
Status Integer enable, disable RW status
Partner MAC Address PhysAddress User Defined RwW partnermacaddr
Wireless Distribution System (WDS) Security Table Parameters
The WDS Security Table manages WDS related security objects.
Name Type Value Access CLI Parameter
WDS Security Table Table N/A R wdssectbl
Table Index Integer 3 R index
Security Mode Integer 1 or none RW secmode
2 or wep
3 or aes
Shared Secret DisplayString 6-32 characters w sharedsecret
Encryption Key 0 WEPKeyType N/A W encryptkey0

Wireless Interface SSID/VLAN/Profile Parameters

The Wireless Interface SSID table manages the SSIDs, VLANs, Security Profiles, and RADIUS Profiles associated to

each SSID.

For configuration examples, see Configure SSIDs (Network Names), VLANSs, and Profiles.

Name Type Value Access CLI Parameter
Wireless Interface SSID |Table N/A R wifssidtbl
Table
Table Index Integer 3 R index
SSID Table Index Integer32 1-16 (SSID index) R ssidindex
SSID DisplayString 2 - 32 characters RwW ssid
Broadcast Unique Integer enable RW bcastbeacon
Beacon disable
Closed System Integer enable, RwW denybcastprobereq
disable
VLAN ID Vlanld -1 - 4094 or untagged RwW vlanid
Rekeying Interval Integer32 0 (disabled) RwW reykeyint
300 - 65535
Default = 900
Table Row Status RowsStatus enable RwW status
disable
delete
SSID Authorization Integer enable RwW ssidauth
Status per VLAN disable
RADIUS Accounting Integer enable RW acctstatus
Status per VLAN disable
MAC ACL Status per Integer enable RwW aclstatus
VLAN disable
Security Profile Integer32 User defined RwW secprofile
RADIUS MAC Profile DisplayString User defined RW radmacprofile
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Name Type Value Access CLI Parameter
RADIUS EAP Profile DisplayString User defined RwW radeapprofile
RADIUS Accounting DisplayString User defined RW radacctprofile
Profile
QoS Policy Integer32 User defined RwW gospolicy

Ethernet Interface Parameters

Name Type Value Access CLI Parameter
Ethernet Interface Group N/A R ethernet
Speed Integer 1 (10halfduplex) RwW etherspeed
2 (10fullduplex)
3 (10autoduplex)
4 (100halfduplex)
5 (100fullduplex)
(

6 (autohalfduplex)
7 (autoautoduplex)
(default)

MAC Address PhyAddress N/A R ethermacaddr
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Management Parameters

Secure Management Parameters

Name Type Value Access CLI Parameter
Secure Management Integer 1 (enable) RwW securemgmistatus
2 (disable)
SNMP Parameters
Name Type Value Access CLI Parameter
SNMP Group N/A R snmp
SNMP Management Interface Bitmask |0 or 2 = No interfaces RwW snmpifbitmask
Interface Bitmask (disable)
1 or 3 = Ethernet
4 or 6 = Wireless
5 or 7 = All interfaces
(default is 7)
Read Password DisplayString User Defined W snmprpasswd
public (default)
6 - 32 characters
Read/Write Password DisplayString User Defined w snmprwpasswd
public (default)
6 - 32 characters
SNMPv3 Authentication |DisplayString User Defined w snmpv3authpasswd
Password public (default)
6 - 32 characters
SNMPv3 Privacy DisplayString User Defined w snmpv3privpasswd
Password public (default)
6 - 32 characters
HTTP Parameters
Name Type Value Access CLI Parameter
HTTP Group N/A R http
HTTP Management Interface Bitmask |0 or 2 = No interfaces RwW httpifbitmask
Interface Bitmask (disable)
1 or 3 = Ethernet
4 or 6 = Wireless
5 or 7 = All interfaces
(default is 7)
HTTP Password DisplayString User Defined (6 - 32 w httppasswd
characters)
HTTP Port Integer User Defined RwW httpport
Default = 80
Help Link* DisplayString User Defined RwW httphelplink
SSL Status Integer enable/disable RwW sslstatus
SSL Certificate DisplayString User Defined w sslpassphrase
Passphrase

* The help link must be set to an HTTP address. Use the forward slash character ("/") rather than the backslash character ("\") when configuring

the Help Link location.
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Telnet Parameters

Name Type Value Access CLI Parameter
Telnet Group N/A R telnet
Telnet Management Interface Bitmask [0 or 2 = No interfaces RwW telifbitmask
Interface Bitmask (disable)
1 or 3 = Ethernet
4 or 6 = Wireless
5 or 7 = All interfaces
(default is 7)
Telnet Port Integer User Defined RW telport
23 (default)
Telnet Login Inactivity Integer 30 - 300 seconds RwW tellogintout
Time-out 60 sec (default)
Telnet Session Idle Integer 60 - 36000 seconds RW telsessiontout
Time-out 900 sec (default)
Serial Port Parameters
Name Type Value Access CLI Parameter
Serial Group N/A R serial
Baud Rate Integer 2400, 4800,9600 RW serbaudrate
(default), 19200, 38400,
57600
Data Bits Integer 8 R serdatabits
Parity Integer none R serparity
Stop Bits Integer 1 R serstopbits
Flow Control Value none (default) RwW serflowctrl

xonxoff

RADIUS Based Management Access Parameters

The RADIUS Based Management Access parameters allow you to enable HTTP or Telnet Radius Management Access,
enable or disable local user access, and configure the local user password.

The default local user ID is root and the default local user password is public. “Root” cannot be configured as a valid
user for RADIUS based management access when local user access is enabled.

Name Type Value Access CLI Parameter
Radius Local User Status |Integer enable RwW radlocaluserstatus
disable
Radius Local User DisplayString User Defined RwW radlocaluserpasswd
Password
HTTP Radius Integer enable RW httpradiusmgmtaccess
Management Access disable
Telnet Radius Integer enable RwW telradiusmgmtaccess
Management Access disable
SSH Parameters
The following commands enable or disable SSH and set the SSH host key.
Name Type Value Access CLI Parameter
SSH Status Integer enable RwW sshstatus
disable
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Name Type Value Access CLI Parameter
SSH Public Host Key DisplayString AP Generated RwW sshkeyfprint
Fingerprint
SSH Host Key Status Integer create RwW sshkeystatus
delete

The AP SSH feature, open-SSH, confirms to the SSH protocol, and supports SSH version 2. The following SSH clients
have been verified to interoperate with the AP’s server. The following table lists the clients, version number, and the
website of the client.

Clients Version Website
OpenSSH V3.4-2 http://www.openssh.com
Putty Rel 0.53b http://www.chiark.greenend.org.uk
Zoc 5.00 http://www.emtec.com
Axessh V2.5 http://www.labf.com

For key generation, only the OpenSSH client has been verified.

Auto Configuration Parameters

These parameters relate to the Auto Configuration feature which allows an AP to be automatically configured by
downloading a specific configuration file from a TFTP server during the boot up process.

Name Type Value Access CLI Parameter
Auto Configuration Group N/A R autoconfig
Auto Configuration Status|Integer enable (default) RwW autoconfigstatus
disable
Auto Config File Name DisplayString User Defined RwW autoconfigfilename
Auto Config TFTP Server |IpAddress User Defined RW autoconfigTFTPaddr
IP Address

TFTP Server Parameters
These parameters relate to upload and download commands.

When you execute an upload and/or download Command, the specified arguments are stored in TFTP parameters for
future use. If nothing is specified in the command line when issuing subsequent upload and/or download commands, the
stored arguments are used.

Name Type Value Access CLI Parameter
TFTP Group N/A R tftp
TFTP Server IP Address |IpAddress User Defined RwW tftpipaddr
TFTP File Name DisplayString User Defined RwW tftpfilename
TFTP File Type Integer img RwW tftpfiletype
config
bootloader

sslcertificate
sslprivatekey
sshprivatekey
sshpublickey
clibatchfile (CLI Batch
File)

cbflog (CLI Batch Error
Log)
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IP Access Table Parameters

When creating table entries, you may either specify the argument name followed by argument value or simply enter the
argument value. When only the argument value is specified, then enter the values in the order depicted by the following
table. CLI applies default values to the omitted arguments. Due to the nature of the information, the only argument that
can be omitted is the “comment” argument.

Name Type Value Access CLI Parameter
IP Access Table Table N/A R mgmtipaccesstbl
Table Index Integer User Defined N/A index
IP Address IpAddress User Defined RwW ipaddr
IP Mask IpAddress User Defined RW ipmask
Comment (optional) DisplayString User Defined RwW cmt
Status (optional) Integer enable (default) RwW status
disable
delete

Filtering Parameters

Ethernet Protocol Filtering Parameters

Name Type Value Access CLI Parameter
Ethernet Filtering Group N/A R etherflt
Filtering Interface Interface Bitmask |0 or 2 = No interfaces RwW etherfltifbitmask
Bitmask (disable)

1 or 3 = Ethernet

4 or 6 = Wireless

5 or 7 = All interfaces
(default is 7)

Operation Type passthru RwW etherfltoptype
block

Ethernet Filtering Table
Identify the different filters by using the table index.

Name Type Value Access CLI Parameter
Ethernet Filtering Table |Table N/A R etherflttbl
Table Index N/A N/A R index
Protocol Number Octet String N/A RwW protonumber
Protocol Name (optional) |DisplayString RW protoname
Status (optional) Integer enable (1) RwW status
disable (2)
delete (3)

NOTE: The filter Operation Type (passthru or block) applies only to the protocol filters that are enabled in this table.

Static MAC Address Filter Table

Name Type Value Access CLI Parameter
Static MAC Address Filter | Table N/A R staticmactbl
Table
Table Index N/A N/A R index
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Name Type Value Access CLI Parameter
Static MAC Address on |PhysAddress User Defined RwW wiredmacaddr
Wired Network
Static MAC Address PhysAddress User Defined RwW wiredmask
Mask on Wired Network
Static MAC Address on |PhysAddress User Defined RwW wirelessmacaddr
Wireless Network
Static MAC Address PhysAddress User Defined RwW wirelessmask
Mask on Wireless
Network
Comment (optional) DisplayString max 255 characters RwW cmt
Status (optional) Integer enable (default) RW status
disable
delete
Proxy ARP Parameters
Name Type Value Access CLI Parameter
Proxy ARP Group N/A R parp
Status Integer enable RW parpstatus
disable (default)
IP ARP Filtering Parameters
Name Type Value Access CLI Parameter
IP ARP Filtering Group N/A R iparp
Status Integer enable RW iparpfltstatus
disable (default)
IP Address IpAddress User Defined RwW iparpfltipaddr
Subnet Mask IpAddress User Defined RwW iparpfltsubmask
Broadcast Filtering Table
Name Type Value Access CLI Parameter
Broadcast Filtering Table [Table N/A R broadcastflttbl
Index Integer 1-5 N/A index
Protocol Name DisplayString N/A R protoname
Direction Integer ethertowireless RW direction
wirelesstoether
both (default)
Status Integer enable RwW status
disable (default)
TCP/UDP Port Filtering
The following parameters are used to enable/disable the Port filter feature.
Name Type Value Access CLI Parameter
Port Filtering Group N/A R portflt
Port Filter Status Integer enable (default) RwW portfltstatus

disable
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TCP/UDP Port Filtering Table

The following parameters are used to configure TCP/UDP Port filters.

Name Type Value Access CLI Parameter
Port Filtering Table Table N/A R portflttbl
Table Index N/A User Defined R index

(there are also 4
pre-defined indices, see
Port Number below for
more information)

Port Type Octet String tcp RwW porttype
udp
tcp/udp

Port Number Octet String User Defined RwW portnum

(there are also 4
pre-defined protocols:
Index 1: NetBios Name
Service - 137, Index 2:
NetBios Datagram
Service - 138, Index 3:
NetBios Session Service
- 139, Index 4: SNMP
Service - 161)

Protocol Name DisplayString User Defined RW protoname
(there are also 4
pre-defined protocols,
see Port Number above)

Interface Bitmask Integer32 0 or 2 = No interfaces RwW ifbitmask
(disable)

1 or 3 = Ethernet

4 or 6 = Wireless

5 or 7 = All interfaces
(default is 7)

Status (optional) Integer enable (default for new |RW status
entries)

disable (default for
pre-defined entries)
delete

Alarms Parameters

SNMP Table Host Table Parameters

When creating table entries, you may either specifying the argument name followed by argument value. CLI applies
default values to the omitted arguments. Due to the nature of the information, the only argument that can be omitted is
the “comment” argument.

Name Type Value Access CLI Parameter
SNMP Trap Host Table |Table N/A R snmptraphosttbl
Table Index Integer User Defined N/A index
IP Address IpAddress User Defined RW ipaddr
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Name Type Value Access CLI Parameter
Password DisplayString User Defined (up to 64 w passwd
characters)
Comment (optional) DisplayString User Defined (up to 254 RwW cmt
characters)
Status (optional) Integer enable (default) RwW status
disable
delete
Syslog Parameters
The following parameters configure the Syslog settings.
Name Type Value Access CLI Parameter
Syslog Group N/A R syslog
Syslog Status Integer enable RwW syslogstatus
disable (default)
Syslog Port Octet String 514 R syslogport
Syslog Lowest Priority Integer 1=LOG_ALERT RwW syslogpritolog
Logged 2=LOG_CRIT
3=LOG_ERR
4 = LOG_WARNING
5=LOG_NOTICE
6 = LOG_INFO (default)
7 = LOG_DEBUG
Heartbeat Status Integer enable (1) RwW sysloghbstatus
disable (2) (default)
Heartbeat Interval Integer 1 - 604800 seconds; RwW sysloghbinterval

(seconds)

900 sec. (default)

NOTE: When Heartbeat is enabled, the AP periodically sends a message to the Syslog server to indicate that it is active.
The frequency with which the heartbeat message is sent depends upon the setting of the Heartbeat Interval.

Syslog Host Table

The table described below configures the Syslog hosts that will receive message from the AP. You can configure up to

ten Syslog hosts.

Name Type Value Access CLI Parameter
Syslog Host Table Table N/A R sysloghosttbl
Table Index Integer 1-10 N/A index
IP Address IpAddress User Defined RW ipaddr
Comment (optional) DisplayString User Defined RW cmt
Status (optional) Integer enable RwW status
disable
delete
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Bridge Parameters

Spanning Tree Parameters

Name Type Value Access CLI Parameter
Spanning Tree Group N/A R stp
Spanning Tree Status Integer enable RwW stpstatus
disable (default)

Bridge Priority Integer 0 - 65535 RwW stppriority
32768 (default)

Maximum Age Integer 600 - 4000 RW stpmaxage
(in 0.01 sec intervals;
i.e., 6 to 40 seconds)
2000 (default)

Hello Time Integer 100 - 1000 (1/100 RwW stphellotime
second; i.e., 1to 10
seconds); enter values in
increments of 100
200 (default)

Forward Delay Integer 400 - 3000 RwW stpfwddelay
(in 0.01 sec intervals;
i.e., 4 to 30 seconds)
1500 (default)

Spanning Tree Priority and Path Cost Table
Name Type Value Access CLI Parameter
Spanning Tree Table Table N/A R stpbl
Table Index (Port) N/A 1-15 R index
Priority Integer 0-255 RwW priority
128 (default)

Path Cost Integer 1-65535 RW pathcost
100 (default)

State Integer disable R state
blocking
listening
learning
forwarding
broken

Status Integer enable RwW status
disable

Storm Threshold Parameters

Name Type Value Access CLI Parameter
Storm Threshold Group N/A (see below) N/A stmthres
Broadcast Threshold Integer 0 - 255 packets/sec RwW stmbrdthres

(default is 0)
Multicast Threshold Integer 0 - 255 packets/sec RW stmmultithres

(default is 0)
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Storm Threshold Table

(default is 0)

Name Type Value Access CLI Parameter
Storm Threshold Table |Table N/A R stmthrestbl
Table Index Integer 1 = Ethernet R index
3 = Wireless
Broadcast Threshold Integer 0 - 255 packets/sec RwW bcast
(default is 0)
Multicast Threshold Integer 0 - 255 packets/sec RW mcast

Intra BSS Subscriber Blocking

The following parameters control the Intra BSS traffic feature, which prevent wireless clients that are associated with the

same AP from communicating with each other:

Operation

block

Name Type Value Access CLI Parameter
Intra BSS Traffic Group N/A R intrabss
Intra BSS Traffic Integer passthru (default) RwW intrabssoptype

Packet Forwarding Parameters

The following parameters control the Packet Forwarding feature, which redirects wireless traffic to a specific MAC

address:
Name Type Value Access CLI Parameter
Packet Forwarding MAC |Group N/A R pktfwd
Address
Packet Forwarding MAC |MacAddress User Defined RwW pktfwdmacaddr
Address
Packet Forwarding Status|Integer enable RwW pktfwdstatus
disable (default)
Packet Forwarding Integer 0 (any) (default) RwW pktfwdif

Interface Port

1 (Ethernet)
2 (WDS 1)
3 (WDS 2)
4 (WDS 3)
5 (WDS 4)
6 (WDS 5)
7 (WDS 6)
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RADIUS Parameters

General RADIUS Parameters

Name Type Value Access CLI Parameter
RADIUS Group N/A R radius
Client Invalid Server Counter32 N/A R radcliinvsvradd
Address

RADIUS Server Configuration Parameters

NOTE: Use a server name only if you have enabled the DNS Client functionality. See DNS Client for RADIUS Name

Resolution.
Name Type Value Access CLI Parameter
RADIUS Authentication |Table N/A R radiustbl
Table Index (Profile Integer N/A R index
Index)
Primary/Secondary Index |Integer Primary (1) R subindex
Secondary (2)
Status Integer enable RwW status
disable
Server Address Format |Integer Ipaddr RwW seraddrfmt
Name
Server |IP Address or IpAddress User defined (enter an IP RwW ipaddr
Name DisplayString address if seraddrfmt is
ipaddr or a name if set to
name; up to 254
characters if using a
name)
Port (optional) Integer User Defined RwW port
1812 (default)
Shared Secret DisplayString User Defined w ssecret
6 - 32 characters
Response Time (optional)|Integer 1-10 seconds RwW responsetm
3 (default)
Maximum Integer 0-4 RwW maxretx
Retransmissions 3 (default)
(optional)
RADIUS MAC Address |Integer dashdelimited RwW radmacaddrformat
Format colondelimited
singledashdelimited
nodelimiter
RADIUS Accounting Integer32 1 - 60 minutes RwW radaccinactivetmr
Inactivity Timer
Authorization Lifetime Integer32 900 - 43200 seconds w radauthlifetm
RADIUS Accounting Integer32 10 - 3600 minutes RwW radacctupdinterval
Update Interval
VLAN ID vlanID -1 (untagged) RwW radvlanid
1-4094
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Security Parameters

MAC Access Control Parameters

Name Type Value Access CLI Parameter
MAC Address Control Group N/A R macacl
Status Integer enable RwW aclstatus
disable (default)
Operation Type Integer passthru (default) RwW macacloptype
block

MAC Access Control Table

Name Type Value Access CLI Parameter
MAC Address Control Table N/A R macacltbl
Table
Table Index N/A N/A R index
MAC Address PhysAddress User Defined RW macaddr
Comment (optional) DisplayString User Defined RwW cmt
max 254 characters
Status (optional) Integer enable (default) RwW status
disable
delete

Rogue Scan Configuration Table

The Rogue Scan Configuration Table allows you to enable or disable Rogue Scan and configure the scanning
parameters.

Name Type Value Access CLI Parameter
Rogue Scan Table N/A R rscantbl
Configuration Table
Rogue Scan Mode Integer Bkscan (1) RwW mode
Contscan (2)
Rogue Scan Cycle Time |Integer 1-1440 RwW cycletime
Rogue Scan Integer 3or4 RwW index
Configuration Table Index
Rogue Scan Status Integer enable RwW status
disable

802.1x Parameters

Name Type Value Access CLI Parameter
802.1x Group Group N/A R dot1xauthcfg
802.1x Supplicant Integer32 3 - 60 seconds RwW dot1xsupptimeout
Timeout (recommended range)

Hardware Configuration Reset

The Hardware Configuration Reset commands allows you to enable or disable the feature and to change the password to
be used for configuration reset during boot up.
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Password

Name Type Value Access CLI Parameter
Hardware Configuration |Integer enable (1) R hwconfigresetstatus
Reset Status disable (2)

Configuration Reset DisplayString User Defined RwW configresetpasswd

Security Profile Table

The Security Profile Table allows you to configure security profiles. A maximum of 16 security profiles are supported.

Each security profile can contain one or more enabled security modes (Non-secure station, WEP station, 802.1x station,
WPA station, WPA-PSK station, 802.11i, 802.11i-PSK). The WEP/PSK parameters are separately configurable for each

security mode. See the command examples in Set Security Profile Parameters.

Name

Type

Value

Access

CLI Parameter

Security Profile Table

Table

N/A

R

secprofiletbl

Table Index

Integer

1-16

RW

index

Security Mode

Integer

nonsecure
wep

802.1x

wpa
wpa-psk
802.11i
802.11i-psk

RW

secmode

Authentication Mode

Integer

none
802.1x
psk

authmode

Cipher

Integer

none
wep
tkip
aes

ciphersuite

Encryption Key 0

Integer

See Encryption Key
Format

encryptkeyO

Encryption Key 1

Integer

See Encryption Key
Format

encryptkey1

Encryption Key 2

Integer

See Encryption Key
Format

encryptkey2

Encryption Key 3

Integer

See Encryption Key
Format

encryptkey3

Encryption Transmit Key

Integer

0-3

encryptkeytx

Encryption Key Length

Integer

1 (64 bits)
2 (128 bits)
3 (152 bits)

encryptkeylength

PSK Passphrase

Integer

8 - 64 characters

passphrase

Encryption Key Format

If WEP security mode is configured, then the appropriate key size must be configured. The AP supports 63-, 128-, and
152-bit encryption keys. Encryption keys may be configured using either hexadecimal or ASCII values, as described in

the following table.

Key Length

Hexadecimal

ASCII

64-bit

10 characters (0 - F)

5 alphanumeric characters
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Key Length Hexadecimal ASCII
128-bit 26 characters (0 - F) 13 alphanumeric characters
152-bit 32 characters (0 - F) 16 alphanumeric characters

Each ASCII character corresponds to two hexadecimal digits. See ASCII Character Chart for ASCll/Hexadecimal

correspondence.

VLAN/SSID Parameters

Name Type Value Access CLI Parameter
VLAN Group N/A R vlan
Status Integer enable RW vlanstatus
disable (default)
Management ID Vlanld -1 (untagged) RwW vlanmgmtid
or1-4094
Other Parameters
IAPP Parameters
Name Type Value Access CLI Parameter
IAPP Group N/A R iapp
IAPP Status Integer enable (default) RwW iappstatus
disable
Periodic Announce Integer 80 RwW iappannint
Interval (seconds) 120 (default)
160
200
Announce Response Integer 2 seconds R iappannresp
Time
Handover Time-out Integer 410 ms RwW iapphandtout
512 ms (default)
614 ms
717 ms
819 ms
Max. Handover Integer 1 - 4 (default 4) RW iapphandretx
Retransmissions
Send Announce Request |Integer enable (default) RwW iappannregstart
on Startup disable

NOTE: These parameters configure the Inter Access Point Protocol (IAPP) for roaming. Leave these settings at their
default value unless a technical representative asks you to change them.

Wireless Multimedia Enhancements (WME)/Quality of Service (QoS) parameters

The Wireless Multimedia Enhancements commands enable and configure Wireless Multimedia Enhancement/Quality of
Service parameters. The following two commands are part of the Wireless Interface Properties table.
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Enabling QoS
Name Type Value Access CLI Parameter
QoS Status Object Status enable RwW gosstatus
disable (default)
QoS Maximum Medium |Integer 50 - 90 RW gosmaximummediumthresh
Threshold old
Configuring QoS Policies
The QoS group manages the QoS policies:
Name Type Value Access CLI Parameter
QoS Group Group N/A N/A qos
QoS Policy Table Table N/A N/A gospolicytbl
Table Primary Index Integer N/A R index
Table Secondary Index |Integer N/A R secindex
Policy Name Display String 0 - 32 characters RW policyname
Policy Type Integer inlayer2, RwW type
inlayer3,
outlayer2,
outlayer3,
spectralink®
Priority Mapping Indext |Integer See NoteT. RwW mapindex
Apply QoS Marking Object Status enable RwW markstatus
disable
Table Row Status Row Status enable RwW status
disable
delete

* QoS must be enabled on the wireless interface before spectralink can be enabled.

T A priority mapping needs to be specified for a QoS Policy. The priority mapping depends on the type of policy configured. For Layer 2 policy
types (inbound or outbound) a mapping index from the 802.1p to 802.1D table should be specified. For Layer 3 policy types (inbound or out-
bound) a mapping index from the IP DSCP to 802.1D table should be specified. The mapping index, in both cases, depends on the number of

mappings configured by the user. For SpectraLink policy type a mapping is not required.

Specifying the Mapping between 802.1p and 802.1D Priorities
The QoS 802.1p to 802.1D Mapping Table specifies the mapping between 802.1P and 802.1D priorities.

Name Type Value Access CLI Parameter
QoS 802.1p to 802.1D Table N/A N/A gos1pto1dtbl
Mapping Table
Table Index (Primary Integer 0-7 R index
Index)
802.1D Priority Integer 0-7 R 1dpriority
(Secondary Index)
802.1p Priority Integer 0-7 RW 1ppriority
Table Row Status Row Status enable RwW status
disable
delete
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Specifying the Mapping between IP Precedence/DSCP Ranges and 802.1D Priorities

The QoS IP DSCP to 802.1D Mapping Table specifies the mapping between IP Precedence/DSCP Ranges and 802.1D
priorities.

Name Type Value Access CLI Parameter
QoS IP DSCP to 802.1D |Table N/A N/A qosdscpto1dtbl
Mapping Table
Table Index (Primary Integer 0-7 R index
Index)
802.1D Priority Integer 0-7 R 1dpriority
IP DSCP Lower Limit Integer 0-62 RwW dscplower
IP DSCP Upper Limit Integer 1-63 RwW dscpupper
Table Row Status Row Status enable RwW status
disable
delete

QoS Enhanced Distributed Channel Access (EDCA) Parameters
The following commands configure the client (STA) and AP Enhanced Distributed Channel Access (EDCA) parameters.

The EDCA parameter set provides information needed by the client stations for proper QoS operation during the wireless
contention period. These parameters are used by the QoS enabled AP to establish policy, to change policies when
accepting new stations or new traffic, or to adapt to changes in the offered load. The EDCA parameters assign priorities
to traffic types where higher priority packets gain access to the wireless medium more frequently than lower priority
packets.

NOTE: We have defined default recommended values for EDCA parameters; we recommend not modifying EDCA
parameters unless strictly necessary.

Name Type Value Access CLI Parameter

STA EDCA Table Table N/A N/A gosedcatbl
Table Index Integer 3 (Wireless A) R —

4 (Wireless B)
QoS Access Category Integer 1 (Best Effort) R —

2 (Background)

3 (Video)

4 (Voice)
CWmin Integer 0-255 RW cwmin
CWmax Integer 0 - 65535 RW cwmax
AIFSN Integer 2-15 RwW aifsn
Tx OP Limit Integer 0 - 65535 RwW txoplimit
MSDU Lifetime Integer 0-500 RwW msdulifetime
AC Mandatory Truth Value 1 (Enable) RwW acmandatory

2 (Disable)
AP EDCA Table Table N/A N/A gosqgapedcatbl
Table Index Integer 3 (Wireless A) R —

4 (Wireless B)
QoS Access Category Integer 1 (Best Effort) R —

2 (Background)

3 (Video)

4 (Voice)
CWmin Integer 0-255 RwW cwmin
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Name Type Value Access CLI Parameter
CWmax Integer 0 - 65535 RW cwmax
AIFSN Integer 2-15 RwW aifsn
Tx OP Limit Integer 0 - 65535 RwW txoplimit
MSDU Lifetime Integer 0-500 RwW msdulifetime
AC Mandatory Truth Value true RW acmandatory
false

Examples:

show gosedcatbl (or gosgapedcatbl)

set gosedcatbl (or gosgapedcatbl) <Index>.<Access Category> <EDCA parameter> <value>

For example: set gosedcatbl 3.1 cwmin 15

Defining the QoS Policy used for a Wireless Interface SSID

The QoS Policy object configures the QoS policy to be used per wireless interface SSID. This object is part of the

Wireless Interface SSID Table; the CLI command for this table is “wifssidtbl.”

Name

Type

Value

Access

CLI Parameter

QoS Policy

Integer

See Note*

RW

gospolicy

* A QoS Policy number needs to be specified in the SSID table. This depends on the QoS policies configured by the user. Once the user has

configured QoS policies, the user should specify the policy to be used for that SSID.
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CLI Batch File

A CLI Batch file is a user-editable file that lists a series of CLI set commands, that can be uploaded to the Access Point to
change its configuration. The Access Point executes the CLI commands specified in the CLI Batch file after upload and
the configuration gets changed accordingly. A CLI Batch file can also be used for Auto Configuration.

The CLI Batch file does not replace the existing LTV format configuration file, which continues to define the configuration
of the AP.

The CLI Batch file contains a list of CLI commands that the AP will execute. The AP performs the commands in the file
immediately after the file is uploaded to the AP manually or during Auto Configuration. The AP parses the file and
executes the CLI commands. Commands that do not require a reboot take effect immediately, while commands that
require a reboot (typically commands affecting a wireless interface) will take effect after reboot.

Auto Configuration and the CLI Batch File

The Auto Configuration feature allows download of the LTV format configuration file or the CLI Batch file. The AP detects
whether the file uploaded is LTV format or a CLI Batch file. If the AP detects a CLI Batch file (a file with extension .cli), the
AP executes the file immediately.

The AP will reboot after executing the CLI Batch file. Auto Configuration will not result in repeated reboots if the CLI Batch
file contains rebootable parameters.

CLI Batch File Format and Syntax

The CLI Batch file must be named with a .cli extension to be recognized by the AP. The maximum file size allowed is 100
Kbytes, and files with larger sizes cannot be uploaded to the AP. The CLI commands supported in the CLI Batch File are
a subset of the legal AP CLI commands.

The follow commands are supported:

+ Set commands
* Reboot command (the reboot command ignores the argument (time)

Each command must be separated by a new line.

NOTE: The following commands are not supported: Show command, Debug command, Undebug command, Upload
command, Download command, Passwd command, Kill command, and the Exit, Quit, and Done commands.

Sample CLI Batch File
The following is a sample CLI Batch File:

set sysname systeml

set sysloc sunnyvale

set sysctname contactl

set sysctphone 1234567890

set sysctemail email@domain.com
set ipaddr 11.0.0.66

set ipaddrtype static

set ipsubmask 255.255.255.0
set ipgw 11.0.0.1

set wif 3 autochannel disable
set wif 3 mode 1

set syslogstatus enable

set sysloghbstatus enable

set sysloghbinterval 5

set wif 3 netname london
reboot
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Reboot Behavior

When a CLI Batch file contains a reboot command, the reboot will occur only after the entire CLI Batch file has been
executed.

There are two methods of uploading the CLI Batch File:

* Upload
» Upload and reboot (this option is to be used for a CLI Batch file containing the configuration parameters that require a
reboot)

CLI Batch File Error Log

If there is any error during the execution of the CLI Batch file, the AP will stop executing the file. The AP generates traps
for all errors and each trap contains the following information:

« Start of execution

» Original filename of the uploaded file

» End of execution (along with the status of execution)

» Line number and description of failures that occurred during execution

The AP logs all the errors during execution and stores them in the Flash memory in a CLI Batch File Error Log named

“CBFERR.LOG”. The CLI Batch File Error Log can be downloaded though TFTP, HTTP, or CLI file transfer to a specified
host.
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You can configure WEP Encryption Keys in either Hexadecimal or ASCII format. Hexadecimal digits are 0-9 and A-F (not
case sensitive). ASCII characters are 0-9, A-F, a-f (case sensitive), and punctuation marks. Each ASCII character
corresponds to two hexadecimal digits.

The table below lists the ASCII characters that you can use to configure WEP Encryption Keys. It also lists the

Hexadecimal equivalent for each ASCII character.

ASCII Hex ASCII Hex ASCII Hex ASCII Hex
Charact | Equival | Charact | Equival ] Charact | Equival i Charact | Equival
er ent er ent er ent er ent
! 21 9 39 Q 51 i 69
" 22 : 3A R 52 i 6A
# 23 ; 3B S 53 k 6B
$ 24 < 3C T 54 I 6C
% 25 = 3D U 55 m 6D
& 26 > 3E V 56 n 6E
' 27 ? 3F w 57 o} 6F
( 28 @ 40 X 58 p 70
) 29 A 41 Y 59 q 71
* 2A B 42 4 5A r 72
+ 2B C 43 [ 5B s 73
, 2C D 44 \ 5C t 74
- 2D E 45 ] 5D u 75
. 2E F 46 A 5E v 76
/ 2F G 47 _ 5F w 77
0 30 H 48 60 X 78
1 31 I 49 a 61 y 79
2 32 J 4A b 62 z T7A
3 33 K 4B C 63 { 7B
4 34 L 4C d 64 [ 7C
5 35 M 4D e 65 } 7D
6 36 N 4E f 66 ~ 7E
7 37 o] 4F g 67
8 38 P 50 h 68
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» Software Features
* Hardware Specifications
¢ Available Channels

Software Features
The tables below list the software features available on the AP-700.
* Number of Stations per BSS
* Management Functions
* Advanced Bridging Functions
*  Medium Access Control (MAC) Functions
« Security Functions
* Network Functions

Number of Stations per BSS

Feature Supported by AP-700

Without security 124
With security* 120

* Number may vary based on combination of security methods used.

Management Functions

Feature Supported by AP-700

Web User Interface

Telnet / CLI

SNMP Agent

Serial CLI

Secure Management

SSH

RADIUS Based Management Access

W | W[ W | W|WwW|Ww|w
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Advanced Bridging Functions

Feature

Supported by AP-700

IEEE 802.1d Bridging

WDS Relay

Roaming

Protocol Filtering

Multicast/Broadcast Storm Filtering

Proxy ARP

TCP/UDP Port Filtering

Blocking Intra BSS Clients

Packet Forwarding

W | W[ W|W|W|WwW|Ww|w|Ww

Medium Access Control (MAC) Functions

Feature Supported by AP-700

Automatic Channel Selection (ACS) 3
Dynamic Frequency Selection (DFS)/Radar Detection 3
(RD)*

Wireless Service Shutdown 3
802.11d Support 3
TX Power Control 3
Wireless Multimedia Enhancements/Quality of Service 3
(QoS)

Channel Blacklist 3
Closed System 3
Broadcast Unique Beacon 3
Super and Turbo Mode Support 3

* DFS is required for 802.11a APs certified in the ETSI, TELEC, FCC, and IC regulatory domains and operating in the middle frequency band.
When ACS is disabled, available channels are limited to those in the lower frequency band. See Dynamic Frequency Selection/Radar Detec-

tion (DFS/RD).
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Security Functions

Feature Supported by AP-700
Security Profiles per VLAN
RADIUS Profiles per VLAN
IEEE 802.11 WEP*
MAC Access Control
RADIUS MAC-based Access Control
IEEE 802.1x AuthenticationT
Multiple Authentication Server Support per VLANF

W | W | W[ W[ W|Ww|lw|lw

Rogue Scanning to Detect Rogue Access Points and
Clients

Per User Per Session (PUPS) Encryption § 3
Wi-Fi Protected Access (WPA)/802.11i (WPA2) 3
Hardware Configuration Reset Disable 3

* Key lengths supported by 802.11a: 64-bit, 128-bit, and 152-bit.
Key lengths supported by 802.11b: 64-bit and 128-bit.
Key lengths supported by 802.11b/g: 64-bit, 128-bit, and 152-bit.

1 EAP-MD5, EAP-TLS, EAP-TTLS, and PEAP client supplicant supported.

I Supportis provided for a primary and backup RADIUS authentication server for both MAC-based authentication and 802.1x authentication per
VLAN.

§ Use in conjunction with WPA or 802.1x Authentication.

Network Functions

Feature Supported by AP-700

DHCP Client 3

DHCP Server 3

DHCP Relay Agent and IP Lease Renewal 3

Inter Access Point Protocol (IAPP) 3

Link Integrity 3

System Logging (Syslog) 3

RADIUS Accounting Support® 3

DNS Client 3

TCP/IP Protocol Support 3

Virtual LAN Support Up to 16 SSID/VLAN pairs, with
specific Security and RADIUS
profiles. For more information, see
the Advanced Configuration chapter.

* Includes Fallback to Primary RADIUS Server, RADIUS Session Timeout, RADIUS Multiple MAC Address Formats, RADIUS DNS Host Name
Support, RADIUS Start/Stop Accounting.
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Hardware Specifications

Category

Specification

Physical

Dimensions (H x W x L)

1x4.75x7.1in (25 x 121 x 180 mm)

Weight Unit: .65 Ib (.295 kg)
Power Supply: .45 Ibs (.20 kg)
Electrical
Voltage 100 to 240 VAC +/- 10% (50-60 Hz) (power supply)
Power Draw <9 Watts (power supply)

Environmental

Storage Temperature

-20°C to 85°C (-4°F to 185°F)

Operating Temperature

0°C to 55°C (32°F to 131°F)

Humidity

5 to 95% relative humidity, non-condensing

Interfaces

Wired Ethernet

10/100 Base-T auto-sensing RJ45 Female Socket, Auto-sensing

Wireless Ethernet

1 integrated 802.11a/b/g radio

Serial Port Standard RS-232 interface with DB-9 female connector
LEDs
Types Power

Ethernet Link
Wireless 802.11a/b/g Radio Link
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Available Channels
Available channels vary based on operational mode and country. To verify which channels are available for your product:
1. Locate the product model number on the underside of your AP unit or on the unit’s box.
2. Note the alphanumeric code following the number 8675. (e.g., 8675-EU)
3. See the following tables.
+ 802.11a/b/g Channels
WD SKU Channels by Country

802.11a/b/g Channels

Mode Frequency Channel Product Model Number

Band AU AU2 BR CN EU EU2 HK JP SG SK ™ UK us us2 WD
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*  Default channel.
1 Available for use only in 802.11b mode.
1 Also supports 40 MHz channel bandwidths.
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WD SKU Channels by Country
Available channel bands depend on the selected country and mode of use (indoor/outdoor).

The typical channels available in each 802.11a frequency band are as follows:

Band Supported Channels
Lower (L) 36, 40, 44, 48
Middle (M) 52, 56, 60, 64
High (H) 100, 104, 108, 112, 116, 120, 124, 128, 132, 136, 140
Upper (U) 149, 153, 157, 161
ISM 165
Country Indoor/Outdoor 802.11a 802.11b/g Country .11d Country
Identifier Code
Austria Indoor L,M,H 1-13 AT1 AT
Outdoor H 1-13 AT2 AT
Belgium Indoor L, M,H 1-13 BE1 BE
Outdoor H 1-13 BE2 BE
Canada Indoor M, H, U, ISM 1-11 CA1 CA
Note: H band
frequencies 5600-5650
are not supported in
Canada.)
Cyprus Indoor L,M,H 1-13 CY1 CcY
Outdoor H 1-13 CY2 CY
Czech Republic Indoor L,M,H 1-13 Cz1 cz
Outdoor H 1-13 Cz2 Ccz
Denmark Indoor L,M,H 1-13 DK1 DK
Outdoor H 1-13 DK2 DK
Estonia Indoor L,M,H 1-13 EE1 EE
Outdoor H 1-13 EE2 EE
Finland Indoor L,MH 1-13 Fl1 Fl
Outdoor H 1-13 Fl2 Fl
France Indoor L, M, H 1-13 FR1 FR
Outdoor H 1-13 FR2 FR
Germany Indoor L,M,H 1-13 DE1 DE
Outdoor H 1-13 DE2 DE
Greece Indoor L,M,H 1-13 GR1 GR
Outdoor H 1-13 GR2 GR
Hungary Indoor L,M,H 1-13 HU1 HU
Outdoor H 1-13 HU2 HU
Ireland Indoor L, M,H 1-13 IE1 IE
Outdoor H 1-13 IE2 IE
Italy Indoor L,M,H 1-13 IT1 IT
Outdoor H 1-13 IT2 IT
Latvia Indoor L, M, H 1-13 LV1 LV
Outdoor H 1-13 Lv2 LV
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Country Indoor/Outdoor 802.11a 802.11b/g Country .11d Country
Identifier Code
Lithuania Indoor L,M,H 1-13 LT1 LT
Outdoor H 1-13 LT2 LT
Luxembourg Indoor L,M,H 1-13 LU1 LU
Outdoor H 1-13 LU2 LU
Malta Indoor L,MH 1-13 MT1 MT
Outdoor H 1-13 MT2 MT
Netherlands Indoor L,M,H 1-13 NL1 NL
Outdoor H 1-13 NL2 NL
Norway Indoor L, M, H 1-13 NO1 NO
Outdoor H 1-13 NO2 NO
Poland Indoor L,MH 1-13 PLA1 PL
Outdoor H 1-13 PL2 PL
Portugal Indoor L, M, H 1-13 PT1 PT
Outdoor H 1-13 PT2 PT
Russia Indoor/Outdoor L,M,H, U, ISM |1-13 RU RU
Spain Indoor L,M,H 1-13 ES1 ES
Outdoor H 1-13 ES2 ES
Sweden Indoor L,M,H 1-13 SE1 SE
Outdoor H 1-13 SE2 SE
Switzerland Indoor L,M,H 1-13 CH1 CH
Outdoor H 1-13 CH2 CH
United Kingdom/ Indoor L,M,H 1-13 GB1 GB
Great Britain Outdoor H 1-13 GB2 GB
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Technical Services and Support

See the following sections:

Obtaining Technical Services and Support
Support Options

— Proxim eService Web Site Support

— Telephone Support

— ServPak Support

Obtaining Technical Services and Support

If you are having trouble utilizing your Proxim product, please review this manual and the additional documentation
provided with your product.

If you require additional support and would like to use Proxim’s free Technical Service to help resolve your issue, please
be ready to provide the following information before you contact Proxim’s Technical Services:

Product information

— Part number of suspected faulty unit

— Serial number of suspected faulty unit

Trouble/error information:

— Trouble/symptom being experienced

— Activities completed to confirm fault

— Network information (what kind of network are you using?)

— Circumstances that preceded or led up to the error

— Message or alarms viewed

— Steps taken to reproduce the problem

Servpak information (if a Servpak customer):

— Servpak account number

Registration information:

— If the product is not registered, date when you purchased the product
— If the product is not registered, location where you purchased the product

NOTE: If you would like to register your product now, visit the Proxim eService Web Site at http://support.proxim.com
and click on New Product Registration.
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Support Options

Proxim eService Web Site Support
The Proxim eService Web site is available 7x24x365 at http://support.proxim.com.
On the Proxim eService Web Site, you can access the following services:

* New Product Registration: Register your product for free support.
* Open a Ticket or RMA: Open a ticket or RMA and receive an immediate reply.
» Search Knowledgebase: Locate white papers, software upgrades, and technical information.

» ServPak (Service Packages): Receive Advanced Replacement, Extended Warranty, 7x24x365 Technical Support,
Priority Queuing, and On-Site Support.

* Your Stuff: Track status of your tickets or RMAs and receive product update notifications.
* Provide Feedback: Submit suggestions or other types of feedback.
* Customer Survey: Submit an On-Line Customer Survey response.

* Repair Tune-Up: Have your existing Proxim equipment inspected, tested, and upgraded to current S/W and H/W
revisions, and extend your warranty for another year.

Telephone Support
Contact technical support via telephone as follows:

« Domestic: 866-674-6626
¢ International: +1-408-542-5390

Hours of Operation
* North America: 8 a.m. to 5 p.m. PST, Monday through Friday
« EMEA: 8 a.m. to 5 p.m. GMT, Monday through Friday

ServPak Support

Proxim understands that service and support requirements vary from customer to customer. It is our mission to offer
service and support options that go above-and-beyond normal warranties to allow you the flexibility to provide the quality
of service that your networks demand.

In recognition of these varying requirements we have developed a support program called ServPak. ServPak is a
program of Enhanced Service Options that can be purchased individually or in combinations to meet your needs.

+ Advanced Replacement: This service offers customers an advance replacement of refurbished or new hardware.
(Available in the U.S., Canada, and select countries. Please inquire with your authorized Proxim distributor for
availability in your country.)

+ Extended Warranty: This service provides unlimited repair of your Proxim hardware for the life of the service
contract.

* 7x24x365 Technical Support: This service provides unlimited, direct access to Proxim’s world-class technical
support 24 hours a day, 7 days a week, 365 days a year.

* Priority Queuing: This service allows your product issue to be routed to the next available Customer Service
Engineer.

To purchase ServPak support services, please contact your authorized Proxim distributor. To receive more information
or for questions on any of the available ServPak support options, please call Proxim Support at +1-408-542-5390 or send
an email to servpak@proxim.com.
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Statement of Warranty

Warranty Coverage

Proxim Wireless Corporation warrants that its Products are manufactured solely from new parts, conform substantially to
specifications, and will be free of defects in material and workmanship for a Warranty Period of 1 year from the date of
purchase.

Repair or Replacement

In the event a Product fails to perform in accordance with its specification during the Warranty Period, Proxim offers
return-to-factory repair or replacement, with a thirty (30) business-day turnaround from the date of receipt of the
defective Product at a Proxim Wireless Corporation Repair Center. When Proxim Wireless has reasonably determined
that a returned Product is defective and is still under Warranty, Proxim Wireless shall, at its option, either: (a) repair the
defective Product; (b) replace the defective Product with a refurbished Product that is equivalent to the original; or (c)
where repair or replacement cannot be accomplished, refund the price paid for the defective Product. The Warranty
Period for repaired or replacement Products shall be ninety (90) days or the remainder of the original Warranty Period,
whichever is longer. This constitutes Buyer’s sole and exclusive remedy and Proxim Wireless’s sole and exclusive
liability under this Warranty.

Limitations of Warranty

The express warranties set forth in this Agreement will not apply to defects in a Product caused; (i) through no fault of
Proxim Wireless during shipment to or from Buyer, (ii) by the use of software other than that provided with or installed in
the Product, (iii) by the use or operation of the Product in an application or environment other than that intended or
recommended by Proxim Wireless, (iv) by modifications, alterations, or repairs made to the Product by any party other
than Proxim Wireless or Proxim Wireless’s authorized repair partners, (v) by the Product being subjected to unusual
physical or electrical stress, or (vii) by failure of Buyer to comply with any of the return procedures specified in this
Statement of Warranty.

Support Procedures

Buyer should return defective LAN Products within the first 30 days to the merchant from which the Products were
purchased. Buyer can contact a Proxim Wireless Customer Service Center either by telephone or via web. Calls for
support for Products that are near the end of their warranty period should be made not longer than seven (7) days after
expiration of warranty. Repair of Products that are out of warranty will be subject to a repair fee. Contact information is
shown below. Additional support information can be found at Proxim Wireless’s web site at http://support.proxim.com.

* Domestic: 866-674-6626
¢ International: +1-408-542-5390

Hours of Operation

* North America: 8 a.m. to 5 p.m. PST, Monday through Friday
« EMEA: 8 a.m. to 5 p.m. GMT, Monday through Friday

When contacting the Customer Service for support, Buyer should be prepared to provide the Product description and
serial number and a description of the problem. The serial number should be on the product.

In the event the Customer Service Center determines that the problem can be corrected with a software update, Buyer
might be instructed to download the update from Proxim Wireless’s web site or, if that's not possible, the update will be
sent to Buyer. In the event the Customer Service Center instructs Buyer to return the Product to Proxim Wireless for

repair or replacement, the Customer Service Center will provide Buyer a Return Material Authorization (“RMA”) number
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and shipping instructions. Buyer must return the defective Product to Proxim Wireless, properly packaged to prevent
damage, shipping prepaid, with the RMA number prominently displayed on the outside of the container.

Calls to the Customer Service Center for reasons other than Product failure will not be accepted unless Buyer has
purchased a Proxim Wireless Service Contract or the call is made within the first thirty (30) days of the Product’s invoice
date. Calls that are outside of the 30-day free support time will be charged a fee of $25.00 (US Dollars) per Support Call.

If Proxim Wireless reasonably determines that a returned Product is not defective or is not covered by the terms
of this Warranty, Buyer shall be charged a service charge and return shipping charges.

Other Information

Search Knowledgebase

Proxim Wireless stores all resolved problems in a solution database at the following URL: http://support.proxim.com.

Ask a Question or Open an Issue

Submit a question or open an issue to Proxim Wireless technical support staff at the following URL:
http://support.proxim.com/cgi-bin/proxim.cfg/php/enduser/ask.php.

Other Adapter Cards

Proxim Wireless does not support internal mini-PCl devices that are built into laptop computers, even if identified as
"ORINOCO" devices. Customers having such devices should contact the laptop vendor's technical support for
assistance.

For support for a PCMCIA card carrying a brand name other than Proxim, ORINOCO, Lucent, Wavelan, or Skyline,
Customer should contact the brand vendor's technical support for assistance.
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